About this guide

This guide provides service and maintenance information for the HP Z210 Convertible Mini Tower (CMT) Workstation. It includes these topics:

<table>
<thead>
<tr>
<th>Guide topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product overview on page 1</td>
</tr>
<tr>
<td>Setting up the operating system on page 16</td>
</tr>
<tr>
<td>Restoring the operating system on page 22</td>
</tr>
<tr>
<td>System management on page 25</td>
</tr>
<tr>
<td>Replacing components on page 53</td>
</tr>
<tr>
<td>Diagnostics and troubleshooting on page 109</td>
</tr>
<tr>
<td>Configuring RAID devices on page 146</td>
</tr>
<tr>
<td>Configuring password security and resetting CMOS on page 150</td>
</tr>
<tr>
<td>Connector pins on page 154</td>
</tr>
<tr>
<td>System board designators on page 161</td>
</tr>
<tr>
<td>Routine Care on page 163</td>
</tr>
<tr>
<td>Locating HP resources on page 165</td>
</tr>
</tbody>
</table>
Table of contents

1 Product overview ........................................................................................................................................ 1
  Product features ........................................................................................................................................ 1
  System board architecture ................................................................................................................ 1
    Processor technology ....................................................................................................................... 2
    Memory technology .......................................................................................................................... 2
    Graphics .............................................................................................................................................. 3
    Expansion card slots ....................................................................................................................... 3
    Additional features ......................................................................................................................... 3
  Workstation components .................................................................................................................... 4
    Chassis components ....................................................................................................................... 4
    Front panel components .................................................................................................................. 5
    Rear panel components ................................................................................................................... 6
  Workstation specifications ..................................................................................................................... 7
    Physical characteristics .................................................................................................................... 7
    Power supply description ................................................................................................................ 7
      Power supply voltages .................................................................................................................. 7
      Power supply currents .................................................................................................................. 8
      Power supply specifications .......................................................................................................... 9
      Power consumption and heat dissipation ...................................................................................... 9
      System fans .................................................................................................................................. 10
    Resetting the power supply ............................................................................................................ 10
    Environmental specifications .......................................................................................................... 11
    ENERGY STAR Qualification ............................................................................................................. 12
    ERP compliance mode .................................................................................................................... 13
      Enabling ERP compliance mode .................................................................................................. 13
      Disabling ERP compliance mode ................................................................................................ 13
    Accessibility ...................................................................................................................................... 13
    Hyper-threading .............................................................................................................................. 13
    SATA Power Management ................................................................................................................ 14
    Intel Turbo Boost Technology ......................................................................................................... 14
    HP Cool Tools .................................................................................................................................. 14
    Ensuring proper ventilation ............................................................................................................. 15

2 Setting up the operating system ............................................................................................................ 16
  Setting up the Microsoft operating system .......................................................................................... 17
  Installing or upgrading device drivers ............................................................................................... 17
Transferring files and settings to your Windows workstation ......................................... 17
Setting up Red Hat Enterprise Linux .......................................................................................... 18
  Verifying hardware compatibility .................................................................................. 18
  Installing from RHEL optical media ............................................................................... 18
  Installing with the HP driver CD .................................................................................. 18
Setting up Novell SLED ........................................................................................................ ... 19
  Setting up SLED on preloaded systems ....................................................................... 19
  Installing from SLED optical media ............................................................................ 19
  Installing with the HP driver CD ................................................................................. 19
Updating the workstation ......................................................................................................... 20
  Updating the workstation after first boot ................................................................. 20
  Upgrading the BIOS .................................................................................................. 20
    Determining current BIOS ....................................................................................... 20
    Upgrading BIOS .................................................................................................... 21
    Upgrading device drivers ....................................................................................... 21

3 Restoring the operating system ....................................................................................... 22
  Restore method ........................................................................................................... 22
  Ordering backup software ........................................................................................... 23
  Restoring Windows 7 .................................................................................................. 23
    Ordering the HP Recovery Manager media ............................................................... 23
    Restoring the operating system ............................................................................... 23
  Restoring Novell SLED ................................................................................................. 24
    Creating restore media ............................................................................................ 24

4 System management ...................................................................................................... 25
  BIOS ROM .................................................................................................................. 25
  The Computer Setup (F10) Utility ................................................................................... 25
    Computer Setup (F10) functionality ......................................................................... 25
    Accessing the Computer Setup (F10) Utility ............................................................ 27
    The Computer Setup (F10) Utility menu .................................................................. 28
  Desktop management .................................................................................................... 36
    Initial computer configuration and deployment ........................................................ 37
    Installing a remote system ....................................................................................... 37
    Replicating the setup ............................................................................................... 38
      Copying a setup configuration to another computer .............................................. 38
    Updating and managing software ........................................................................... 39
    HP Client Manager Software ................................................................................... 39
    Altiris Client Management Solutions ....................................................................... 39
    HP SoftPaq Download Manager ................................................................................ 40
    System Software Manager ....................................................................................... 40
1 Product overview

This chapter presents an overview of the hardware components of the workstation. It includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product features on page 1</td>
</tr>
<tr>
<td>Workstation specifications on page 7</td>
</tr>
</tbody>
</table>

Product features

The following sections describe the workstation system board architecture and components, and includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>System board architecture on page 1</td>
</tr>
<tr>
<td>Workstation components on page 4</td>
</tr>
</tbody>
</table>

System board architecture

This section describes the system architecture.
The following figure shows the typical system board block diagram.

**Figure 1-1** System board block diagram

![System board block diagram](image)

**NOTE:** The x1, x4, and x16 designators describe the mechanical length of the slot. The number in parentheses lists the number of electrical PCIe lanes routed to the expansion slot. For example, x16(4) means that the expansion slot is mechanically a x16 length connector, with four PCIe lanes connected.

**Processor technology**

This workstation uses the latest 32nm process SKT-H2 chipset, with support for the Intel® Xeon® Processor E3 Family or 2nd generation Intel Core(TM) processors up to 95W. These processors incorporate an integrated 2-channel memory controller, microarchitecture improvements, integrated graphics (some models) and Advanced Vector Extensions (AVX) to increase floating point performance. In addition, the chipset uses the Intel DMIx4 interface to connect the processor and I/O controller.

**Memory technology**

The workstation dual in-line memory modules (DIMMs) are based on DDR3 1066/1333MHz technology. Error checking and correcting (ECC) and non-ECC DIMMs are supported. Two direct-attach memory channels permit low latency access and fast data transfer to improve performance. System memory sizes up to 32GB (using 8GB DIMMs) are supported.

**NOTE:** To optimize performance, distribute the DIMMs across both memory channels. See Memory on page 83 for more information.
NOTE: Do not intermix non-ECC memory DIMMs with ECC memory DIMMs.

Graphics

The workstation supports discrete PCIe Gen2 graphics cards in its PCIe2 x16 and PCIe2 x16(4) slots. The system supports multiple graphics cards as long as the total power usage of these cards fits within the total graphics power budget of 150W.

To view supported graphic card configurations using HP QuickSpecs, visit [http://www.hp.com/go/quickspecs](http://www.hp.com/go/quickspecs), select your geographic region, click on "Workstations," then select your workstation model.

Some workstation models (depending on installed processor type) also support up to two displays with integrated Intel HD graphics. Most supported Intel Core processors provide Intel HD Graphics 2000. Intel Xeon processors with model designations that end in "−5" provide Intel HD Graphics P3000. In Windows 7, you can view the model of CPU installed in the workstation by selecting Start > Control Panel > System.

NOTE: Intermixing integrated Intel HD graphics and discrete graphics cards in order to drive more than two displays can be enabled using the Computer (F10) Setup Utility. However, HP recommends using only discrete graphics cards when attaching three or more displays. To see graphics card configurations that have been fully tested and validated by HP for use in this workstation, refer to [http://www.hp.com/go/quickspecs](http://www.hp.com/go/quickspecs).

Expansion card slots

The workstation provides multiple high-performance graphics and I/O slots: one full x16 PCIe2; one x16(4) PCIe2; one x8(4) PCIe2; two x1 PCIe2; and two PCI 32b/33Mhz slots. These slots provide extra I/O bandwidth for high speed I/O cards.

Additional features

The workstation provides these additional features:

- Nine external and three internal USB 2.0 ports.
- A 400W power supply that is 90% efficient and permits Energy Star Version 5.0 system configurations.
- HP WattSaver technology permits support of the European Union ERP Lot 6 tier 2 power limit of 0.5W in off mode.
- HP Quiet Fan Technology permits quiet system operation.
- Parallel and serial headers that can be used with an optional PCI bulkhead connector.


**Workstation components**

This section describes the workstation components, including front and rear panel components.

For complete and current information on supported accessories and components for the workstation, see [http://partsurfer.hp.com](http://partsurfer.hp.com).

**Chassis components**

The following figure shows the chassis components of a typical HP Z210 CMT Workstation layout. Drive configurations can vary.

*Figure 1-2  Workstation chassis components*

![](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power supply</td>
<td>8</td>
<td>Memory module (DIMM)</td>
</tr>
<tr>
<td>2</td>
<td>Side access panel</td>
<td>9</td>
<td>PCIe card</td>
</tr>
<tr>
<td>3</td>
<td>Rear system fan</td>
<td>10</td>
<td>PCI card</td>
</tr>
<tr>
<td>4</td>
<td>Optical drive</td>
<td>11</td>
<td>Speaker</td>
</tr>
<tr>
<td>5</td>
<td>Processor heatsink</td>
<td>12</td>
<td>Hard disk drive</td>
</tr>
<tr>
<td>6</td>
<td>Processor (CPU)</td>
<td>13</td>
<td>Front bezel</td>
</tr>
<tr>
<td>7</td>
<td>System board</td>
<td>14</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Front panel components

The following figure shows the front panel of an HP Z210 CMT Workstation. Drive configurations can vary.

Figure 1-3  Workstation front panel

Table 1-2  Workstation front panel connectors

<table>
<thead>
<tr>
<th>Item</th>
<th>Symbol</th>
<th>Description</th>
<th>Item</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Optical drive manual eject</td>
<td>6</td>
<td></td>
<td>Headphone connector</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Optical drive eject button</td>
<td>7</td>
<td></td>
<td>Microphone connector</td>
</tr>
<tr>
<td>3</td>
<td>![Power button]</td>
<td>Power button</td>
<td>8</td>
<td>![1394a connector]</td>
<td>1394a connector (optional and plugged unless configured)</td>
</tr>
<tr>
<td>4</td>
<td>![Hard drive activity light]</td>
<td>Hard drive activity light</td>
<td>9</td>
<td></td>
<td>Optical drive activity light</td>
</tr>
<tr>
<td>5</td>
<td>![USB 2.0 ports]</td>
<td>USB 2.0 ports (3)</td>
<td>10</td>
<td></td>
<td>Optical drive</td>
</tr>
</tbody>
</table>
Rear panel components

The following figure shows the rear panel of a typical HP Z210 CMT Workstation.

Figure 1-4 Workstation rear panel

Table 1-3 Rear panel components

<table>
<thead>
<tr>
<th>Item</th>
<th>Symbol</th>
<th>Description</th>
<th>Item</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Power supply fan</td>
<td>9</td>
<td></td>
<td>Microphone connector (pink)</td>
</tr>
<tr>
<td>2</td>
<td><img src="image" alt="PS/2 mouse connector (green)" /></td>
<td>PS/2 mouse connector (green)</td>
<td>10</td>
<td><img src="image" alt="USB 2.0 ports (4)" /></td>
<td>USB 2.0 ports (4)</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Universal chassis clamp opening</td>
<td>11</td>
<td><img src="image" alt="USB 2.0 ports (2)" /></td>
<td>USB 2.0 ports (2)</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Cable lock slot</td>
<td>12</td>
<td><img src="image" alt="Display Port (DP) connector" /></td>
<td>Display Port (DP) connector</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Padlock loop</td>
<td>13</td>
<td><img src="image" alt="DVI-I connector" /></td>
<td>DVI-I connector</td>
</tr>
<tr>
<td>6</td>
<td><img src="image" alt="RJ-45 network connector" /></td>
<td>RJ-45 network connector</td>
<td>14</td>
<td><img src="image" alt="PS/2 keyboard connector (purple)" /></td>
<td>PS/2 keyboard connector (purple)</td>
</tr>
<tr>
<td>7</td>
<td><img src="image" alt="Audio line-in connector (blue)" /></td>
<td>Audio line-in connector (blue)</td>
<td>15</td>
<td></td>
<td>Power cord connector</td>
</tr>
<tr>
<td>8</td>
<td><img src="image" alt="Audio line-out connector (green)" /></td>
<td>Audio line-out connector (green)</td>
<td>16</td>
<td></td>
<td>Power Supply BIST LED</td>
</tr>
</tbody>
</table>
Workstation specifications

This section provides workstation chassis, power supply, and environmental specifications.

Physical characteristics

The following table lists the workstation physical characteristics.

<table>
<thead>
<tr>
<th>Weight (Typical configuration)</th>
<th>10.4-14.8 kg (22.9-32.5 lb)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chassis Dimensions</td>
<td></td>
</tr>
<tr>
<td><strong>Height</strong>: 44.8 cm (17.6 in)</td>
<td></td>
</tr>
<tr>
<td><strong>Width</strong>: 17.8 cm (7.0 in)</td>
<td></td>
</tr>
<tr>
<td><strong>Depth</strong>: 45.4 cm (17.9 in)</td>
<td></td>
</tr>
</tbody>
</table>

Power supply description

The workstation includes a 400W 90% efficient 80PLUS gold-level power supply, which is compatible with ENERGY STAR requirements.

Power supply voltages

<table>
<thead>
<tr>
<th>Table 1-4 Power supply source voltages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source voltage</strong></td>
</tr>
<tr>
<td>V12CPU</td>
</tr>
<tr>
<td>V12-B</td>
</tr>
<tr>
<td>V12-S</td>
</tr>
<tr>
<td>V12-G</td>
</tr>
<tr>
<td>V12N</td>
</tr>
<tr>
<td>11VSB</td>
</tr>
</tbody>
</table>
## Power supply currents

### Table 1-5  Maximum current per rail

<table>
<thead>
<tr>
<th>Output (400W)</th>
<th>V12CPU</th>
<th>V12–B</th>
<th>V12–S</th>
<th>V12–G</th>
<th>V12N</th>
<th>11VSB</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Nominal output voltage</strong></td>
<td>12.0</td>
<td>12.0</td>
<td>12.0</td>
<td>12.0</td>
<td>–12.0</td>
<td>11.4</td>
</tr>
<tr>
<td><strong>Maximum continuous current</strong></td>
<td>18A</td>
<td>18A</td>
<td>18A</td>
<td>12.5A</td>
<td>0.15A</td>
<td>1.74A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>33.3A combined</td>
</tr>
</tbody>
</table>

⚠️ **CAUTION:** Do not exceed 400 watts of total continuous output power.

Maximum combined current on +12V (CPU,B,S,g) is 33.3A.
Power supply specifications

Table 1-6  Power supply specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply</td>
<td>400W Wide Ranging, Active PFC and 90% efficient at typical loads</td>
</tr>
<tr>
<td>Operating voltage range</td>
<td>90–269 VAC</td>
</tr>
<tr>
<td>Rated voltage range</td>
<td>100–240 VAC</td>
</tr>
<tr>
<td>Rated line frequency</td>
<td>50–60 Hz</td>
</tr>
<tr>
<td>Operating line frequency range</td>
<td>47–63 Hz</td>
</tr>
<tr>
<td>Rated input current</td>
<td>6A @ 100-127 VAC</td>
</tr>
<tr>
<td></td>
<td>3A @ 200–240 VAC</td>
</tr>
<tr>
<td>Heat dissipation</td>
<td>Typical: 985 btu/hr</td>
</tr>
<tr>
<td>(Configuration and software dependent)</td>
<td>Maximum 1569BTU/hr = (395.4 kg-cal/hr)</td>
</tr>
<tr>
<td>Power supply fan</td>
<td>One fan, 92mm x 25mm, variable speed</td>
</tr>
<tr>
<td>ENERGY STAR Qualified (Config dependent)</td>
<td>Yes</td>
</tr>
<tr>
<td>80 PLUS® Compliant</td>
<td>Yes, Gold-level rating</td>
</tr>
<tr>
<td>FEMP Standby Power compliant @115V</td>
<td>Yes</td>
</tr>
<tr>
<td>(&lt;2W in S5 – Power Off)</td>
<td></td>
</tr>
<tr>
<td>ERP Lot 6 Tier 1 Compliant @ 230V</td>
<td>Yes</td>
</tr>
<tr>
<td>(&lt;1W in S5 – Power Off)</td>
<td></td>
</tr>
<tr>
<td>ERP Lot 6 Tier 2 Compliant @ 230V</td>
<td>Yes</td>
</tr>
<tr>
<td>(&lt;0.5W in S5 – Power Off)</td>
<td></td>
</tr>
<tr>
<td>Built-in Self Test LED</td>
<td>Yes</td>
</tr>
<tr>
<td>Surge tolerant full ranging power supply</td>
<td>Yes</td>
</tr>
<tr>
<td>(withstands power surges up to 2000V)</td>
<td></td>
</tr>
<tr>
<td>Power Consumption in sleep mode (as defined by ENERGY STAR) - Suspend to RAM (S3) (Instantly Available PC)</td>
<td>&lt;4W</td>
</tr>
</tbody>
</table>

Power consumption and heat dissipation

Power consumption and heat dissipation specifications are available for multiple configurations. To review available specifications, see http://www.hp.com/go/quickspecs.

To reach zero power consumption, unplug the workstation from the power outlet or use a power strip with an on/off switch. For additional information about power-saving features, see the operating system installation instructions.

This product is in compliance with U.S. Executive Order 13221.
**System fans**

This workstation includes:

- One rear system fan
- One CPU heatsink fan
- One power supply fan

In addition, an optional front system fan is available for special environments, and many graphics cards include onboard fans.

**Resetting the power supply**

If an overload triggers the power supply overload protection, power is immediately disconnected.

To reset the power supply:

1. Disconnect the power cord from the workstation.

2. Determine what caused the overload and fix the problem. For troubleshooting information, see Diagnostics and troubleshooting on page 109.

3. Reconnect the power cord and restart the workstation.

When you power off the workstation through the operating system, power consumption falls below what is considered low power consumption but does not reach zero. This low power consumption feature extends the life of the power supply.
**Environmental specifications**

The following table lists the environmental specifications of HP Workstations.

**Table 1-7  HP Workstation environmental specifications**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Operating</th>
<th>Non-operating</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Temperature</strong></td>
<td><strong>Operating:</strong> 5 to 35°C (40 to 95°F)</td>
<td><strong>Non-operating:</strong> -40 to 60°C (-40 to 140°F)</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Derate by one degree C (1.8 degrees F) for every 305m (1,000 ft) altitude over 1,524m (5,000 ft).</td>
<td></td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td><strong>Operating:</strong> 8 to 85% Relative Humidity (RH), non-condensing</td>
<td><strong>Non-operating:</strong> 8 to 90% Relative Humidity, non-condensing</td>
</tr>
<tr>
<td><strong>Altitude</strong></td>
<td><strong>Operating:</strong> 0 to 3,048m (10,000 ft)</td>
<td><strong>Non-operating:</strong> 0 to 9,144m (30,000 ft)</td>
</tr>
<tr>
<td><strong>Shock</strong></td>
<td><strong>Operating:</strong> ½-sine: 40g, 2-3ms</td>
<td><strong>Non-operating:</strong></td>
</tr>
<tr>
<td></td>
<td>● ½-sine: 160 cm/s, 2-3ms (~100g)</td>
<td>● square: 422 cm/s, 20g</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Values represent individual shock events and do not indicate repetitive shock events.</td>
<td></td>
</tr>
<tr>
<td><strong>Vibration</strong></td>
<td><strong>Operating Random:</strong> 0.5g (rms), 5-300 Hz</td>
<td><strong>Non-Operating:</strong> random: 2.0g (rms), 10-500 Hz</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Values do not indicate continuous vibration.</td>
<td></td>
</tr>
</tbody>
</table>
ENERGY STAR Qualification

HP computers marked with the ENERGY STAR logo are compliant with the applicable U.S. Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA ENERGY STAR logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, Hewlett-Packard Company has determined the products marked with the ENERGY STAR logo are ENERGY STAR qualified per the applicable ENERGY STAR guidelines for energy efficiency. The following logo appears on all ENERGY STAR qualified computers.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and reduce air pollution through more energy-efficient equipment in homes, offices, and factories. One way products achieve this energy efficiency is by reducing power consumption when not being used through the Microsoft Windows Power Management feature.

The Power Management feature enables the computer to enter a low-power (or “sleep”) mode after a period of inactivity. When used with an external monitor that is ENERGY STAR qualified, this feature also supports the similar power management features of the external monitor.

To take advantage of this energy savings:

- The Power Management feature has been preset to suspend the computer to a sleep state after 30 minutes of inactivity.
- The Power Management feature has been preset to suspend the monitor to a sleep state after 15 minutes of inactivity.

Both the computer and monitor can be woken from sleep mode through user interaction with any of the computer input devices (mouse, keyboard, and so on). When configured with Wake On LAN (WOL) enabled, the computer can also be woken by a network signal.

See the EPA ENERGY STAR Power Management Web site for more information about the energy and financial savings potential of the Power Management Feature: http://www.energystar.gov/powermanagement.

See the EPA ENERGY STAR Web site for more information about the ENERGY STAR program and its environmental benefits: http://www.energystar.gov.

⚠️ CAUTION: Using the Energy Save Monitor feature with monitors that are not ENERGY STAR qualified can cause video distortion when an Energy Save timeout occurs.

💡 NOTE: ENERGY STAR is not supported on Linux computers.

If it is necessary to restore the operating system, you must also reset the ENERGY STAR settings (if applicable) after the restore.

To verify the factory default power settings for your computer, select Start>Control Panel, and then double-click Power Options.
**ERP compliance mode**

This computer provides ERP compliance mode capability.

When enabled, this feature enables the computer to shut down to the lowest possible power state by removing all power to the system board.

When disabled, the computer powers down conventionally.

When the computer is shut down in ERP compliance mode, it must be powered up with the computer power button.

**Enabling ERP compliance mode**

To enable ERP compliance mode:

1. Press F10 during start up.
2. Using the arrow keys, select the **Power>Hardware Power Management>S5 Maximum Power Savings**, and then select **Enable**.
3. Press F10 to accept the change.
4. Select **File>Save Change and Exit**, and then press F10 to accept the change.

**Disabling ERP compliance mode**

To disable the ERP compliance mode:

1. Press F10 during start up.
2. Select **Power>Hardware Power Management>S5 Maximum Power Savings**, and then select **Disable**.
3. Press F10 to accept the change.
4. Select **File>Save Change and Exit**, and then press F10 to accept the change.

**Accessibility**

HP is committed to developing products, services, and information that is easier to access for all customers, including customers with disabilities and age-related limitations. HP products with Windows® 7 preinstalled are designed for accessibility. These products are tested with industry-leading Assistive Technology products. For more information see [http://www.hp.com/accessibility](http://www.hp.com/accessibility).

**Hyper-threading**

This HP computer supports Hyper-threading.

Hyper-Threading Technology (HTT), is an Intel-proprietary technology used to provide process parallelization. The technology improves processor performance under certain workloads by providing useful work for execution units that would otherwise be idle. A processor with Hyper-Threading enabled is treated by the operating system as two processors instead of one. Hyper-threading relies on support in the operating system as well as the CPU.
**SATA Power Management**

SATA Power Management enables or disables SATA bus and/or device power management.

**Intel Turbo Boost Technology**

The HP Z Workstation series supports Intel® Turbo Boost Technology.

This feature enables the CPU to run at a higher than normal rate. When all CPU cores are not necessary for the workload, inactive cores are turned off and power is diverted to the active cores to increase their performance.

Turbo Boost is enabled and disabled in computer BIOS.

**HP Cool Tools**

HP workstations and computers installed with Windows include additional software tools. To access or learn more about these tools that can enhance the computer experience:

1. Double-click the **HP Cool Tools** icon on the desktop.
2. To learn more about an HP Cool Tool application, just click on the application’s "Learn More" link.
3. To install or launch the applications, select the appropriate application and follow the instructions given.
Ensuring proper ventilation

Proper ventilation for the system is important for workstation operation. Follow these guidelines to ensure adequate ventilation:

- Operate the workstation on a sturdy, level surface.
- Place the workstation in an area with adequate ventilation. Provide at least 15.24 cm (6 inches) of clearance at the front and back of the workstation as shown in the following figure.

Your workstation might look different than the one shown.

**Figure 1-5** Proper workstation ventilation

- Ensure that the ambient air temperature surrounding the workstation falls within the published limit.

**NOTE:** The ambient upper limit of 35°C is only good up to 1524 m (5000 ft) elevation. There is a 1°C per 304.8 m (1000 ft) derating above 1524 m (5000 ft). So, at 3,048 m (10,000 ft), the upper ambient air temperature limit is 30°C.

- For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient temperature within the cabinet does not exceed published limits.

- Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air intakes as shown in the following figure.

**Figure 1-6** Proper workstation placement
2 Setting up the operating system

This chapter provides setup and update information for the workstation operating system. It includes these topics:

- Setting up the Microsoft operating system on page 17
- Setting up Red Hat Enterprise Linux on page 18
- Setting up Novell SLED on page 19
- Updating the workstation on page 20

This chapter also includes information on how to determine that you have the latest BIOS, drivers, and software updates installed on the workstation.

⚠️ **CAUTION:** Do not add optional hardware or third-party devices to the HP workstation until the operating system is successfully installed. Adding hardware might cause errors and prevent the operating system from installing correctly.
Setting up the Microsoft operating system

When you first apply power to the workstation, the operating system is installed. This process takes approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the installation.

⚠️ **CAUTION:** After installation has started, do not turn off the workstation until the process is complete. Turning off the workstation during installation can damage the installation and operation of the software.

For complete operating system installation and configuration instructions, see the operating system documentation that was provided with the workstation. Additional information is available in the online help tool after you successfully install the operating system.

Installing or upgrading device drivers

To install hardware devices after the operating system is installed, you must install the appropriate device drivers before you install the devices. Follow the installation instructions that came with the device. In addition, for optimum performance, your operating system must have the most recent updates, patches, and software fixes. For additional driver and software update information, refer to Upgrading device drivers on page 21.

Transferring files and settings to your Windows workstation

The Microsoft Windows operating system offers data migration tools that helps you choose and transfer files and data from another Windows computer to your Windows operating system workstation.

For instructions on how to use these tools, see the documents at http://www.microsoft.com.
Setting up Red Hat Enterprise Linux

HP offers an HP Installer Kit for Linux (HPIKL) to supplement Red Hat box sets and help HP Linux customers customize their system image. The HPIKL contains the HP driver CD and device drivers to successfully set up the Red Hat Enterprise Linux (RHEL) operating system. The HP Installer Kit for Linux CDs are currently available for download at http://www.hp.com/support/workstation_swdrivers.

To use the drivers in the HP Installer kit for Linux other than RHEL, you must manually extract the drivers from the HP Driver CD and install them. HP does not test the installation of these drivers on other Linux distributions nor does HP support this operation.

Verifying hardware compatibility

To see which Linux versions have been qualified to work on HP Workstations visit http://www.hp.com/support/linux_hardware_matrix.

Installing from RHEL optical media

When installing RHEL on your workstation, follow this procedure prior to booting and installing from the RHEL box set media:

1. With the RHEL install media in the DVD drive, restart the workstation and press the F9 key within three seconds to display the boot menu. If you miss the boot menu, press Ctrl-Alt-Del to restart and wait slightly more or less before pressing F9.

2. From the list of available boot sources, under Legacy boot sources, pick the optical drive that contains the RHEL install media.

   **NOTE:** Be sure to pick from the list labeled Legacy boot sources when selecting the optical drive from which to boot. Do not select from UEFI boot sources. Doing so may result in the OS installation being unable to complete.

3. Press Enter to continue with system boot and the OS installation process.

Installing with the HP driver CD

For instructions on installing the HP driver CD, see “Installing with the HP Installer Kit for Linux” in the HP Workstations for Linux User Guide at http://www.hp.com/support/linux_user_manual.
Setting up Novell SLED

The workstation can be ordered with Novell SLED preloaded.

HP offers an HP Installer Kit for Linux (HPIKL) to help HP Linux customers customize their system image. The HPIKL contains the HP driver CD and device drivers to successfully set up the SUSE Linux Enterprise Desktop (SLED) operating system. The HP Installer Kit for Linux CDs are currently available for download at http://www.hp.com/support/workstation_swdrivers.

Setting up SLED on preloaded systems

To set up the SUSE Linux Enterprise Desktop (SLED) on systems preloaded with the operating system:

1. Boot the workstation.

2. Start the Installation Settings and enter the password, network, graphics, time, keyboard settings, and Novell Customer Center Configuration for the workstation.

**NOTE:** During Installation Settings the Novell subscription can be activated from the Novell Customer Center Configuration screen. Visit the full Novell Customer Center documentation at http://www.novell.com/documentation/ncc/.

Installing from SLED optical media

To install SLED on your workstation, follow this boot procedure prior to installing from the SLED media:

1. With the SLED install media in the DVD drive, restart the workstation and press the F9 key within three seconds to display the boot menu. If you miss the boot menu, press Ctrl-Alt-Del to restart and wait slightly more or less before pressing F9.

2. From the list of available boot sources, under **Legacy boot sources**, pick the optical drive that contains the SLED install media.

**NOTE:** Be sure to pick from the list labeled **Legacy boot sources** when selecting the optical drive from which to boot. Do not select from **UEFI boot sources**. Doing so may result in the OS installation being unable to complete.

3. Press **Enter** to continue with system boot and the OS installation process.

Installing with the HP driver CD

For instructions on installing the HP driver CD, see “Installing with the HP Installer Kit for Linux” in the HP Workstations for Linux User Guide at http://www.hp.com/support/linux_user_manual.
Updating the workstation

HP is constantly working on improving your total workstation experience. To ensure that the workstation leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and software updates on a regular basis.

Updating the workstation after first boot

After successfully booting the workstation for the first time, you should follow these guidelines to ensure that the workstation is up-to-date:

- Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 20 for instructions.
- Ensure that you have the latest drivers for your system. See Upgrading device drivers on page 21 for instructions.
- Become familiar with your available HP resources.
- Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS

For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.

Determining current BIOS

To determine the current BIOS of the workstation during system power up:

1. Wait for F10=setup to appear on the lower right corner of the screen.
2. Press F10 to enter the F10 Setup utility.
   The F10 Setup utility displays the workstation BIOS version under File > System Information.
3. Note the workstation BIOS version so that you can compare it with the BIOS versions that appear on the HP website.
Upgrading BIOS

To find and download the latest available BIOS, which includes the latest enhancements:


2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to locate the latest BIOS available for the workstation.

4. If the BIOS on the Web site is the same as the version on your system, no further action is required.

5. If the BIOS on the Web site is a version later than the one on your system, download the appropriate version for the workstation. Follow the instructions in the release notes to complete the installation.

Upgrading device drivers

If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you have the latest device drivers loaded. If you purchased your device through HP, visit the HP Web site to download the latest drivers for your device. These drivers have been tested to ensure the best compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP Web site first to see if your device and its drivers have been tested for HP workstation compatibility. If no driver is available, visit the device manufacturer’s Web site to download the latest drivers.

To upgrade device drivers:


2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the Web site of the manufacturer of the peripheral device.
3 Restoring the operating system

This chapter describes how to restore the Windows or Linux operating system. It includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore method</td>
<td>22</td>
</tr>
<tr>
<td>Ordering backup software</td>
<td>23</td>
</tr>
<tr>
<td>Restoring Windows 7</td>
<td>23</td>
</tr>
<tr>
<td>Restoring Novell SLED</td>
<td>24</td>
</tr>
</tbody>
</table>

**Restore method**

The Windows 7 operating system can be reinstalled using the HP Recovery Manager.

HP Recovery Manager reinstalls the Windows operating system and device drivers (for devices included with the system) to a near-factory state. The process does not back up or recover data on the hard drive. Some application software might not be restored using this process and must be installed from the appropriate application CD.

⚠️ **CAUTION:** This method restores the operating system, but not data. Data must be backed up regularly to avoid loss.
Ordering backup software

You can order a recovery disk set from the HP support center. To obtain the support center telephone number for your region see http://www.hp.com/support/contactHP. Request the Windows 7 32-bit or 64-bit system recovery media kit.

Restoring Windows 7

This section describes how to restore Windows 7.

Ordering the HP Recovery Manager media

If you ordered restore media with your workstation, the media is included with your workstation components.

If you did not order restore media, call HP Support and request the Windows 7 32-bit or 64-bit system recovery media kit. For worldwide technical support phone numbers, see http://www.hp.com/support.

Restoring the operating system

**NOTE:** Windows 7 provides a backup and restore application as well. To learn more about this application, see the Microsoft Web site.

**CAUTION:** Before you restore the operating system, back up your data.

When you run HP Recovery Manager from media, the process deletes all information on the primary hard drive, including all partitions.

To restore Windows 7:

1. Boot from the first disk in the HP Recovery Manager DVD set to start the system recovery process.
2. Follow the prompts to restore your operating system.

Some application software might not be restored using this process. If software is not restored, install it from the appropriate application DVD.
Restoring Novell SLED

The SLED restore media is required to restore the Linux operating system.

Creating restore media

The SUSE Linux Enterprise Desktop preload includes a SUSE ISO icon on the desktop. You can click this icon to go to the /iso directory. The /iso directory contains all iso images used to preload your workstation. To recover or restore the original image, follow the instructions in the readme file in the /iso directory to copy the ISO image file onto a DVD.

NOTE: Make copies of the ISO recovery images on a DVD as backup files in case your workstation experiences a hard drive failure.
4 System management

This section describes the tools and utilities that provide system management for the workstation. It includes these topics:

Topics

- BIOS ROM on page 25
- The Computer Setup (F10) Utility on page 25
- Desktop management on page 36

BIOS ROM

The BIOS ROM is a collection of machine language applications stored as firmware in ROM. It includes functions such as Power on Self Test (POST), PCI device initialization, Plug and Play support, power management, and the Computer Setup (F10) Utility. The BIOS ROM is an 8MB Serial Peripheral Interface (SPI) port.

See [http://www.hp.com/go/quickspecs](http://www.hp.com/go/quickspecs) to review the latest BIOS ROM specifications.

The Computer Setup (F10) Utility

This section contains these topics:

Topics

- Computer Setup (F10) functionality on page 25
- Accessing the Computer Setup (F10) Utility on page 27
- The Computer Setup (F10) Utility menu on page 28

Computer Setup (F10) functionality

The Computer Setup (F10) Utility enables you to:

- Change factory default settings and set or change the workstation configuration, which might be necessary when you add or remove hardware.
- Determine if all devices installed on the workstation are recognized by the system and functioning.
- Determine information about the operating environment of the workstation.
- Solve system configuration errors that are detected but not fixed during the Power-On Self-Test (POST).
● Establish and manage passwords and other security features.
● Establish and manage energy-saving time-outs (not supported on Linux platforms).
● Modify or restore factory default settings.
● Set the computer date and time.
● Set, view, change or verify the computer configuration, including settings for CPU, graphics, memory, audio, storage, communications and input devices.
● Modify the boot order of installed mass storage devices such as SATA, optical disk drives, network drives, and USB boot devices.
● Configure the boot priority of SATA hard-drive controllers.
● Enable or disable Network Server Mode, which enables the computer to start the operating system when the power-on password is enabled with or without a keyboard or mouse attached. When attached to the computer, the keyboard and mouse remain locked until the power-on password is entered.
● Enable or disable the display of POST messages. Disabling POST Messages suppresses most POST messages, such as memory count, product name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the mode selected. To manually switch to POST Messages Enabled during POST, press any key except F1 through F12.
● Specify an Ownership Tag, which appears when the computer is powered on or restarted.
● Specify the Asset Tag or property identification number assigned by the company to this computer.
● Enable power-on password prompts during system restarts (warm-starts) and power on.
● Hide or show the integrated I/O functionality, including serial, USB, or parallel ports, audio, or embedded NIC. Hidden devices are inaccessible, which increases system security.
● Enable or disable removable media boot ability.
● Enable or disable removable media write ability (if supported by hardware).
● Replicate the computer setup by saving system configuration information on USB removable storage devices and restoring it on computers.
● Execute self-tests on specified SATA hard disk drives (if supported by the drive).
Accessing the Computer Setup (F10) Utility

To access the Computer Setup (F10) Utility menu:

1. Power on or restart the computer.

2. As the display first becomes active, press F10.

   If you do not press F10 quickly enough at the appropriate time, try again. Turn the computer off, then on, and press F10 again to access the utility. You can also press Ctrl + Alt + Delete before starting if you miss the opportunity to press F10.

3. Select the language from the list and press Enter.

   In the Computer Setup (F10) Utility menu, five headings are displayed: File, Storage, Security, Power, and Advanced.

4. Use the left and right arrow keys to select the appropriate heading, use the up and down arrow keys to select an option, and then press Enter.

5. Choose from the following:

   - To apply and save changes, select File > Save Changes, and then select F10=YES.
   - To remove changes you have made, select Ignore Changes and then select F10=YES.
   - To reset to factory settings, select File > Default Setup > Restore Factory Settings as Default. Press F10 to accept the changes, and then select Apply Defaults and Exit. This restores the original factory system defaults.

   NOTE: Help screens (accessed by pressing F1) are available for many menus in the Computer Setup (F10) Utility.

   CAUTION: Do not power off the computer while the ROM is saving the Computer Setup (F10) Utility changes to CMOS memory. A loss of power could corrupt the CMOS memory. After you exit the F10 Setup screen, you can disconnect power from the computer.
The Computer Setup (F10) Utility menu

The following table describes the functions available in the Computer Setup (F10) utility menu.

**NOTE:** With new BIOS releases, the following content is subject to change, so the menu might be different than shown.

<table>
<thead>
<tr>
<th>File</th>
<th>System Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Displays the following system characteristics:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Product Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SKU Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Processor Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Processor Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Processor Stepping (stepping designation and patch number)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Cache Size (L1/L2/L3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Memory Size</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Integrated MAC (onboard NIC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• System BIOS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Chassis Serial Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Asset Tracking Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ME (Intel Management Engine) Firmware Version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ME Management Mode</td>
</tr>
</tbody>
</table>

| About | | Displays copyright information. |

| Set Time and Date | | Lets you set system time and date. Use the keyboard Tab and arrow keys to make changes. |

| Flash System ROM | | Lets you upgrade the BIOS from a ROM image on optical media or USB. |

| Replicated Setup | | Provides these options: |
|                  | | • Save to Removable Media—Saves the computer configuration, including CMOS, to a USB storage device. The saved configuration file is named cpqsetup.txt. |
|                  | | • Restore from Removable Media—Restores the computer configuration from a USB storage device. |

| Default Setup | | Provides these options: |
|              | | • Save Current Settings as Default—Saves the current settings as default settings for the next operation. |
|              | | • Restore Factory Settings as Default—Restores the factory settings as the default settings for the next operation. |

<p>| Apply Defaults and Exit | | Restores the default settings defined in Default Setup. |</p>
<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ignore Changes and Exit</td>
<td></td>
<td>Exits computer setup without applying or saving changes.</td>
</tr>
<tr>
<td>Save Changes and Exit</td>
<td></td>
<td>Saves changes to system configuration and exits the computer setup.</td>
</tr>
<tr>
<td>Storage</td>
<td>Device Configuration</td>
<td>Lists installed SATA storage devices and provides specific information about each device:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Hard Disk—Provides information about the hard disk drives.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● CD-ROM—Provides information about the optical disk drives.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Default Values—Resets devices to their default configuration (SATA is the default).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Translation Mode—Enables the BIOS to determine the translation mode used to configure a formatted SATA or USB mass storage device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This prevents you from needing to know how the mass storage device was formatted. Options are Automatic (default), Bit Shift, LBA Assisted, User (Cylinders, Heads, Sectors), and Off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ordinarily, you should not change the translation mode selected by the BIOS. If the selected translation mode is not compatible with the translation mode that was active when the drive was partitioned and formatted, the data on the disk becomes inaccessible.</td>
</tr>
<tr>
<td></td>
<td>Storage Options</td>
<td>Provides these options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Removable Media Boot (Enabled/Disabled)—Enabling allows the workstation to boot from removable media, such as a USB flash drive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● SATA Emulation—Sets the SATA emulation mode with the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ RAID + AHCI—both the RAID and AHCI OPROMs execute. This emulation mode is the default and offers the best performance and most functionality.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ IDE—offers standard SATA support. Some higher-numbered SATA ports may not be available in this mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● eSATA Port—Displays the internal SATA port(s) that are configured to operate as eSATA. Changing this to None provisions the port(s) as internal SATA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Max eSATA Speed—Configures eSATA port speeds:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Gen 2 (3.0 Gbps)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Gen 1 (1.5 Gbps)</td>
</tr>
<tr>
<td></td>
<td>DPS Self-test</td>
<td>Select a drive—Lets you execute self-tests on SATA hard drives capable of performing Drive Protection System (DPS) self-tests.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> This selection appears only when the system has one or more drives capable of performing the DPS self-tests.</td>
</tr>
</tbody>
</table>
Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)

<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boot Order</td>
<td>Let you configure the boot order by physically reordering the menu entries. The default boot order is:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● EFI Boot Sources</td>
<td>• USB Floppy/CD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• USB Hard Drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ATAPI CD/DVD Drive</td>
</tr>
<tr>
<td></td>
<td>● Legacy Boot Sources</td>
<td>• ATAPI CD/DVD Drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• USB Floppy/CD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hard Drive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Network Controller</td>
</tr>
<tr>
<td></td>
<td>You can take the following actions:</td>
<td>• Press Enter to drag a device with the arrow keys to a preferred place, then press Enter again to drop the device in place.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Press F5 to remove the device from consideration as a bootable device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You must confirm changes by selecting File&gt;Save Changes and Exit and then press Enter. The computer then stores boot order changes in the physical ROM.</td>
</tr>
<tr>
<td></td>
<td>To temporarily override the boot order and boot from a device other than the default device specified in Boot Order:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Restart the computer.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Press F9 when the F9=Boot Menu message appears on the screen.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Wait for POST to finish and for the list of bootable devices to display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Use the arrow keys to select the preferred boot device.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5. Press Enter. The computer then starts from the selected nondefault device. (This does not change the default boot device.)</td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td>Setup Password</td>
<td>Lets you set and enable a setup password for the administrator.</td>
</tr>
<tr>
<td></td>
<td>If you create a setup password, you must use it to change computer setup options, to flash the ROM, and to make changes to certain Plug and Play settings under Windows.</td>
<td></td>
</tr>
<tr>
<td>Power-On</td>
<td>Password</td>
<td>Let you set and enable the power-on password.</td>
</tr>
<tr>
<td>Heading</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Password Options</td>
<td>This option becomes available depending on the presence of setup or power-on passwords. It provides these options: • Lock Legacy Resources (Enabled/Disabled)—Prevents the operating system from changing resources to serial, parallel, or diskette controller. (Appears if a setup password is set.) • Setup Browse Mode (Enabled/Disabled)—Lets you view but not change the F10 Setup Options without having to enter the setup password. (Appears if a setup password is set.) • Password prompt on F9, F11, and F12 (Enabled/Disabled)—Lets you access menus without entering the setup password. • Network Server Mode (Disabled/Enabled)—Enables network server mode. (Appears if a power-on password is set.)</td>
<td></td>
</tr>
<tr>
<td>Smart Cover</td>
<td>Lets you enable/disable the cover removal sensor.</td>
<td></td>
</tr>
<tr>
<td>Device Security</td>
<td>Makes the following devices available or hidden to the computer: • Embedded Security Device (hidden by default) • System Audio • Network Controller • SATA ports With the exception of Embedded Security Device (TPM), Device Available is the default setting for all devices (allows the operating system to access the device). Device Hidden disables the device by the BIOS so that the operating system can no longer enable the device. <strong>NOTE:</strong> An entry for enabling DriveLock appears in the setup menu if the computer has a DriveLock-compatible hard disk drive.</td>
<td></td>
</tr>
<tr>
<td>USB Security</td>
<td>Set workstation USB ports to Enabled/Disabled: • Front USB Ports • Rear USB Ports • Accessory USB Ports</td>
<td></td>
</tr>
<tr>
<td>Slot Security</td>
<td>Lets you disable any PCI or PCI Express slot.</td>
<td></td>
</tr>
<tr>
<td>Network Boot</td>
<td>Lets you enable/disable the ability to boot from the network using the F12 key or the boot order.</td>
<td></td>
</tr>
<tr>
<td>System IDs</td>
<td>Provides these options: • Asset Tag—A user-editable, 16-byte string identifying the computer. • Ownership Tag—A user-editable, 80-byte string identifying ownership of the computer. This tag appears on the screen during POST. • Universal Unique Identifier (UUID)—An ID number set in the factory that uniquely identifies the computer. • Keyboard—Lets you set the keyboard locale for System ID entry.</td>
<td></td>
</tr>
</tbody>
</table>
Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)

<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Security</td>
<td></td>
<td>With the exception of the first option, Data Execution Prevention, changing any of these system security settings and choosing <strong>File &gt; Save Changes and Exit</strong> will result in the computer performing a global reset, automatically turning itself off and then back on. Note also that these options are hardware dependent and may not be available on some models:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data Execution Prevention (Enabled/Disabled)—Helps prevent operating system security breaches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Virtualization Technology (VTx)(^1) (Disabled/Enabled)—Controls the virtualization features of the processor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Virtualization Technology Directed I/O (VTd)(^1) (Disabled/Enabled)—Controls virtualization DMA remapping features of the chipset.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Intel TXT((LT)) Support(^1) (Enabled/Disabled)—Controls the underlying processor and chipset features needed to support a virtual appliance. To enable this feature you must enable:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Virtualization Technology (VTx)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Virtualization Technology Directed I/O (VTd)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Embedded Security Device</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Embedded Security Device(^1) (Disabled/Enabled)—Permits activation and deactivation of the Embedded Security Device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> Embedded Security Device must be set to <strong>Device Available</strong> in the Device Security menu, and you must create a Setup Password, in order to configure the Embedded Security Device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reset to Factory Settings(^1) (Do not reset/Reset)—Restores factory defaults and erases all security keys.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>CAUTION:</strong> Choosing Reset to Factory Settings may result in significant data loss. The embedded security device is a critical component of many security schemes. Erasing the security keys prevent access to data protected by the Embedded Security Device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OS Management of Embedded Security Device(^1) (Disabled/Enabled)—Limits operating system control of the Embedded Security Device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reset of Embedded Security Device through OS(^1) (Enabled/Disabled)—Limits the operating system ability to request a Reset to Factory Settings of the Embedded Security Device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> You must create a Setup Password to use this option.</td>
</tr>
<tr>
<td>Drive Lock Security</td>
<td></td>
<td>Lets you assign or modify a master password or user password for hard drives. When enabled, this feature prompts the user to provide one of the DriveLock passwords during POST. If the user does not successfully enter one of the passwords, the hard drive remains inaccessible until one of the passwords is successfully entered during a subsequent cold-boot sequence.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> This selection appears only when the system includes at least one drive that supports the DriveLock feature.</td>
</tr>
<tr>
<td>Heading</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Power</td>
<td>OS Power Management</td>
<td>Enables or disables:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Runtime Power Management</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Idle Power Savings: Extended (default) or Normal; extended mode reduces processor power consumption when the CPU is idle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● ACPI S3 PS2 Mouse Wakeup</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Unique Sleep State Blink Rates</td>
</tr>
<tr>
<td>Hardware Power</td>
<td></td>
<td>Enables or disables:</td>
</tr>
<tr>
<td>Management</td>
<td></td>
<td>● SATA Power Management</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● S5 Maximum Power Savings</td>
</tr>
<tr>
<td>Thermal</td>
<td></td>
<td>Lets you set the minimum speed of the system fan when the CPU is idle.</td>
</tr>
<tr>
<td>Advanced(^2)</td>
<td>Power-On Options</td>
<td>Sets the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● POST Mode:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● QuickBoot—Do not clear memory or perform a memory test.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● FullBoot—Memory test (count) on cold boot. Clears memory on all boots.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Clear Memory—No memory test (count) on cold boot. Clears memory on all boots.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● FullBoot Every x Days—Memory count on first cold boot on or after the Xth day and no more memory counts until that boot occurs. Clears memory on all boots.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● POST Messages (Enabled/Disabled)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Press the ESC key for Startup Menu (Enabled/Disabled)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Option ROM Prompt (Enabled/Disabled)—Enabling this feature causes the computer to display a message before loading option ROMs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● After Power Loss—Lets you specify computer behavior after a power loss:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● <strong>Power Off</strong>—Computer remains powered off when power is restored (default).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● <strong>Power On</strong>—Computer automatically powers on when power is restored. (This lets you power on the computer using a power strip switch, if the computer is connected to an electric power strip.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● <strong>Previous state</strong>—Computer powers on automatically when power is restored only if computer was on when power was lost.</td>
</tr>
</tbody>
</table>
### Table 4-1  Computer Setup (F10) Utility menu descriptions (continued)

<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIOS Power-On</td>
<td></td>
<td>Lets you disable or specify a weekday and time for BIOS power-on.</td>
</tr>
<tr>
<td>Onboard Devices</td>
<td></td>
<td>Lets you disable or set resources (IRQ, DMA, I/O Rate) for onboard system devices such as the serial port and parallel ports. Operating system parameters generally override Onboard Devices settings.</td>
</tr>
<tr>
<td>Bus options</td>
<td>Enable/disable these options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ PCI SERR# Generation (Enabled/Disabled)—Controls PCI SERR# generation for ill-behaved PCI add-in cards (that can generate SERR# spuriously)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ PCI VGA Palette Snooping (Disabled/Enabled)—Controls PCI VGA Palette Snooping for compatibility purposes</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** If you turn off power to the computer using a power strip, you cannot use the suspend/sleep feature or the Remote Management features.

- POST Delay (None (default), 5, 10, 15, 20 seconds)—Delays start of the POST process. You might need a delay to:
  - Allow time for some hard disk drives to spin up before POST is finished
  - Give yourself more time to select F10 to enter the Computer Setup (F10) Utility.
- Remote Wakeup Boot Source (Local Hard Drive/Remote Server). Sets the boot device for the workstation when it is started using Remote Wakeup (takes precedence over the Boot Order menu setting).
- System Recovery Boot Support (Enabled/Disabled). Enabling this feature displays an additional prompt, **F11=Recovery**, during POST on systems with HP Backup and Recovery software installed and configured with a recovery partition on the boot hard drive. Pressing F11 causes the system to boot to the recovery partition and launch HP Backup and Recovery. You can hide the **F11=Recovery** prompt by using the F11 prompt option described above.
- Bypass F1 Prompt on Confirmation Changes (Enabled/Disabled)—Prevents display of a confirmation prompt when you make changes to the system.
<table>
<thead>
<tr>
<th>Heading</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device Options</strong></td>
<td>Enable/disable the following device options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● S5 Wake-on-LAN (Enabled/Disabled)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Turbo Mode (Enabled/Disabled)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Printer Mode (EPP+ECP, Output Only, Bi-Directional)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Num Lock State at Power-On (On/Off)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Integrated Video† (Enabled/Disabled)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● IGD (Integrated Graphics Device) Memory—Displayed when Integrated Video is Enabled. Sets the maximum amount of system memory that can be allocated as graphics memory (32, 64 (default), 128, 256, 512 MB)†</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Internal Speaker (Enabled/Disabled)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● NIC Option ROM§ Download (PXE/Disabled)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● SATA RAID Option ROM§ Download (Enabled/Disabled)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Multi-Processor (Enabled/Disabled)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Hyperthreading† (Disabled/Enabled)</td>
<td></td>
</tr>
<tr>
<td><strong>Slot Settings</strong></td>
<td>Lets you Enable/Disable Option ROM Download for each slot. Selective disabling of Option ROM downloads can help manage limited Option ROM space.</td>
<td></td>
</tr>
<tr>
<td><strong>AMT Configuration</strong></td>
<td>Lets you set the following AMT (Intel Active Management Technology) configuration options:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● AMT (Enabled/Disabled)—Allows for remote discovery, repair and protection of networked workstations. Enabling the AMT function also enables the Network Controller (required for AMT to function correctly).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● Unconfigure AMT/ME (Disabled/Enabled)§—Restores AMT/ME defaults. When you save and exit after enabling this option, you will be prompted to complete the process upon restart. A Setup Password (even if one is set) does not need to be entered to complete the process.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Information about Intel AMT can be found at <a href="http://www.intel.com">www.intel.com</a>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● WatchDog Timer (Enabled/Disabled)—OS and BIOS WatchDog Timers can be set independently (in minutes):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ OS WatchDog Timer—Sets the OS WatchDog Timer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ BIOS WatchDog Timer—Sets the BIOS WatchDog Timer.</td>
<td></td>
</tr>
</tbody>
</table>

† Available on selected models

§ These options should be used by advanced users only
Desktop management

This section summarizes capabilities, features, and key components of computer management, including:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial computer configuration and deployment on page 37</td>
</tr>
<tr>
<td>Installing a remote system on page 37</td>
</tr>
<tr>
<td>Replicating the setup on page 38</td>
</tr>
<tr>
<td>Updating and managing software on page 39</td>
</tr>
<tr>
<td>HP Client Manager Software on page 39</td>
</tr>
<tr>
<td>Altiris Client Management Solutions on page 39</td>
</tr>
<tr>
<td>System Software Manager on page 40</td>
</tr>
<tr>
<td>ROM Flash on page 40</td>
</tr>
<tr>
<td>FailSafe Boot Block ROM on page 41</td>
</tr>
<tr>
<td>Workstation security on page 42</td>
</tr>
<tr>
<td>Fault notification and recovery on page 51</td>
</tr>
<tr>
<td>Dual-state power button on page 52</td>
</tr>
</tbody>
</table>

**NOTE:** Support for specific features described in this guide can vary by model and software version.
Initial computer configuration and deployment

The computer includes a preinstalled system software image. After a brief software unbundling process, the computer is ready to use.

If you prefer to replace the preinstalled software image with a customized set of system and application software, several methods are available for deploying a customized software image, including:

- Installing additional software applications after unbundling the preinstalled software image
- Using a disk cloning process to copy the contents from one hard disk drive to another

The HP Recovery Manager DVDs, ROM-based setup, and ACPI hardware provide further assistance with recovery of system software, configuration management and troubleshooting, and power management.

Support for specific features described in this guide can vary by model and software version.

The best deployment method depends on the information technology environment and processes.

Installing a remote system

Remote system installation enables starting and setting up the computer using software and configuration information on a network server. This feature is usually used as a system setup and configuration tool and can be used for the following tasks:

- Deploying a software image on new PCs
- Formatting a hard disk drive
- Installing application software or drivers
- Updating the operating system, application software, or drivers

To initiate a remote system installation, press F12 when F12=Network Service Boot appears in the lower right corner of the HP logo screen. Follow the onscreen instructions to continue the installation process. The default boot order is a BIOS configuration setting that can be changed to always attempt a PXE boot.
Replicating the setup

This section provides information about replicating the computer setup.

Copying a setup configuration to another computer

⚠️ **CAUTION:** A setup configuration is model-specific. File system corruption can result if source and target computers are not the same model.

To copy a setup configuration:

1. Select a setup configuration to copy, and then restart the computer.

2. As soon as the computer powers on, press and hold F10 until you enter the Computer Setup (F10) Utility. If necessary, press Enter to bypass the title screen.

   **NOTE:** If you do not press F10 at the appropriate time, you must restart the computer, and then press and hold F10 again to access the utility.

   If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select `File>Replicated Setup>Save to Removable Storage Device`. Follow the instructions on the screen to create the configuration file `cpqsetup.txt` and write it to a USB storage device.

4. Power off the computer you are configuring and insert the removable USB media device containing the configuration file.

5. Power on the computer you are configuring.

6. Press and hold the F10 key until you enter the Computer Setup (F10) Utility. If necessary, press Enter to bypass the title screen.

7. Select `File>Replicated Setup>Restore from Removable Storage Device`, and then follow the instructions on the screen.

8. Restart the computer when the configuration is complete.
Updating and managing software

HP provides several tools for managing and updating software on desktops and computers:

- HP Client Manager Software
- Altiris Client Management Solutions
- HP SoftPaq Download Manager
- System Software Manager

**HP Client Manager Software**

The HP Client Manager Software offers these services:

- Detailed views of hardware inventory for asset management
- PC health-check monitoring and diagnostics
- Proactive notification of changes in the hardware environment
- Web-accessible reporting of business-critical details such as thermal warnings and memory alerts
- Remote updating of system software such as device drivers and ROM BIOS
- Remote changing of boot order
- Configuration of system BIOS settings


For more information about the HP Client Manager, see [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm).

**Altiris Client Management Solutions**

Altiris and HP have partnered to provide comprehensive, tightly integrated systems management solutions to reduce the cost of owning HP client PCs.

The HP CMS is the foundation for additional Altiris Client Management Solutions that address the following topics.

- Inventory and asset management
- Deployment and migration
- Help desk and problem resolution
- Software and operations management

For more information about the following topics, go to [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm).

- How HP CMS works
- Which solutions are compatible with the operating system
- How to download a fully functional, 30-day evaluation version of Altiris solutions
**HP SoftPaq Download Manager**

HP SoftPaq Download Manager is a free, easy-to-use interface for locating and downloading software updates for the HP client PC models in your environment. By specifying your models, operating system, and language, you can quickly locate, sort, and select the softpaqs you need. To download HP SoftPaq Download Manager, visit [http://h20331.www2.hp.com/Hpsub/cache/509658-0-0-225-121.html](http://h20331.www2.hp.com/Hpsub/cache/509658-0-0-225-121.html).

**System Software Manager**

System Software Manager (SSM) is a utility available on Windows computers that enables you to update system-level software on multiple systems simultaneously. When executed on a PC client system, SSM detects hardware and software versions and then updates the software from a central repository, known as a file store. Driver versions supported by SSM are noted with a special icon on the software, the driver download Web site, and on the Support Software CD.

To download the utility or to obtain more information about SSM, see [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm).

**ROM Flash**

HP computers include a programmable flash ROM. By establishing a setup password in the Computer Setup (F10) Utility, you can protect the ROM from being inadvertently updated or overwritten. This function is important to ensure the operating integrity of the computer.

To upgrade the ROM, download the latest SoftPaq images from [http://www.hp.com/support/workstation_swdrivers](http://www.hp.com/support/workstation_swdrivers).

For maximum ROM protection, establish a setup password. The setup password prevents unauthorized ROM upgrades. SSM enables you to create the setup password on several computers simultaneously.

**Remote ROM Flash**

Remote ROM Flash allows system administrators to safely upgrade the ROM on remote HP computers from a centralized network management console, resulting in a consistent deployment of, and greater control over, HP PC ROM images over the network.

To use Remote ROM Flash, the computer must be powered on, or turned on using Remote Wakeup.

For more information about Remote ROM Flash and HPQFlash, see the HP Client Manager Software or System Software Manager sections at [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm).

**HPQFlash**

The HPQFlash utility is used to locally update or restore the system ROM on PCs using a Windows operating system. For more information about HPQFlash, see [http://www.hp.com/go/ssm](http://www.hp.com/go/ssm), and enter the name of the computer.
FailSafe Boot Block ROM

The FailSafe Boot Block ROM enables system recovery in the unlikely event of a ROM flash failure. For example, if a power failure occurs during a ROM upgrade, the Boot Block uses a flash-protected section of the ROM to verify a valid system ROM flash when power is restored to the computer.

If the system ROM is valid, the computer starts normally.

If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support to start the computer from a BIOS image CD created from a SoftPaq. The BIOS image CD programs the system ROM with a valid image.

When Boot Block detects an invalid system ROM, the computer power LED blinks red eight times and the computer beeps eight times; then the computer pauses for two seconds. On some models, a Boot Block recovery mode message appears.

In preparation for system recovery, use the BIOS CD media file in the SoftPaq to create a BIOS image CD.

Recovering the computer from Boot Block Recovery mode

To recover the computer after it enters Boot Block recovery mode:

1. Remove any media such as USB keys or disks in the optical disk drives.

2. Insert a BIOS image CD into the CD drive. You can also use USB media such as an HP DriveKey.

3. Power off, then power on the computer.
   - If no BIOS image CD or USB media is found, you are prompted to insert one and restart the computer.
   - If a setup password has been established, the Caps Lock light illuminates and you are prompted for the password.

4. Enter the setup password.
   - If the computer starts from the CD or USB media and successfully reprograms the ROM, three keyboard lights illuminate. A rising-tone series of beeps also signals successful recovery.

5. Remove the CD or USB media and power off the computer.

6. Restart the computer.
Workstation security

This section provides information about providing system security through asset tracking, password security, hard disk drive locking, and chassis locks.

Asset tracking

Asset tracking features incorporated into the computer provide asset tracking data that can be managed using HP Systems Insight Manager (HP SIM), HP CMS, or other systems-management applications.

Seamless, automatic integration between asset tracking features and these products enables you to choose the management tool that is best suited to the environment and to leverage investments in existing tools.

HP also offers several solutions for controlling access to valuable components and information:

- HP ProtectTools Embedded Security prevents unauthorized access to data, checks system integrity, and authenticates third-party users attempting system access.
- Security features such as ProtectTools and the Side access panel sensor (Smart Cover Sensor) help prevent unauthorized access to the data and to the internal components of the computer.
- By disabling parallel, serial, or USB ports, or by disabling removable-media boot capability, you can protect valuable data assets.
- Memory Change and Side access panel sensor (Smart Cover Sensor) alerts can be forwarded to system management applications to deliver proactive notification of tampering with a computer’s internal components.

ProtectTools, the Side access panel sensor (Smart Cover Sensor), and the Side access panel solenoid lock (Hood Lock) are available as options on select systems.

Use the following utilities to manage security settings on the HP computer:

- Locally, using the Computer Setup (F10) Utility
- Remotely, using the HP CMS or System SSM, which enables the secure, consistent deployment and control of security settings from a simple command line utility

For more information about the Computer Setup (F10) Utility, see The Computer Setup (F10) Utility menu on page 28.

The following table and sections refer to the management of computer security through the Computer Setup (F10) Utility.

Table 4-2 Security features overview

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
<th>How it is established</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removable Media Boot Control</td>
<td>Prevents booting from removable media drives</td>
<td>From the Computer Setup (F10) Utility menu</td>
</tr>
<tr>
<td>Serial, Parallel, USB, or Infrared Interface Control</td>
<td>Prevents transfer of data through the integrated serial, parallel, USB, or infrared interface</td>
<td>From the Computer Setup (F10) Utility menu</td>
</tr>
</tbody>
</table>
### Table 4-2  Security features overview (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
<th>How it is established</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power-On Password</td>
<td>Prevents use of the computer until the password is entered (applies to initial system startup and restarts)</td>
<td>From the Computer Setup (F10) Utility menu</td>
</tr>
<tr>
<td>Setup Password</td>
<td>Prevents reconfiguration of the computer (use of the Setup utility) until the password is entered</td>
<td>From the Computer Setup (F10) Utility menu</td>
</tr>
<tr>
<td>Network Server Mode</td>
<td>Provides unique security features for computers used as servers</td>
<td>From the Computer Setup (F10) Utility menu</td>
</tr>
</tbody>
</table>

### SATA hard disk drive security

HP computers include the HP DriveLock facility for SATA hard disk drives to prevent unauthorized access to data.

⚠️ **WARNING!** Enabling DriveLock can render a SATA hard disk drive permanently inaccessible if the master password is lost or forgotten. No method exists to recover the password or access the data.

DriveLock has been implemented as an extension to Computer Setup (F10) functions. It is only available when hard disk drives that support the ATA security command set are detected. On HP computers, it is not available when the SATA emulation mode is RAID+AHCI or RAID.

DriveLock is for HP customers for whom data security is a paramount concern. For such customers, the cost of a hard disk drive and the loss of the data stored on it is inconsequential when compared to the damage that could result from unauthorized access to its contents.

To balance this level of security with the need to address the issue of a forgotten password, the HP implementation of DriveLock employs a two-password security scheme. One password is intended to be set and used by a system administrator, while the other is typically set and used by the user.

No “back door” can be used to unlock the drive if both passwords are lost. Therefore, DriveLock is most safely used when the data contained on the hard disk drive is replicated on a corporate information system or is regularly backed up.

If both DriveLock passwords are lost, the hard disk drive is rendered unusable. For users who do not fit the previously defined customer profile, this might not be acceptable. For users who fit this profile, it might be a tolerable risk, given the nature of the data stored on the hard disk drive.
**DriveLock applications**

The most practical use of DriveLock is in a corporate environment. The system administrator would be responsible for configuring the hard disk drive, which involves setting the DriveLock master password and a temporary user password. If you forget the user password or if the equipment is passed on to another employee, the master password can be used to reset the user password and regain access to the hard disk drive.

HP recommends that corporate system administrators who enable DriveLock also establish a corporate policy for setting and maintaining master passwords. This should be done to prevent a situation where an employee sets both DriveLock passwords before leaving the company. In such a scenario, the hard disk drive is unusable and requires replacement. Likewise, by not setting a master password, system administrators might find themselves locked out of a hard disk drive and unable to perform routine checks for unauthorized software, other asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users in this category include personal users, or users who do not maintain sensitive data on their hard disk drives as a common practice. For these users, the potential loss of a hard disk drive resulting from forgetting both passwords is much greater than the value of the data DriveLock protects.

Access to Computer Setup (F10) and DriveLock can be restricted through the setup password. By specifying a setup password and not giving it to users, system administrators can restrict users from enabling DriveLock.

**Using DriveLock**

When hard disk drives that support the ATA security command set are detected, DriveLock appears under the Security menu in the Computer Setup (F10) menu. You are presented with options to set the master password and to enable DriveLock. You must provide a user password to enable DriveLock. Because the initial configuration of DriveLock is typically performed by a system administrator, a master password should be set first.

HP encourages system administrators to set a master password whether they plan to enable DriveLock or not. This gives the administrator the ability to modify DriveLock settings if the drive is locked in the future. After the master password is set, the system administrator can enable DriveLock or leave it disabled.

If a locked hard disk drive is present, POST requires a password to unlock the device. If a power-on password is set and it matches the device’s user password, POST does not prompt the user to re-enter the password. Otherwise, the user is prompted to enter a DriveLock password.

For a cold start, use the master or user password. For a warm start, enter the same password used to unlock the drive during the preceding cold start.

Users have two attempts to enter a correct password. During cold start, if neither attempt succeeds, POST continues but the drive remains inaccessible. During a warm-start or restart from Windows, if neither attempt succeeds, POST halts and the user is instructed to cycle power.
Enabling DriveLock

To enable and set the DriveLock user password:

1. Power on or restart the computer.

2. As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

   If you do not press F10 at the appropriate time, you must restart the computer, and then press and hold F10 again to access the utility.

   If you are using a PS2 keyboard, you might see a keyboard error message. Disregard it.


4. For each DriveLock-capable drive, select a drive by pressing F10 to accept.

5. Under Enable/Disable DriveLock options, select Enable, and then press F10 to enable DriveLock for a specific drive.

   **CAUTION:** Forgetting the DriveLock password renders the drive unusable.

6. Enter a new user password, and then press F10 to accept. This password may be 1 to 32 characters long.

7. Enter the password again in the Enter New Password Again field. If you forget this password, the drive is rendered permanently disabled.

8. Select File>Save Changes and Exit, and then press F10. After you press F10, the computer performs a cold start before invoking the DriveLock function.

   You can also use this process to set the DriveLock master password by selecting Master in Step 5.

   When the computer starts, you are prompted to enter the DriveLock password for each DriveLock-capable drive for which you have set a password. You have two attempts to enter the password correctly. If the password is not entered correctly, the computer attempts to start anyway. However, the boot process most likely fails because data from a locked drive cannot be accessed.

   In a single drive computer, if the drive has DriveLock enabled, the computer might not be able to boot to the operating system, and might try to boot from the network or from another storage device (depending on the boot ordering options). Regardless of the outcome of the start attempts, the drive-locked drive remains inaccessible without the DriveLock password.

   In a two-drive computer that has a boot drive and a data drive, you can apply the DriveLock feature to the data drive only. In this case, the computer can always start, but the data drive is accessible only when the DriveLock password is entered.

   Cold starts require that you enter DriveLock passwords. However, DriveLock passwords are also required for warm starts. For example, if you boot to DOS and press Ctrl+Alt+Del, you must enter the DriveLock password before the computer completes the next start cycle. This warm-start behavior is consistent with the DriveLock feature.
Password security

The power-on password prevents unauthorized use of the computer by requiring entry of a password to access applications or data when the computer is powered on or restarted. The setup password specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as an override to the power-on password. When prompted for the power-on password, entering the setup password instead enables access to the computer.

You can establish a network-wide setup password to enable the system administrator to log in to all network systems to perform maintenance without needing to know the power-on password.

Establishing a setup password using Computer Setup (F10) Utility

Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the computer (through the use of the Computer Setup (F10) Utility) until the password is entered.

To establish a setup password using the Computer Setup (F10) menu:

1. Power on or restart the computer.
2. As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

   If you do not press F10 at the appropriate time, you must restart the computer, and then press and hold F10 again to access the utility.

   If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security>Setup Password and then follow the onscreen instructions.
4. Before exiting, select File>Save Changes and Exit.
Establishing a power-on password using computer setup

Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the computer when power is connected, unless you specify the password. When a power-on password is set, the Computer Setup (F10) Utility presents Password Options in the Security menu. The password options include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, you must enter the password when the computer is powered on, when the key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, you must enter the password. The password must also be entered each time the computer is restarted. When Network Server Mode is enabled, the password prompt is not presented during POST, but an attached PS/2 keyboard remains locked until you enter the power-on password.

To enable Network Server Mode, you must set a power-on password under Advanced>Password Options. This option enables the computer to start without requiring the power-on password, but the keyboard and mouse are locked until you enter the password. The keyboard LEDs rotate constantly when the computer is in locked mode.

To establish a power-on password through the Computer (F10) menu:

1. Power on or restart the computer.
2. As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
   - If you do not press F10 at the appropriate time, you must restart the computer and then press and hold F10 again to access the utility.
   - If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
3. Select Security>Power-On Password and then follow the onscreen instructions.
4. Before exiting, select File>Save Changes and Exit.

Entering a power-on password

To enter a power-on password:

1. Restart the computer.
2. When the key icon appears on the monitor, enter the current password, and then press Enter.
   - Type carefully. For security reasons, the characters you enter do not appear on the screen.
   - If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful tries, you will enter the F10 setup screen with read-only permission. (See the Setup Browse Mode option under the Power-On options.)
Entering a setup password

If a setup password has been established on the computer, you will be prompted to enter it each time you run the Computer Setup (F10) Utility.

To enter a setup password:

1. Restart the computer.
2. As soon as the computer is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
   
   If you do not press F10 at the appropriate time, you must restart the computer and press and hold F10 again to access the utility.
   
   If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
3. When the key icon appears on the monitor, enter the setup password, and press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful tries, you must restart the computer before you can continue.

Changing a power-on or setup password

To change a power-on or setup password:

1. Restart the computer.
2. To change the power-on password, go to step 4.
3. To change the setup password, as soon as the computer is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
   
   If you do not press F10 at the appropriate time, you must restart the computer, and then press and hold the F10 key again to access the utility.
   
   If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.
4. When the key icon appears, enter the current password, a slash (/) or alternative delimiter character, the new password, another slash (/) or alternative delimiter character, and the new password again as shown:

   current password/new password/new password

   For information about the alternative delimiter characters, see National keyboard delimiter characters on page 49.

   Type carefully. For security reasons, the characters you enter do not appear on the screen.
5. Press Enter.

The new password takes effect the next time you power on the computer.

The power-on and setup passwords can also be changed using the Security options in the Computer Setup (F10) Utility.
Deleting a power-on or setup password

To delete a power-on or setup password:

1. Power on or restart the computer.

2. Choose from the following:
   - To delete the power-on password, go to step 4.
   - To delete the setup password, as soon as the computer is powered on, press and hold F10 until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

   If you do not press F10 at the appropriate time, you must restart the computer and then press and hold F10 again to access the utility.

   Use the appropriate operating system shutdown process.

3. When the key icon appears, enter the current password followed by a slash (/) or alternative delimiter character: \textit{current password/}.

   For information about the alternative delimiter characters see National keyboard delimiter characters on page 49.

4. Press Enter.

National keyboard delimiter characters

Each keyboard meets country-specific requirements. The syntax and keys you use for changing or deleting passwords depend on the keyboard included with the computer.

<table>
<thead>
<tr>
<th>Language</th>
<th>Delimiter</th>
<th>Language</th>
<th>Delimiter</th>
<th>Language</th>
<th>Delimiter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic</td>
<td>/</td>
<td>Greek</td>
<td>-</td>
<td>Russian</td>
<td>/</td>
</tr>
<tr>
<td>Belgian</td>
<td>=</td>
<td>Hebrew</td>
<td>-</td>
<td>Slovakian</td>
<td>-</td>
</tr>
<tr>
<td>BHCSY*</td>
<td>-</td>
<td>Hungarian</td>
<td>-</td>
<td>Spanish</td>
<td>-</td>
</tr>
<tr>
<td>Brazilian</td>
<td>/</td>
<td>Italian</td>
<td>-</td>
<td>Swedish/Finnish</td>
<td>/</td>
</tr>
<tr>
<td>Chinese</td>
<td>/</td>
<td>Japanese</td>
<td>/</td>
<td>Swiss</td>
<td>-</td>
</tr>
<tr>
<td>Czech</td>
<td>-</td>
<td>Korean</td>
<td>/</td>
<td>Taiwanese</td>
<td>/</td>
</tr>
<tr>
<td>Danish</td>
<td>-</td>
<td>Latin American</td>
<td>-</td>
<td>Thai</td>
<td>/</td>
</tr>
<tr>
<td>French</td>
<td>!</td>
<td>Norwegian</td>
<td>-</td>
<td>Turkish</td>
<td>.</td>
</tr>
<tr>
<td>French</td>
<td>é</td>
<td>Polish</td>
<td>-</td>
<td>U.K. English</td>
<td>/</td>
</tr>
<tr>
<td>Canadian</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>German</td>
<td>-</td>
<td>Portuguese</td>
<td>-</td>
<td>U.S. English</td>
<td>/</td>
</tr>
</tbody>
</table>

* Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
Clearing passwords

If you forget the password, you cannot access the computer.

For instructions about clearing passwords, see Configuring password security and resetting CMOS.

Chassis security

Side access panel sensor (Smart Cover Sensor) (optional)

The optional Side access panel sensor is a combination of hardware and software technology that can alert you when the computer side access panel has been removed (if the sensor has been configured in the Computer Setup (F10) Utility).

The three levels of Side access panel sensor protection are shown in the following table:

<table>
<thead>
<tr>
<th>Table 4-4 Side access panel sensor protection levels</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Level</strong></td>
</tr>
<tr>
<td>Level 0</td>
</tr>
<tr>
<td>Level 1</td>
</tr>
<tr>
<td>Level 2</td>
</tr>
</tbody>
</table>

* Side access panel sensor settings can be changed using the Computer Setup (F10) Utility.

Setting the side access panel sensor protection level

To set the side access panel sensor protection level:

1. Power on or restart the computer.

2. As soon as the computer is powered on, press and hold the F10 key until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

   **NOTE:** If you do not press the F10 key at the appropriate time, you must restart the computer, and then press and hold the F10 key again to access the Computer Setup (F10) Utility.

   If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select **Security>Smart Cover>Cover Removal Sensor**, and follow the onscreen instructions.

4. Before exiting, select **File>Save Changes and Exit**.

Side access panel solenoid lock

The side access panel solenoid locks the side access panel to the chassis. The solenoid is controlled by a local or remote signal.

To lock the solenoid, set a password for the solenoid lock in the Computer Setup (F10) Utility. To unlock the solenoid, remove the solenoid lock password in the Computer Setup (F10) Utility.
The solenoid lock FailSafe Key—available from HP—is a device for manually disabling the solenoid lock. You will need the FailSafe Key in case of forgotten password, power loss, or computer malfunction.

**Cable lock (optional)**

To prevent theft, the rear chassis panel of the computer accommodates a keyed cable lock. This cable lock attaches to the chassis and secures it to the work area.

**Fault notification and recovery**

Fault notification and recovery features combine innovative hardware and software technology to prevent the loss of critical data and minimize unplanned downtime.

If the computer is connected to a network that is managed by HP CMS, the computer sends a fault notice to the network management application. With HP CMS, you can also remotely schedule diagnostics to run on managed PCs and create a summary report of failed tests.

**Drive Protection System**

The Drive Protection System (DPS) is a diagnostic tool built into hard disk drives and is installed in select HP computers. The DPS helps diagnose problems that might result in unwarranted hard disk drive replacement.

When HP computers are built, each installed hard disk drive is tested using the DPS, and a permanent record of key information is written onto each drive. Every time the DPS is run, test results are written to the hard disk drive. The service provider can use this information to help diagnose conditions that required you to run the DPS software.

**ECC fault prediction**

When the computer encounters an excessive number of error checking and correcting (ECC) memory errors, it displays a local alert message. This message contains information about the errant DIMM, enabling you to take action before you experience noncorrectable memory errors. ECC DIMMs are standard on this computer.

**Thermal sensors**

Several thermal sensors in the HP Workstation regulate computer fans to maintain an acceptable, efficient chassis temperature.
**Dual-state power button**

With ACPI enabled, the power button can function as an on/off switch or as a button. This feature does not completely turn off power, but instead causes the computer to enter a low-power standby state. This enables you to go to standby without closing applications, and to return to the same operational state without any data loss.

**Changing the power button configuration**

To change the power button configuration:

1. Select **Start**, and then select **Control Panel>Power Options**.
2. In Power Options Properties, select the **Advanced** tab.
3. In the Power Button section, select **Hibernate**.

   **NOTE:** Hibernate must be enabled in the Hibernate tab.

After configuring the power button to function as a button, you can press the power button to put the computer in a very low power state. Press the button again to bring the computer out of this low power state to full power state. To completely turn off power to the computer, press and hold the power button for four seconds.

**CAUTION:** Do not use the power button to power off the computer unless the system is not responding; turning off the power without operating system interaction can cause data loss.
5 Replacing components

This chapter presents removal and installation procedures for most internal workstation components. It includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warnings and cautions on page 54</td>
</tr>
<tr>
<td>Service considerations on page 55</td>
</tr>
<tr>
<td>Customer Self-Repair on page 59</td>
</tr>
<tr>
<td>Removing and installing components on page 60</td>
</tr>
<tr>
<td>Product recycling on page 108</td>
</tr>
</tbody>
</table>
Warnings and cautions

⚠️ **WARNING!** Any surface or area of the equipment marked with this symbol indicates the presence of a hot surface or hot component. If this surface is contacted, the potential for injury exists. To reduce the risk of injury from a hot component, enable the surface to cool before touching.

⚠️ **WARNING!** Any surface or area of the equipment marked with this symbol indicates the presence of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open any enclosed area marked with this symbol.

⚠️ **WARNING!** To reduce the risk of electric shock or damage to your equipment:
- Do not disable the power cord grounding plug. The grounding plug is an important safety feature.
- Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.
- Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

⚠️ **WARNING!** To reduce the risk of serious injury, read the *Safety & Comfort Guide*. It describes proper computer setup, posture, health, and work habits for computer users, and provides important electrical and mechanical safety information. This guide is located at [http://www.hp.com/ergo](http://www.hp.com/ergo).

⚠️ **WARNING!** If a product is shipped in packaging marked with this symbol, the product must always be lifted by two persons to avoid personal injury due to product weight.

⚠️ **CAUTION:** Static electricity can damage the electronic components of the computer. Before beginning these procedures, be sure you discharge static electricity by briefly touching a grounded metal object.

⚠️ **CAUTION:** Observe the following cautions when removing or replacing a processor:
- Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller or service provider to install the processor. If you plan to install the processor yourself, read all of the instructions carefully before you begin.
- Failure to follow the computer preparation instructions can result in an improperly installed processor, causing extensive computer damage.
- Processor socket pins are delicate and bend easily. Use extreme care when placing the processor in the socket.

⚠️ **CAUTION:** To prevent damage to the computer, observe the following Electrostatic Discharge (ESD) precautions while performing the system parts removal and replacement procedures:
- Work on a static-free mat.
- Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body to the ground.
- Create a common ground for the equipment you are working on by connecting the static-free mat, static strap, and peripheral units to that piece of equipment.
NOTE: HP accessories are for use in HP Workstation products. They have been extensively tested for reliability and are manufactured to high quality standards.

Service considerations

Review the following service considerations before replacing system components.

Cautions, warnings and safety precautions

Review the cautions, warnings, and safety precautions before accessing the computer components. Also, review the Safety and Regulatory Guide that came with the computer for more information.

ESD information

Generating static

The following table shows that different activities generate different amounts of static electricity through electrostatic discharge (ESD). Static electricity increases as humidity decreases.

<table>
<thead>
<tr>
<th>Event</th>
<th>Relative humidity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>55%</td>
</tr>
<tr>
<td>Walking across carpet</td>
<td>7,500V</td>
</tr>
<tr>
<td>Walking across vinyl floor</td>
<td>3,000V</td>
</tr>
<tr>
<td>Motions of bench worker</td>
<td>400V</td>
</tr>
<tr>
<td>Removing bubble pack from PCB</td>
<td>7,000V</td>
</tr>
<tr>
<td>Packing PCBs in foam-lined box</td>
<td>5,000V</td>
</tr>
</tbody>
</table>

CAUTION: Static electricity in the amount of 700 volts might degrade a product.
Preventing ESD equipment damage

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric components and accessories:

- Transport products in static-safe containers such as tubes, bags, or boxes, to avoid hand contact.
- Protect electrostatic parts and assemblies with nonconductive or approved containers or packaging.
- Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.
- Place items on a grounded surface before removing them from containers.
- When handling or touching a sensitive component or assembly, ground yourself by touching the chassis.
- Avoid contact with pins, leads, or circuitry.
- Place reusable electrostatic-sensitive parts from assemblies in protective packaging or nonconductive foam.

Personal grounding methods and equipment

Use the following items to help prevent ESD damage:

- **Wrist straps**—These are flexible straps with a maximum of one megohm ± 10% resistance in the ground cords. To provide a proper ground, wear the strap against bare skin. The ground cord must be connected and fit snugly into the banana plug connector on the grounding mat or computer.

- **Heel straps, toe straps, and boot straps**—These can be used at standing computers and are compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with a maximum of one megohm ± 10% resistance between the operator and ground.

The following table shows protection levels available from static shielding materials.

<table>
<thead>
<tr>
<th>Method</th>
<th>Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antistatic plastic</td>
<td>1,500V</td>
</tr>
<tr>
<td>Carbon-loaded plastic</td>
<td>7,500V</td>
</tr>
<tr>
<td>Metalized laminate</td>
<td>15,000V</td>
</tr>
</tbody>
</table>

This section provides guidelines to prevent ESD damage to equipment.
**Grounding the work area**

To prevent static damage in the work area:

- Cover the work surface with approved static-dissipative material. Use a wrist strap connected to the work surface, and properly grounded tools and equipment.
- Use static-dissipative mats, foot straps, or air ionizers to give added protection.
- Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate. Handle them only in static-free work areas.
- Disconnect power and input signals before inserting and removing connectors or test equipment.
- Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.
- Keep work area free of nonconductive materials, such as plastic assembly aids and Styrofoam.
- Use field service tools (such as cutters, screwdrivers, and vacuums) that are conductive.

**Recommended ESD prevention materials and equipment**

The recommended materials and equipment are:

- Antistatic tape
- Antistatic smocks, aprons, and sleeve protectors
- Conductive bins and other assembly or soldering aids
- Conductive foam
- Conductive tabletop computers with a ground cord of one megohm ± 10% resistance
- Static-dissipative table or floor mats with a hard-tie to ground
- Field service kits
- Static awareness labels
- Wrist straps and footwear straps providing one megohm ± 10% resistance
- Material-handling packages
- Conductive plastic bags
- Conductive plastic tubes
- Conductive tote boxes
- Opaque shielding bags
- Transparent metallized shielding bags
- Transparent shielding tubes
Tools and software requirements

The tools necessary for computer component removal and installation are:

- Torx T-15 driver
- Flat blade and cross-tip screwdrivers
- Diagnostics software

Special handling of components

The components included in this section require special handling when servicing the computer.

⚠️ WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the computer. Lifting the computer from the front bezel, or lifting it incorrectly, could cause the computer to fall, causing possible injury to you and damage to the computer. To properly and safely lift the computer, lift from the bottom of the computer.

Cables and connectors

Handle cables with care to avoid damage. Apply only the tension required to seat or unseat cables during insertion or removal from the connector. When possible, handle cables by the connector or pull-strap. In all cases, avoid bending or twisting the cables, and be sure that the cables are routed in such a way that they cannot be caught or snagged by parts being removed or replaced.

When servicing the computer, be sure that cables are placed in their proper location during the reassembly process. Improper cable placement can damage the computer.
**Hard drives**

Hard drives are fragile, precision components. Avoid subjecting them to physical shock and vibration. The following guidelines apply to all drives, including failed drives, replacement drives, and spares.

- Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective packaging until they are mounted in the computer.
- Avoid dropping hard drives from any height.
- If you are inserting or removing a hard drive, power off the computer. Do not remove a hard drive while the computer is powered on or in standby mode.
- Before handling a drive, be sure that you discharge static electricity. While handling a drive, avoid touching the connector. For more information about preventing electrostatic damage, see ESD information on page 55.

To prevent possible ESD damage when the drive is installed, connect the drive power cable before connecting the data cable. This discharges accumulated static electricity through the drive power cable to the computer chassis.

- When inserting a drive, do not use excessive force.
- Avoid exposing a hard drive to liquids, temperature extremes, or products with magnetic fields such as monitors or speakers.

**Lithium coin cell battery**

The battery included with the computer provides power to the real-time clock and has a lifetime of about three years.

For instructions on battery removal and replacement, see Battery on page 93.

⚠️ **WARNING!** This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery is handled improperly. Do not disassemble, crush, puncture, short the external contacts, dispose of in water or fire, or expose the battery to temperatures higher than 60° Centigrade (140° Fahrenheit).

💡 **NOTE:** Do not dispose of batteries, battery packs, and accumulators with general household waste.

**Customer Self-Repair**

Customer Self-Repair enables you to obtain replacement parts and install them on the computer. For more information, see http://www.hp.com/go/selfrepair/. 
Removing and installing components

Component locations

The following illustration and table identify workstation system board components.

Figure 5-1 System board component locations
<table>
<thead>
<tr>
<th>Item</th>
<th>Component</th>
<th>Item</th>
<th>Component</th>
<th>Item</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rear chassis fan</td>
<td>13</td>
<td>Battery</td>
<td>25</td>
<td>PCIe2 x1</td>
</tr>
<tr>
<td>2</td>
<td>CPU power</td>
<td>14</td>
<td>SATA ports 1</td>
<td>26</td>
<td>PCIe2 x16(4)</td>
</tr>
<tr>
<td>3</td>
<td>Solenoid hood lock</td>
<td>15</td>
<td>Clear CMOS button</td>
<td>27</td>
<td>PCIe2 x1</td>
</tr>
<tr>
<td>4</td>
<td>Chassis intrusion</td>
<td>16</td>
<td>Crisis recovery jumper</td>
<td>28</td>
<td>PCIe2 x16</td>
</tr>
<tr>
<td>5</td>
<td>CPU socket</td>
<td>17</td>
<td>Front chassis fan</td>
<td>29</td>
<td>PCIe2 x8(4)</td>
</tr>
<tr>
<td>6</td>
<td>CPU fan</td>
<td>18</td>
<td>System speaker</td>
<td>30</td>
<td>Audio</td>
</tr>
<tr>
<td>7</td>
<td>Memory sockets</td>
<td>19</td>
<td>3rd internal USB</td>
<td>31</td>
<td>USB</td>
</tr>
<tr>
<td>8</td>
<td>Main Power</td>
<td>20</td>
<td>Password jumper</td>
<td>32</td>
<td>Network/USB</td>
</tr>
<tr>
<td>9</td>
<td>Front power button/LED</td>
<td>21</td>
<td>Serial</td>
<td>33</td>
<td>DP display port 2</td>
</tr>
<tr>
<td>10</td>
<td>Front USB</td>
<td>22</td>
<td>Parallel</td>
<td>34</td>
<td>DVI —I video 2</td>
</tr>
<tr>
<td>11</td>
<td>1st internal USB/DASH</td>
<td>23</td>
<td>Front audio</td>
<td>35</td>
<td>Keyboard/mouse</td>
</tr>
<tr>
<td>12</td>
<td>2nd internal USB</td>
<td>24</td>
<td>PCI 32/33</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 Blue SATA ports, namely SATA0 and SATA1, support SATA Gen3 (6 Gb). Note that SATA5 is the only eSATA compatible port.

2 Intel integrated HD video is supported on some workstation models, depending on installed CPU. Most supported Intel Core processors support Intel HD Graphics 2000. Intel Xeon processors with model designations that end in “—5” support Intel HD Graphics P3000. In Windows 7, you can view the model of CPU installed in the workstation by selecting Start > Control Panel > System.

For related system architecture information, see System board architecture on page 1.
Predisassembly procedures

NOTE: Read the section at the beginning of this chapter on Warnings and cautions and the Safety and Regulatory Guide that came with the workstation before servicing components.

Perform the following steps before servicing the workstation:

1. Locate and clear a suitable work area.
2. Close all open software applications.
3. Remove all USB keys, diskettes, CDs, and DVDs from the workstation.
4. Shut down the operating system.
5. Power off the workstation and all peripheral devices connected to it.
6. Remove or disengage security devices that prevent you from opening the workstation.
7. Disconnect the power cord from the electrical outlet and then from the workstation.
8. Disconnect peripheral device cables from the workstation.
9. Gather the tools.
10. Service the workstation.
11. Restore power to the workstation when servicing is done.
Disassembly order

For convenience, disassembly procedures should be followed in a particular order. Use the following table to determine the sequence in which to access major workstation components.

Table 5-3  Workstation component installation

<table>
<thead>
<tr>
<th>To install/replace...</th>
<th>Remove...</th>
<th>Then remove...</th>
<th>Then remove...</th>
<th>Then remove...</th>
<th>Then remove...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery, front bezel, hard drive, memory, power supply, rear system fan, side access panel sensor, or solenoid lock</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Heatsink</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expansion card (PCI/PCle)</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Expansion card support</td>
<td>Expansion card slot cover</td>
<td></td>
</tr>
<tr>
<td>Front panel I/O assembly, optical bay filler, optical drive, power button assembly, or system speaker</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Front bezel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System board</td>
<td>Chassis lock</td>
<td>Side access panel</td>
<td>Expansion card support</td>
<td>Expansion cards or DIMMs</td>
<td>Heatsink</td>
</tr>
</tbody>
</table>

Removing the cable lock (optional)

If a cable lock is installed on the workstation, remove it before servicing the workstation.
Unlock it and remove from the cable lock slot as shown in the following figure.

**Figure 5-2** Removing the cable lock
Side access panel

Before accessing the internal components of the workstation, you must remove the side access panel. This section describes how to remove and install the side access panel.

Removing the side access panel

⚠️ **WARNING!** Power off the workstation and disconnect the power cord from the electrical outlet before you remove the workstation side access panel.

To remove the side access panel:

1. Disconnect power from the workstation (see *Predisassembly procedures on page 62*).
2. Remove locks that are present such as a cable lock.
3. Pull up on the handle (1), rotate the panel away from the chassis (2), then slide the front edge of the cover about 1.3 cm (1/2 inch) toward the rear of the system to remove it (3), as shown in the following figure.

![Figure 5-3 Removing the side access panel](image)

Installing the side access panel

To install the side access panel:

1. Align the front edge of the side panel with the slot on the front of the chassis.
2. Rotate the back of the side panel down onto the chassis, then press firmly until the latch engages.
**Side access panel sensor (optional)**

The side access panel sensor is a remote solenoid that detects when the side access panel is opened. This section describes how to remove and install the sensor.

**Removing the side access panel sensor**

To remove the side access panel sensor:

1. Disconnect power from the workstation (see *Predisassembly procedures on page 62*).
2. Remove the side access panel (see *Removing the side access panel on page 65*).
3. Disconnect the sensor cable from the in-line chassis cable as shown below (1).

   ![Figure 5-4 Removing the side access panel sensor](image)

4. Slide the sensor back in its slot, push the sensor down, and then remove it from the chassis (2).

**Installing the side access panel sensor**

To replace the side access panel sensor, reverse the previous steps.
Side access panel solenoid lock

The side access panel solenoid lock provides a method to lock the side access panel by means of a local or remote signal-controlled solenoid.

This section describes how to remove and install the side access panel solenoid lock.

Removing the side access panel solenoid lock

To remove the side access panel solenoid lock:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Disconnect the side access panel solenoid lock cable from the system board (1).
4. Remove the two screws that fasten the solenoid lock to the chassis (2) as shown in the following figure.
5. Pull the solenoid lock assembly inward and then up (3) to remove the assembly from the chassis.

Figure 5-5  Removing the side access panel solenoid lock

Installing the side access panel solenoid lock

Reverse the above steps to install the side access panel solenoid lock. This involves connecting the solenoid lock cable to the system board and fastening the solenoid lock to the chassis.
Bezel

This section describes how to remove and install the front chassis bezel.

Removing the front bezel

To remove the front bezel:

1. Remove the side access panel (see Removing the side access panel on page 65).
2. Lift the release tabs (1), and then rotate the front bezel off the chassis (2).

Figure 5-6 Removing the front bezel

Installing the front bezel

To install the front bezel, align the tabs discussed in the previous section and rotate the bezel until it snaps in place.

Front panel I/O device assembly

This section describes how to remove and install a front panel I/O device assembly.

Removing the front panel I/O device assembly

To remove the front panel I/O device assembly:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the front bezel (see Removing the front bezel on page 68).

4. Remove the fastening screws from the I/O device assembly and remove it from the chassis as shown in the following figure.
   
   **Figure 5-7** Removing the front panel I/O device assembly

5. Disconnect the front panel I/O device assembly cables from the system board as shown below.
   
   **Figure 5-8** Disconnecting the front panel I/O cables

6. Carefully guide the front panel I/O device assembly from the chassis.
Installing the front panel I/O device assembly

To install the front panel I/O device assembly:

1. Guide the front panel I/O device assembly cables through the chassis openings from which they were removed.

2. Place the front panel I/O device assembly in the chassis, and then install the fastening screws in reverse order as they were removed.

3. Connect the front panel I/O audio (1), USB (2) cables, and power switch/LED cable (3) to the system board as shown in the following diagram.

*Figure 5-9* Connecting the front panel I/O device cables

---

**NOTE:** The front panel I/O device assembly also has a 1394a cable. This cable can be connected to an optional 1394 expansion card or clipped to the bottom of the chassis with the plastic clip provided.
Optical disk drive (mini-tower configuration)

This section describes how to remove and install an optical disk drive in the workstation mini-tower configuration. For instructions on how to remove and install an optical disk drive in the workstation desktop configuration, see Optical disk drive (desktop configuration) on page 75.

Removing an optical disk drive from the optical bay (mini-tower configuration)

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the front bezel (see Removing the front bezel on page 68).
4. Disconnect the data (1) and power (2) cables from the optical disk drive as shown in the following figure.

**Figure 5-10** Disconnecting optical disk drive cables
5. Lift the green drive lock release lever (1) and gently slide the drive out of the chassis (2) as shown in the following figure.

**Figure 5-11** Removing the optical disk drive
Installing an optical disk drive in the optical bay (mini-tower configuration)

To install an optical disk drive:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the front bezel (see Removing the front bezel on page 68).
4. If necessary, remove the EMI filter panel from the drive bay you wish to use.
5. Lift the green release lever (1) and slide the optical disk drive into the bay (2) until it is stopped by the release latch, as shown in the figure below.

*Figure 5-12* Installing the optical disk drive

6. Release the latch and continue sliding the drive until the latch closes and engages the drive.

*TIP:* Adjacent drives may move slightly when you insert the drive. If necessary, slide and align other devices to get the release latch to close and engage all devices.
7. Connect the power cable (1) and data cables (2) to the drive as shown in the following figure.

**Figure 5-13** Connecting power and data cables

8. Connect the optical disk drive data cable to the appropriate SATA port on the system board as shown in the following figures.

**NOTE:** HP recommends using SATA ports 3 and 4 for optical disk drives, SATA ports 0 and 1 for primary hard disk drives, and port 5 only after all other ports have been used. (Refer to the service label on the side access panel of your workstation to determine the location of the SATA ports. These ports are also shown in Figure 5–1.)

**NOTE:** Blue SATA ports (SATA0 and SATA1) support SATA Gen3 (6 Gbit). **Only SATA5** is eSATA compatible.

**Figure 5-14** Connecting power and data cables
Optical disk drive (desktop configuration)

This section describes how to remove and install an optical disk drive in the workstation desktop configuration. For instructions on removing and installing optical disk drives in the workstation mini-tower configuration, see Optical disk drive (mini-tower configuration) on page 71.

Removing an optical drive (desktop configuration)

1. Disconnect power from the system (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the front bezel (see Removing the front bezel on page 68).
4. Disconnect the data (1) and power (2) cables from the drive, as shown in the following figure. (The connector colors might be different than shown in the following figure.)

Figure 5-15  Disconnecting the optical drive cables
5. Press down on the green drive-lock release lever (1) and gently slide the drive out of the chassis (2).

**Figure 5-16** Removing the optical drive from chassis

6. If you plan to install another drive, remove the drive completely from the chassis (1) and remove the four guide screws from the drive (2) so that you can re-use the screws to install the new drive. (See Installing an optical drive (desktop configuration) on page 77 below.)

**Figure 5-17** Removing the optical drive screws
Installing an optical drive (desktop configuration)

1. Disconnect power from the system (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the front bezel (see Removing the front bezel on page 68).
4. Remove the bezel blank from the drive bay you wish to use.
5. Remove the EMI filter panel from the drive bay you wish to use.
6. Install the four black metric M3 guide screws into the drive (1).

   ![Figure 5-18 Installing the optical drive]

7. Align the screws with the grooves in the drive bay and gently slide the drive into the casing until it snaps into place (2).

   **CAUTION:** Pull on the drive to make sure it has snapped into place. If the drive is loose, it can be damaged if you move the workstation.
8. Connect the data (1) and power (2) cables to the drive and system board.

**Figure 5-19** Connecting data and power cables
Speaker

This section describes how to remove and install the speaker.

Removing the speaker

To remove the speaker:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the front bezel (see Removing the front bezel on page 68).
4. Disconnect the speaker cable from the system board (1) as shown in the figure below.
5. Remove the two screws as shown (2).
6. Slide the speaker away from the chassis and remove it from the chassis (3).

Figure 5-20 Removing the workstation speaker

Installing the speaker

To install the speaker, reverse the previous steps.
Power supply

This section describes how to remove and install a power supply.

Removing the power supply

To remove the power supply:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Disconnect all of the power supply cables from the system board and all peripheral devices (hard drives, optical drives, and others as needed).
4. Remove the four screws from the rear of the chassis (1).
5. Slide the power supply inward then up to remove it from the chassis (2).

Figure 5-21 Removing power supply

Installing the power supply

To install the power supply, reverse the previous steps.
Power connections

For help with identifying power cables, see the following figure and table. Ensure that all cables are routed or tied so they cannot interfere with the processor heatsink fans.

**Figure 5-22** Power connections

![Power connections diagram]

**Table 5-4 Power connector description**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P1</td>
<td>Main power</td>
<td>P12</td>
<td>Optical disk drive</td>
</tr>
<tr>
<td>P3</td>
<td>CPU power</td>
<td>P13</td>
<td>Optical disk drive</td>
</tr>
<tr>
<td>P8, P9, P10</td>
<td>Hard disk drives</td>
<td>P14</td>
<td>4–pin molex connector for legacy devices</td>
</tr>
<tr>
<td>P6</td>
<td>Expansion graphics card</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Rear system fan assembly

This section describes how to remove and install the rear system fan assembly.

Removing the rear system fan assembly

To remove the rear system fan assembly:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Disconnect the rear system fan assembly cable (1) from the system board as shown in the following figure.

Figure 5-23  Disconnecting fan wires

4. Remove the four screws from the rear of the chassis (2), and then pull the fan assembly inward and then up (3) out of the chassis.

Installing the rear system fan assembly

To install the rear system fan assembly, reverse these steps.
Memory

This section presents memory module (DIMM) configuration information and removal/installation procedures.

Supported DIMM configurations

The workstation supports these DIMM configurations:

- Four DIMM slots
- Memory configuration from 1 GB to 32 GB
- No support for mirroring
- No support for DIMM sparing
- Error checking and correcting (ECC) and non-ECC DIMMs are supported.

DIMM installation guidelines

- Install only HP-approved DDR3 DIMMs.

⚠️ **CAUTION:** HP ships only DIMMs that are electrically and thermally compatible with this workstation. Because third-party DIMMs might not be electrically or thermally compatible, they are not supported by HP.

- For ECC DIMMs, use only industry-standard ECC unbuffered DIMMs. See [hp.com/go/quickspecs](http://www.hp.com/go/quickspecs) to find which DIMMs are compatible with the workstation.

- Do not intermix non-ECC memory DIMMs with ECC memory DIMMs.

DIMM installation order

Review the following to determine the correct installation order for DIMMs.

![DIMM load order](image)
**BIOS errors and warnings**

The BIOS generates warnings/errors on invalid memory configurations:

- If the BIOS can find a valid memory configuration by disabling plugged-in memory, it does so and reports a warning during POST. The workstation can still be started. The warning will indicate the location of the failed DIMM on the system board or memory riser.

- If there is no way for the BIOS to obtain a valid memory configuration by disabling plugged-in memory, the BIOS halts with a diagnostics code for memory error (five beeps and blinks).

**Removing a DIMM**

To remove a DIMM:

1. Disconnect power from the workstation (see *Predisassembly procedures on page 62*).

   **CAUTION:** To prevent possible electrical damage to the DIMMs, power off the workstation and unplug the power cord from the AC power outlet before removing or installing memory. The workstation will not recognize the memory changes if the DIMM is damaged.

2. Remove the side access panel (see *Removing the side access panel on page 65*).

3. Push gently outward on the DIMM socket levers (1) as shown in the following figure.

   **Figure 5-25** Removing a DIMM

4. Lift the DIMM straight up (2) and out of the socket, then store the DIMM in an antistatic bag.
Installing a DIMM

To install the DIMM:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).

⚠️ **CAUTION:** To prevent possible electrical damage to the DIMMs, power off the workstation and unplug the power cord from the AC power outlet before removing or installing memory. The workstation will not recognize the memory changes if the DIMM is damaged.

2. Remove the side access panel (see Removing the side access panel on page 65).

3. Push gently outward on the DIMM socket levers as shown in the following figure.

*Figure 5-26* Opening DIMM socket levers
4. Align the DIMM connector key with the DIMM socket key, and then seat the DIMM firmly in the socket (1) as shown in the following figure.

⚠️ **CAUTION:** DIMMs and their sockets are keyed for proper installation. To prevent socket or DIMM damage, align these guides properly when installing DIMMs.

*Figure 5-27  Seating the DIMM*

5. Secure the socket levers (2).
Expansion card slot identification

This section identifies and describes workstation expansion card slots, and presents card configuration information.

Slot identification and description

The following figure identifies workstation expansion card slots.

**Figure 5-28** Identifying expansion card slots

The following table describes the workstation PCIe card slots.

**Table 5-5** PCI slots

<table>
<thead>
<tr>
<th>Slot</th>
<th>Type</th>
<th>Slot power (per slot)</th>
<th>Slot power (maximum)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PCIe2 - x8(4)</td>
<td>25W</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>PCIe2 - x16</td>
<td>75W</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>PCIe2 - x1</td>
<td>10W</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>PCIe2 - x16(4)</td>
<td>25W</td>
<td>150W max for total power usage of all card slots</td>
</tr>
<tr>
<td>5</td>
<td>PCIe2 - x1</td>
<td>10W</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>PCI 32b/33MHz</td>
<td>25W</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>PCI 32b/33MHz</td>
<td>25W</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** The x1, x4, and x16 designators describe the mechanical length of the slot. The number in parentheses lists the number of electrical PCIe lanes routed to the expansion slot. For example, x16(4) means that the expansion slot is mechanically a x16 length connector, with four PCIe lanes connected.
Graphics cards greater than 75 watts require the use of an auxiliary power cable adapter. See Power connections on page 81 for more information.

Slots two and four use latches to secure the card in the slot.

### Power limitations for graphics cards

**CAUTION:** To prevent damage, the overall power consumption of the workstation (including I/O cards, CPU, and memory) must not exceed the maximum rating of the workstation power supply.

When planning, purchasing, and installing graphics cards in your workstation, observe the following power limitations:

- Maximum allowable graphics card power for Slot 2 is 150W. Note that 75W is available from the system board and an additional 75W directly from the PSU (using the 6-pin power connector from the power supply). If a second graphics card is installed in Slot 4, the combined power consumption of both cards must not exceed 150W.

- If you use a graphics card with greater than 75 watts of power, leave the adjacent slot empty for thermal cooling considerations.

- Slot 4 supplies 25W of power. Do not exceed this power limitation when installing a second graphics card in this slot.
Choosing an expansion card slot

Whenever possible, use the following tips to help you select the proper slot for an expansion card:

- Insert the primary graphics card in a PCIe x16 slot intended for graphics.
- Insert a second graphics card in a second PCIe x16 slot intended for a secondary graphics card.
- Install full-length cards in slots that support full-length cards.
- For optimal cooling and acoustics, place a lower-profile card next to the CPU heatsink.
- Whenever possible, avoid placing cards so they block the graphics card heatsink and fan. This is especially important for graphics cards that require attaching the auxiliary power cable.
- Install a card in a slot that most closely matches its interface technology:
  - Install a PCIe Gen2 x16 or a PCIe Gen2 x8 card in the PCIe Gen2 x16 slot.
  - Install a PCIe Gen1 x16 or a PCIe Gen1 x8 card in the PCIe Gen1 x16 slot.
  - Install a PCIe Gen1 x4 card in the PCIe Gen1 x4 slot.
  - Install a PCIe Gen1 x1 card in the PCIe Gen1 x1 slot.
  - Install a PCI card in one of the PCI slots.
  - Whenever possible, install a PCIe x1 card in an x1 slot.
- Leave as much space as possible between cards.
- For best operational efficiency, select a slot that:
  - Electrically matches the number of PCIe card lanes (e.g., x4 in a x4 slot).
  - Has more lanes electrically.
  - Has fewer lanes, but is closer to your needs. For example, place an x16 card in an x4 slot, and an x4 card in an x1 slot.
- An x1 connector supports an x1 card only. Although an x1 card can be inserted into any slot, this may waste the potential for future card placement.
- Install cards that require internal cable connections so that the cables are organized and have the least amount of strain on them. Some cables may be routed under, rather than over the other expansion cards.
- To prevent electromagnetic interference, avoid installing a card with external cable connections next to a graphics card.
Expansion card

PCIe I/O slots may supply less bus bandwidth than what is physically defined for the slot.

Expansion card slot description

NOTE: The x1, x4, and x16 designators describe the mechanical length of the slot. The number in parentheses lists the number of electrical PCIe lanes routed to the expansion slot. For example, x16(4) means that the expansion slot is mechanically a x16 length connector, with four PCIe lanes connected.

Use the following table to determine PCIe card compatibility.

Table 5-6  HP x210 CMT Workstation PCIe compatibility matrix

<table>
<thead>
<tr>
<th>Slot</th>
<th>Mechanical compatibility</th>
<th>Electrical lanes available</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>x8 connector</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>x16 connector</td>
<td>16</td>
</tr>
<tr>
<td>3</td>
<td>x1 connector</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>x16 connector</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>x1 connector</td>
<td>1</td>
</tr>
</tbody>
</table>

Removing an expansion card

To remove an expansion card:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the expansion card retainer (if installed): grasp the top of the clamp (1), squeeze the release handles until the bottom of the clamp releases from the clamp rail (2) (it should click when it releases), and swing the clamp out from the back panel (3).

**Figure 5-29** Removing expansion card retainer

4. Remove all cables connected to the expansion card.

5. Push down on the expansion card retention clamp levers on the inside of the chassis to open the retention clamp (1) as shown below.

**Figure 5-30** Removing the expansion card

6. If the card is in one of the slots with a latch, release the latch (2). (Note that there are two different styles of latch.)
7. Carefully lift the card from the chassis (3).

8. If you are not replacing the card in this slot, install an expansion slot cover and close the expansion card retention clamp.

   If the expansion card retention clamp does not close, ensure that all cards are properly seated, and then try again.

### Installing an expansion card

Visit [http://www.hp.com/go/quickspecs](http://www.hp.com/go/quickspecs) to learn which graphics cards are supported in the workstation, how much memory each graphics card includes, and graphics card power requirements.

To install an expansion card:

1. Disconnect power from the workstation (see [Predisassembly procedures on page 62](#)).
2. Remove the side access panel (see [Removing the side access panel on page 65](#)).
3. Push the expansion card retention clamp levers down on the outside of the chassis to release the retention clamp (1) as shown in the figure below.

   ![Removing the slot cover](image)

   **Figure 5-31** Removing the slot cover

4. Remove the expansion card slot cover by pulling it up, out of the chassis (2).

   **TIP:** Grasp the slot cover between two fingers—one from the inside of the chassis, and one from the outside.

5. Angle the card into the expansion card guide.
6. Align the PCIe card keyway with the slot key, and then firmly seat the card in the slot as shown (3).

7. Close the expansion card retention clamp by rotating it downward (4).
   - If the PCI retention clamp does not close, ensure that all cards are properly seated, and then try again.
   - If required by the card, connect the auxiliary power cable to the card (not illustrated).

Battery

This section describes how to remove and install the battery.

The battery that comes with the workstation provides power to the real-time clock and has a minimum lifetime of about three years.

⚠️ **WARNING!** This workstation includes a lithium battery. There is a risk of fire and chemical burn if the battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose of in water or fire, or expose battery to temperatures higher than 60°C (140°F).

⚠️ **CAUTION:** Before removing the battery, back up the CMOS settings in case they are lost when the battery is removed. To back up the CMOS settings, select the **Save to Diskette** option in the Computer Setup (F10) Utility.

⚠️ **NOTE:** Do not dispose of batteries, battery packs, or accumulators with general household waste.

Removing the battery

To remove the battery:

1. Disconnect power from the workstation (see **Predisassembly procedures on page 62**).
2. Remove the side access panel (see **Removing the side access panel on page 65**).
3. Locate the battery on the system board.
4. Push horizontally on the battery (1) with a small screwdriver and it will pop out of its holder (2) as shown in the following figure.

**Figure 5-32** Removing the battery

---

**Installing the battery**

To install the battery:

1. Confirm the polarity (positive or negative) of the battery to position it correctly in the battery holder.
2. Place the battery edge under the plastic housing tab and press gently until it snaps into place.

---

**Hard disk drive**

This section provides information to successfully remove and install a hard disk drive.

**Removing the hard disk drive**

To remove a hard disk drive:

1. Disconnect power from the workstation (see *Predisassembly procedures on page 62*).
2. Remove the side access panel (see *Removing the side access panel on page 65*).
3. Disconnect the power and data cables from the drive (1).
4. Squeeze together at the HDD sled’s green touch points (2), then slide the hard disk drive (3) out from the chassis as shown. Support the HDD from below while you slide it out.

**Figure 5-33** Removing the drive from the chassis

5. Replace the side access cover when finished.

### Installing hard disk drives

**Installation guidelines**

The workstation typically ships with one HDD, but you can add additional drives to expand space for programs, data storage, or backup. In general, you should plan to add HDDs starting with the first available bay farthest from the optical drive bays.

After installation, you can use the Computer Setup (F10) Utility to:

- Assign drive letters of your choice to the new HDDs. (The workstation assigns drive letters automatically if you do not choose them.)
- Change the boot sequence so that the workstation boots from one of the additional drives. (Disk C:\ is the typical boot disk.)

See [The Computer Setup (F10) Utility on page 25](#) for more information.
Installation

To install an HDD:

1. Select a drive bay in which to install the hard disk drive and remove its mounting sled.

   **Figure 5-34** HDD installation order

   **Figure 5-35** Removing the mounting sled
2. Install the HDD into the mounting sled as shown in the following figure.

**Figure 5-36** Installing the HDD in the mounting sled

3. Push the sled containing the HDD into the selected bay until it snaps into place (1) as shown in the following figure.

**Figure 5-37** Installing the HDD drive

4. Attach a power cable (2) and a data cable (3) to the hard disk drive.

**CAUTION:** To avoid crushing or pinching the data cable when you replace the access panel, use the HP-supplied data cable with right-angle connectors.

**NOTE:** Connect data cables to lower-numbered drive connectors first on the system board. To identify hard disk drive ports, refer to the workstation service label on the side access panel.
5. Replace all components that were removed in preparation for component installation.

CPU heatsink

This section describes how to remove and install a CPU heatsink.

Removing the CPU heatsink

To remove a heatsink:

1. Power down the workstation (see Predisassembly procedures on page 62).
2. Disconnect power from the workstation (see Predisassembly procedures on page 62).
3. Remove the side access panel (see Removing the side access panel on page 65).
4. Slowly and evenly loosen one pair of diagonally opposite screws (1) from the CPU until the screw shanks disengage from the system board, and then loosen the remaining pair (2) as shown below.

⚠️ CAUTION: Do not fully loosen one screw, and then move on to the next. Instead, loosen all screws a little at a time, ensuring that the CPU remains level.

Figure 5-38  Loosening heatsink screws in sequence
5. Disconnect the CPU heatsink fan cable from the system board (1) as shown in the following figure.

   **Figure 5-39** Disconnecting the heatsink fan cable

6. Before lifting the heatsink, gently twist the heatsink to break the thermal compound between the CPU and the heatsink.

7. Lift the CPU heatsink out of the chassis (2).

8. Use alcohol and a soft cloth to clean the thermal interface residue from the CPU and the heatsink. Allow the alcohol on the CPU and CPU heatsink to dry completely.

**Installing the CPU heatsink**

To install a heatsink:

1. Disconnect power from the workstation (see **Predisassembly procedures on page 62**).

2. Remove the side access panel (see **Removing the side access panel on page 65**).

3. Remove the CPU heatsink (see **Removing the CPU heatsink on page 98**).

4. Perform one of the following tasks:
   - If you are reusing the original heatsink, apply thermal compound to the center of the CPU top surface.
   - If you are using a new CPU heatsink, do not apply thermal compound to the CPU because the new heatsink already has thermal compound applied to the heatsink surface. Instead, remove the thermal compound protective liner from the bottom of the new heatsink.

5. Align the heat sink's four mounting screws with the mounting holes in the chassis.

6. Carefully place the heatsink on the CPU.

7. Tighten each heatsink screw a little at a time to ensure that the CPU stays level. Do **not** fully tighten one screw and then move on to the next.
8. Tighten each set of diagonally opposed screws a little at a time to 6 in-lbs of torque.

⚠️ CAUTION: Do not overtighten the heatsink screws. Overtightening can strip the threads in the chassis.

9. Connect the CPU heatsink fan connector to the system board.

**Figure 5-40** Connecting the heatsink fan cable
CPU

This section describes how to remove and install a CPU.

Removing a CPU

To remove a CPU:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the CPU heatsink (see Removing the CPU heatsink on page 98).
4. Raise the CPU socket lever (1) and open the cover (2) as shown in the following figure.

Figure 5-41 Removing a CPU

⚠️ CAUTION: Do not touch the CPU socket contacts or the gold pads underneath the CPU. Use extreme care and handle the CPU only by the edges.

5. Pull the CPU straight out of the socket (3). Store the CPU in a static free container in a safe place where it cannot be damaged.
Installing a CPU

NOTE: HP recommends that you do not swap processors (CPUs) from one system board to another.

To install a CPU:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the CPU heatsink (see Removing the CPU heatsink on page 98).
4. Remove the CPU (see Removing a CPU on page 101).
5. Using extreme care, fully raise the CPU socket lever and cover.

CAUTION: The CPU socket contacts are delicate. To avoid bending the contacts, use extreme care when installing the CPU in the socket.

6. Align the notches in the CPU base with the tabs on the socket as shown in the figure below.

Seat the CPU into the socket. Ensure that the underside of the CPU is level with the top of the CPU socket.

Figure 5-42 Seating the CPU

7. The CPU cover plate has two tangs opposite its hinge. The tangs slip beneath the mounting screw on the systemboard as the CPU cover plate hinges downward over the CPU. Close the CPU cover plate by closing the socket lever, latching the lever securely into the locking notch on the cover plate.

8. Replace the CPU heatsink (see Installing the CPU heatsink on page 99), and then close the side access cover.
System board

This section describes replacing the system board.

Removing the system board

To remove the system board:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove expansion boards and graphics cards (see Removing an expansion card on page 90).
4. Remove the CPU heatsink (see Removing the CPU heatsink on page 98). Note that the CPU heatsink screws also secure the system board to the chassis.
5. Disconnect all cabling from the system board.
   TIP: Make a note of the cable connections before disconnecting them from the system board. For more information, refer to Power connections on page 81.
6. Remove the ten mounting screws (1) as shown in the following figure.

   Figure 5-43 Removing the system board

7. Lift the system board slightly, and pull the board away from the rear of the chassis.
8. Lift the system board upward out of the chassis (2).
Installing the system board

To install the system board:

1. Carefully insert the system board into the chassis so that mounting holes align with the screw holes in the chassis (2). You may have to slide the system board toward the rear of the chassis.

   Figure 5-44 Inserting and aligning the system board

2. Replace the mounting screws (2).

3. Reinstall all removed components and cables. (See Power connections on page 81 to identify power cables.)
Converting to desktop configuration

This workstation can be operated in the mini-tower or the desktop configuration. Follow these steps to convert to desktop configuration operation:

1. Disconnect power from the workstation (see Predisassembly procedures on page 62).
2. Remove the side access panel (see Removing the side access panel on page 65).
3. Remove the front bezel from the workstation (see Removing the front bezel on page 68).
4. Press gently on the edges of the optical drive bay filler panel (1) to remove it from the front bezel as shown in the following figure.

Figure 5-45 Removing the ODD bay filler panel

5. Rotate the filler panel (2) 90 degrees to a horizontal position.
6. Align the slots in the filler panel frame with the tabs in the front bezel. Press the optical drive filler panel back into the front bezel until it snaps into place as shown in the following figure.

**Figure 5-46** Installing the ODD bay filler panel
7. On the back of the front bezel, squeeze the HP logo mounting tabs (1) and press the logo outward (2) as shown in the following figure.

**Figure 5-47** Rotating the HP logo

Rotate the HP logo 90 degrees counterclockwise, and then release the logo and press it back into place in the front bezel.

8. Remove the EMI filler panels and remove the optical disk drive from the chassis (see Removing an optical disk drive from the optical bay (mini-tower configuration) on page 71.
9. Rotate the EMI filler panels and the optical drive 90 degrees as shown in the figure below, and then reinstall them (see Installing an optical drive (desktop configuration) on page 77).

**Figure 5-48** Reinstalling the optical drive

10. Replace the front bezel (see Installing the front bezel on page 68) and the side access panel (see Installing the side access panel on page 65) when finished.

**Product recycling**

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable batteries.

For information about recycling HP components or products, see [http://www.hp.com/go/recycle](http://www.hp.com/go/recycle).
6 Diagnostics and troubleshooting

This chapter describes the tools available for diagnosing and troubleshooting system issues, and includes these topics:

<table>
<thead>
<tr>
<th>Topics</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calling technical support</td>
<td>110</td>
</tr>
<tr>
<td>Locating ID labels</td>
<td>110</td>
</tr>
<tr>
<td>Locating warranty information</td>
<td>111</td>
</tr>
<tr>
<td>Diagnosis guidelines</td>
<td>112</td>
</tr>
<tr>
<td>Troubleshooting checklist</td>
<td>114</td>
</tr>
<tr>
<td>HP troubleshooting resources and tools</td>
<td>115</td>
</tr>
<tr>
<td>Troubleshooting scenarios and solutions</td>
<td>117</td>
</tr>
<tr>
<td>Self-troubleshooting with HP Vision Diagnostics</td>
<td>126</td>
</tr>
<tr>
<td>Diagnostic codes and errors</td>
<td>135</td>
</tr>
</tbody>
</table>
Calling technical support

At times you might encounter an issue that requires technical support. When you call technical support:

● Have the computer readily accessible.
● Write down the computer serial numbers, product numbers, model names, and model numbers and have them in front of you.
● Note any applicable error messages.
● Note any add-on options.
● Note the operating system.
● Note any third-party hardware or software.
● Note the details of any blinking LEDs on the front of the computer.
● Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the Product Number (example: PS988AV) of the computer. If the computer has a Product Number, it is generally located next to the 10- or 12-digit Serial Number of the computer.

NOTE: On most models, the serial number and product number labels can be found on the top panel or side of the computer and at the rear of the computer.

For a listing of all worldwide technical support phone numbers, visit http://www.hp.com/support, select your region, and click Contact HP in the upper-left corner.

Locating ID labels

To assist in troubleshooting, product, serial, and authentication numbers are available on each computer.
Each HP Workstation has two unique serial number labels (1) and a Certificate of Authentication (COA) label (2) as shown in the figure below.

**Figure 6-1** Workstation label locations

In general, the serial number labels can be found on the top panel or on the side of the computer and at the rear of the computer (your computer may look different). Keep this number available when contacting customer service for assistance.

A product number is generally located next to the serial number.

The COA is used for Windows-preinstalled systems only, and is generally located on the top panel or side of the computer near the serial number label. On some computers it is located on the bottom of the computer.

**Locating warranty information**

To locate base warranty information, see [http://www.hp.com/support/warranty-lookuptool](http://www.hp.com/support/warranty-lookuptool).

To locate an existing Care Pack, see [http://www.hp.com/go/lookup tool](http://www.hp.com/go/lookup tool).

To extend a standard product warranty, visit [http://www.hp.com/hps/carepack](http://www.hp.com/hps/carepack). HP Care Pack Services offer upgraded service levels to extend and expand a standard product warranty.
Diagnosis guidelines

If you encounter a problem with the computer, monitor, or software, the following sections provide a list of general suggestions that help you isolate and focus on the problem before taking further action.

Diagnosis at startup

- Verify that the computer and monitor are plugged into a working electrical outlet.
- Remove all diskettes, CDs, or USB drive keys from your system before turning it on.
- Verify that the computer is turned on and the green power light is on.
- If you have installed an operating system other than the factory-installed operating system, check to be sure that it is supported on your system by visiting [http://www.hp.com/go/quickspecs](http://www.hp.com/go/quickspecs).
- Verify that the monitor is turned on and the green monitor light is on. Note that not all monitors are equipped with LED lights to indicate their functionality.
- Turn up the brightness and contrast controls of the monitor if the monitor is dim.
- If the computer has multiple video sources and only a single monitor, the monitor must be connected to the primary display adapter. During startup, the other monitor connectors are disabled; if the monitor is connected to one of these ports, it will not function after Power-on Self Test (POST). You can select the default source in Computer Setup (F10).
Diagnosis during operation

- Look for blinking LEDs on the front of the computer. The blinking lights are error codes that will help you diagnose the problem. Refer to the [Diagnostic LED and audible (beep) codes on page 135](#) section of this document for information on interpreting diagnostic lights and audible codes.

- Press and hold any key. If the system beeps, then your keyboard is operating correctly.

- Check all cables for loose or incorrect connections.

- Wake the computer by pressing any key on the keyboard or the power button. If the system remains in suspend mode, shut down the system by pressing and holding the power button for at least four seconds, then press the power button again to restart the system. If the system does not shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart, press the power button to start the computer.

- Reconfigure the computer after installing a non–plug and play expansion board or other option.

- Be sure that all required device drivers have been installed. For example, if you have connected a printer, you must install a printer driver.

- If you are working on a network, plug another computer with a different cable into the network connection. There might be a problem with the network plug or cable.

- If you recently added new hardware, remove the hardware and verify if the computer functions properly.

- If you recently installed new software, uninstall the software and verify if the computer functions properly.

- If the screen is blank, plug the monitor into a different video port on the computer if one is available. Alternatively, replace the monitor with a monitor that you know is working properly.

- Upgrade the BIOS. A new release of the BIOS might have been released that supports new features or fixes your problem.
Troubleshooting checklist

Before running diagnostic utilities, use the following checklist to find possible solutions for computer or software problems.

- Is the computer and monitor connected to a working electrical outlet?
- Is the computer powered on?
- Is the blue power light illuminated?
- Is the monitor on?
- Is the monitor power LED illuminated?
- If the monitor is dim, adjust the monitor brightness and contrast controls.
- Press and hold any key. If the system beeps, the keyboard is operating correctly.
- Check cables for loose or improper connections.
- After installing a non-plug and play (PnP) expansion board or other option (such as a diskette drive), reconfigure the computer.
- Are all necessary device drivers installed?
- Have all printer drivers been installed for each application?
- Have you removed diskettes, optical disks, and USB drive keys from the drives before powering on the computer?
- Are you running the latest version of BIOS, drivers, and software?
HP troubleshooting resources and tools

This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for troubleshooting.

HP Support Assistant

The HP Support Assistant is a customized HP user interface that enhances the Windows 7 Help and Support Center functions. This customized utility allows you to access specific information about an HP Workstation such as configuration information by clicking Start > All Programs > HP. The interface also provides customized help and support links to the HP Web site related to the HP Workstation.

NOTE: The customized HP Support Assistant is not available on Linux.

HP Performance Advisor

The HP Performance Advisor is an HP tool that offers a quick and easy way to configure and update HP workstations. It improves workstation stability and performance while helping you work faster and more productively. To use this tool, select Start > All Programs > HP > HP Performance Advisor.

E-support

Online access and support resources include Web-based troubleshooting tools, technical knowledge databases, driver and patch downloads, online communities, and product change notification services.

The following Web sites are also available to you:

- http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.
- http://www.hp.com/support—Provides a listing of the worldwide technical support phone numbers. Access the telephone numbers by visiting the Web site, then select your region, and click Contact HP in the upper-left corner.

Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC). The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem with the workstation, complete the following:

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.
3. Under Select your product (center window), select Workstations (under personal computing).

4. Under Select your product, continue with selections as appropriate to the workstation series and model, and to the problem you are troubleshooting.

**Instant Support and Active Chat**

HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of desktop computing, tape storage, and printing problems.

Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit a support ticket, Active Chat collects information about the computer and passes it to an online support specialist. The collection of information might take up to 30 seconds depending on the computer configuration. When you submit a support ticket, you receive a confirmation message containing your case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, visit http://www.hp.com/hps/hardware/hw_professional.html.

**NOTE:** This feature is not available on Linux.

**Helpful hints**

If you encounter a problem with the workstation, monitor, or software, the following provides a list of general suggestions that help you isolate and focus on the problem before taking further action.

**At startup**

- Verify that the workstation and monitor are plugged into a working electrical outlet.
- Remove all diskettes, optical disks, and USB drive keys from the drives before powering on the workstation.
- Verify that the workstation is turned on and the blue power light is on.
- If you have installed an operating system other than the factory-installed operating system, check to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.
- Verify that the monitor is turned on and the power LED is illuminated.
- Turn up the brightness and contrast controls of the monitor if the monitor is dim.
- If the workstation has multiple video sources and only a single monitor, the monitor must be connected to the source selected as the primary video adapter. During startup, the other monitor connectors are disabled; if the monitor is connected to one of these ports, it will not function after Power-on Self Test (POST). You can select the default video source in Computer Setup (F10).

**During operation**

- Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will help you diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section of this document for information on interpreting diagnostic lights and audible codes.
- Press and hold any key. If the system beeps, then your keyboard is operating correctly.
Check all cables for loose or incorrect connections.

Wake the workstation by pressing any key on the keyboard or the power button. If the system remains in suspend mode, shut down the system by pressing and holding the power button for at least four seconds, then press the power button again to restart the system. If the system does not shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart, press the power button to start the workstation.

Reconfigure the workstation after installing a non–plug and play expansion board or other option. Refer to the Troubleshooting scenarios and solutions on page 117 section of this document for instructions.

Be sure that all required device drivers have been installed. For example, if you have connected a printer, you must install a printer driver.

If you are working on a network, plug another workstation with a different cable into the network connection. There might be a problem with the network plug or cable.

If you recently added new hardware, remove the hardware and verify if the workstation functions properly.

If you recently installed new software, uninstall the software and verify if the workstation functions properly.

If the screen is blank, plug the monitor into a different video port on the workstation if one is available. Alternatively, replace the monitor with a monitor that you know is working properly.

Upgrade the BIOS. A new release of the BIOS might have been released that supports new features or fixes your problem.

**Customizing the monitor display**

You can manually select or change the monitor model, refresh rates, screen resolution, color settings, font sizes, and power management settings. To do so, right-click the desktop, then click **Screen Resolution** to change display settings. For more information, see the online documentation provided with the graphics controller utility or the documentation that came with your monitor.

**Troubleshooting scenarios and solutions**

This section presents an extensive overview of various troubleshooting scenarios and possible solutions for a Windows-based computer.

**NOTE:** For Linux troubleshooting information, refer to the HP Workstations for Linux User Manual at http://www.hp.com/support/linux_user_manual.
### Table 6-1 Minor problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
</table>
| Workstation appears frozen and does not shut down when the power button is pressed. | Software control of the power switch is not functional. | 1. Press and hold the power button for at least four seconds until the computer shuts down.  
2. Disconnect the electrical plug from the outlet.  
3. Restart the computer. |
| Workstation seems to be frozen.              | Program in use has stopped responding to commands. | 1. If possible, use the Windows Task Manager to isolate and terminate the offending process.  
2. Attempt the normal Windows shutdown procedure.  
3. Restart the computer using the power button. |
| Workstation date and time display is incorrect. | Real-time clock (RTC) battery might need replacement. | 1. Reset the date and time in the Control Panel.  
2. Replace the RTC battery. |
| Workstation appears to pause periodically.   | Network driver is loaded and no network connection is established. | Establish a network connection, or use the Computer Setup (F10) Utility or the Microsoft Windows Device Manager to disable the network controller. |
| Cursor does not move using the arrow keys on the keypad. | The Num Lock key might be on. | Press Num Lock. The Num Lock key can be disabled or enabled in the Computer Setup (F10) Utility. |
| Poor performance is experienced.             | Processor is hot.                               | 1. Verify that airflow to the computer is not blocked.  
2. Verify that chassis fans are connected and working properly. Some fans operate only when needed.  
3. Verify that the processor heatsink is installed properly. |
<p>| Hard drive is full.                          | Transfer data from the hard drive to create more space on the hard drive. |</p>
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workstation powered off automatically and the Power LED flashes red 2 times (once every second), followed by a 2-second pause, and then two simultaneous beeps sounded.</td>
<td>Processor thermal protection is activated. A fan might be blocked or not turning. OR The processor heatsink is not properly attached to the processor.</td>
<td>1. Verify that the computer air vents are not blocked. 2. Open the access panel and press the computer power button. 3. Verify that the system fan is running. 4. Verify that the processor heatsink fan spins. If the fan is not spinning, verify that the heatsink fan cable is plugged into the system board connector and that the heatsink is properly seated. 5. Replace the processor heatsink.</td>
</tr>
<tr>
<td>System does not power on, and the LEDs on the front of the computer are not flashing.</td>
<td>System cannot power on.</td>
<td>Press and hold the power button for less than four seconds. If the hard drive LED turns green, then perform the following steps. 1. To find a faulty device, remove all devices one at a time:   a. Disconnect AC power to the computer.   b. Remove a device.   c. Reconnect AC power and power on the computer. 2. Repeat this process until the faulty device is identified. Remove the graphics card last. Replace the faulty device. 3. If no faulty device is found, replace the system board. OR 1. Press and hold the power button for less than four seconds. If the hard drive LED does not illuminate, then perform the following tasks:   a. Verify that the computer is plugged into a working AC outlet.   b. Verify that the power button harness is connected to the inline front panel I/O device assembly connector. 2. Verify that the power supply cables are connected to the system board.</td>
</tr>
</tbody>
</table>
## Solving diskette problems

### Table 6-2 Diskette problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diskette drive light stays on.</td>
<td>Diskette is damaged.</td>
<td>1. Right-click <strong>Start</strong>, select <strong>Explore</strong>, and then select a drive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select <strong>File&gt;Properties&gt;Tools</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Under Error-checking, select <strong>Check Now</strong>.</td>
</tr>
<tr>
<td></td>
<td>Diskette is incorrectly inserted.</td>
<td>Remove and reinsert diskette.</td>
</tr>
<tr>
<td></td>
<td>Files on the diskette are damaged.</td>
<td>Verify the program diskettes.</td>
</tr>
<tr>
<td></td>
<td>Drive cable is not properly connected.</td>
<td>Reconnect the power cable and verify that all four pins are connected.</td>
</tr>
<tr>
<td>Drive not found.</td>
<td>Cable is loose.</td>
<td>Reseat the diskette drive data and power cables.</td>
</tr>
<tr>
<td></td>
<td>Removable drive is not seated properly.</td>
<td>Reseat the drive.</td>
</tr>
<tr>
<td>Diskette drive cannot write to a diskette.</td>
<td>Diskette is not formatted.</td>
<td>Format the diskette.</td>
</tr>
<tr>
<td></td>
<td>Diskette is write-protected.</td>
<td>Use another diskette or remove the write protection.</td>
</tr>
<tr>
<td></td>
<td>Writing to the wrong drive.</td>
<td>Verify the drive letter in the path statement.</td>
</tr>
<tr>
<td></td>
<td>There is not enough space on the diskette.</td>
<td>Use another diskette.</td>
</tr>
<tr>
<td></td>
<td>Diskette write-control is enabled.</td>
<td>Use the Computer Setup (F10) Utility to verify the storage security feature disabled settings.</td>
</tr>
<tr>
<td></td>
<td>Diskette is damaged.</td>
<td>Replace the damaged disk.</td>
</tr>
<tr>
<td>Cannot format diskette.</td>
<td>Invalid media reported.</td>
<td>When formatting a disk in MS-DOS, you might need to specify diskette capacity.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, to format a 1.44-MB diskette, enter the following command at the MS-DOS prompt: <strong>FORMAT A: /F:1440</strong></td>
</tr>
<tr>
<td>A problem has occurred with a disk transaction.</td>
<td>The directory structure is bad, or there is a problem with a file.</td>
<td>1. Right-click <strong>Start</strong>, select <strong>Explore</strong>, and then select a drive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select <strong>File&gt;Properties&gt;Tools</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Under Error-checking, select <strong>Check Now</strong>.</td>
</tr>
<tr>
<td>Diskette drive cannot read a diskette.</td>
<td>Diskette is not formatted.</td>
<td>Format the diskette.</td>
</tr>
<tr>
<td></td>
<td>You are using the wrong diskette type for the drive type.</td>
<td>Verify the type of drive that you are using and use the correct diskette type.</td>
</tr>
<tr>
<td></td>
<td>You are reading the wrong drive.</td>
<td>Verify the drive letter in the path statement.</td>
</tr>
<tr>
<td></td>
<td>Diskette is damaged.</td>
<td>Replace the diskette with a new one.</td>
</tr>
</tbody>
</table>
Table 6-2  Diskette problems (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid system disk is displayed.</td>
<td>A diskette that does not contain the system files needed to start the computer has been inserted into the drive.</td>
<td>When drive activity stops, remove the diskette and press the Spacebar. The computer attempts to boot from the next device in the boot order.</td>
</tr>
<tr>
<td>Diskette error has occurred.</td>
<td></td>
<td>Restart the computer by pressing the power button.</td>
</tr>
<tr>
<td>Cannot boot to diskette</td>
<td>Diskette is not bootable.</td>
<td>Replace with a bootable diskette.</td>
</tr>
<tr>
<td>Diskette boot has been disabled in Computer Setup.</td>
<td>Run the Computer Setup (F10) Utility and enable diskette boot in Storage&gt;Boot Order.</td>
<td></td>
</tr>
<tr>
<td>Removable media boot has been disabled in Computer Setup.</td>
<td>Run the Computer Setup (F10) Utility and enable Removable Media Boot in Storage&gt;Storage Options.</td>
<td></td>
</tr>
<tr>
<td>Diskette MBR validation is enabled.</td>
<td>Run the Computer Setup (F10) Utility and disable Diskette MBR Validation in Storage&gt;Storage Options.</td>
<td></td>
</tr>
</tbody>
</table>

Solving hard drive problems

Table 6-3  Hard drive problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard drive error occurs.</td>
<td>Hard disk has bad sectors or has failed.</td>
<td>Locate and block the usage of bad sectors. If necessary, reformat the hard disk. If the drive is detected by the BIOS, run DPS Self-test.</td>
</tr>
<tr>
<td>Disk transaction problem.</td>
<td>The directory structure is bad, or there is a problem with a file.</td>
<td>1. Right-click Start, select Explore, and select a drive. 2. Select File&gt;Properties&gt;Tools. 3. Under Error-checking, select Check Now.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td>Drive not found (identified).</td>
<td>Improper cable connection</td>
<td>On computers with discreet data and power cables, ensure that the data and power cables are securely connected to the hard drive. (See the Hard drive section of this guide for connection details.)</td>
</tr>
<tr>
<td>Improperly seated hard drive</td>
<td></td>
<td>On systems with blind-mate drive connections, check for connector damage on the drive and in the chassis. Reseat the hard drive and its carrier in the chassis to ensure a proper connection. (See the Hard drive section of this guide for connection details.)</td>
</tr>
<tr>
<td>The system might not have automatically recognized a newly installed device.</td>
<td>1. Run the Computer Setup (F10) Utility. 2. If the system does not recognize the new device, verify that the device is listed in the Computer Setup (F10) Utility. If it is listed, the probable cause is a driver problem. If it is not listed, the probable cause is a hardware problem. 3. If this drive is newly installed, enter Setup and try adding a POST delay under Advanced&gt;Power-On.</td>
<td></td>
</tr>
<tr>
<td>Drive responds slowly immediately after power-up.</td>
<td>Run the Computer Setup (F10) utility, and increase the POST Delay in Advanced&gt;Power-On Options.</td>
<td></td>
</tr>
<tr>
<td>Nonsystem disk or NTLDR missing message.</td>
<td>System is trying to start from a nonbootable diskette.</td>
<td>Remove the diskette from the drive.</td>
</tr>
<tr>
<td>System is trying to start from a damaged hard drive.</td>
<td>1. Insert a bootable diskette into the drive and restart the computer. 2. If the hard drive is still inaccessible and MBR Security is enabled, try restoring the previously saved MBR image by entering Setup and selecting Security&gt;Restore Master Boot Record.</td>
<td></td>
</tr>
<tr>
<td>System files missing or not properly installed.</td>
<td>1. Insert a bootable system diskette and restart. 2. Verify that the hard drive is partitioned and formatted. 3. Install the system files for the appropriate operating system, if necessary.</td>
<td></td>
</tr>
<tr>
<td>Hard drive boot disabled in Computer Setup.</td>
<td>Run the Computer Setup (F10) Utility and enable the hard drive entry in the Storage&gt;Boot Order list.</td>
<td></td>
</tr>
<tr>
<td>Workstation will not start.</td>
<td>Hard drive is damaged.</td>
<td>Replace the hard drive.</td>
</tr>
</tbody>
</table>
### Solving display problems

#### Table 6-4 Display problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank screen (no video).</td>
<td>The cable connections are not correct.</td>
<td>Verify the cable connections from the monitor to the computer and to a working electrical outlet.</td>
</tr>
<tr>
<td></td>
<td>The monitor is off.</td>
<td>Turn the monitor on (LED is on). You might need to refer to the monitor manual for an explanation of LED signals.</td>
</tr>
<tr>
<td></td>
<td>Screen blanking utility installed or energy saver features enabled.</td>
<td>Press a key or the mouse button and, if set, enter your password.</td>
</tr>
<tr>
<td></td>
<td>System ROM is bad; system is running in FailSafe Boot Block mode (indicated by 8 beeps).</td>
<td>Reflash the ROM using a SoftPaq.</td>
</tr>
<tr>
<td></td>
<td>Fixed-sync monitor does not sync at the resolution specified.</td>
<td>Verify that the monitor can accept the same horizontal scan rate as the resolution specified.</td>
</tr>
<tr>
<td></td>
<td>Computer is in Hibernate mode.</td>
<td>Press the power button to resume from Hibernate mode.</td>
</tr>
<tr>
<td></td>
<td>Workstation monitor settings are not compatible with the monitor.</td>
<td>1. When you see <strong>Press F8</strong> in the bottom-right corner of the screen, restart the computer and press <strong>F8</strong> during startup.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Using the keyboard arrow keys, select <strong>Enable VGA Mode</strong> and then press <strong>Enter</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. For Windows, double-click the <strong>Display</strong> icon in the Control Panel and then select the <strong>Settings</strong> tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Use the sliding control to reset the resolution.</td>
</tr>
<tr>
<td>The display works properly during the POST but goes blank when the operating system starts.</td>
<td>The display settings in the operating system are incompatible with your graphics card and monitor.</td>
<td>1. For Windows, restart your computer in VGA mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. After the operating system starts, change the display settings to match those supported by your graphics card and monitor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Refer to your operating system and graphics card documentation for information about changing display settings.</td>
</tr>
<tr>
<td>Power LED flashes red 6 times (once every second), followed by a 2-second pause, and then the computer beeps 6 times.</td>
<td>Prevideo graphics error.</td>
<td>For systems with a graphics card:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Reseat the graphics card.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. If the card requires external power, make sure the power cable is properly connected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Replace the graphics card.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Replace the system board.</td>
</tr>
<tr>
<td>Monitor does not function when used with Energy Saver features.</td>
<td>Monitor without Energy Saver capabilities is being used with Energy Saver features enabled.</td>
<td>Disable the monitor Energy Saver feature.</td>
</tr>
<tr>
<td>Problem</td>
<td>Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dim characters</td>
<td>The brightness and contrast controls are not set properly.</td>
<td>Adjust the monitor brightness and contrast controls.</td>
</tr>
<tr>
<td>Cables are not properly connected.</td>
<td></td>
<td>Verify that the graphics cable is connected to the graphics card and the monitor.</td>
</tr>
<tr>
<td>Blurry video or requested resolution cannot be set.</td>
<td>If the graphics controller was upgraded, the correct video drivers might not be loaded.</td>
<td>Install the video drivers included in the upgrade kit, or download and install the latest drivers for your graphics card from <a href="http://welcome.hp.com/country/us/en/support.html">http://welcome.hp.com/country/us/en/support.html</a>.</td>
</tr>
<tr>
<td>Monitor cannot display requested resolution.</td>
<td></td>
<td>Change the requested resolution.</td>
</tr>
<tr>
<td>The picture is broken up, rolls, jitters, or flashes.</td>
<td>The monitor connections might be faulty, or the monitor might be incorrectly adjusted.</td>
<td>1. Be sure the monitor cable is securely connected to the computer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. In a multiple CRT monitor system, ensure that the monitors’ electromagnetic fields are not interfering with each other. Move them apart if necessary.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Move fluorescent lights or fans that are too close to the CRT monitor.</td>
</tr>
<tr>
<td>Monitor must be degaussed.</td>
<td></td>
<td>Degauss the monitor.</td>
</tr>
<tr>
<td>Vibrating or rattling noise coming from inside a CRT monitor when powered on.</td>
<td>Monitor degaussing coil has been activated.</td>
<td>None. It is normal for the degaussing coil to be activated when the monitor is powered on.</td>
</tr>
<tr>
<td>Clicking noise coming from inside a CRT monitor.</td>
<td>Electronic relays have been activated inside the monitor.</td>
<td>None. It is normal for some monitors to make a clicking noise when turned on and off, when going in and out of Standby mode, and when changing resolutions.</td>
</tr>
<tr>
<td>High pitched noise coming from inside a flat-panel monitor.</td>
<td>Brightness and contrast settings are too high.</td>
<td>Lower brightness and contrast settings.</td>
</tr>
<tr>
<td>Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the picture on the screen (flat-panel monitors using an analog VGA input connection only.)</td>
<td>Flat-panel monitor’s internal digital conversion circuits might be unable to correctly interpret the output synchronization of the graphics card.</td>
<td>1. Select the monitor’s Auto-Adjustment option in the monitor’s onscreen display menu.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Manually synchronize the Clock and Clock Phase onscreen display functions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Download SoftPaq SP22333 to assist with the synchronization).</td>
</tr>
<tr>
<td>Some typed symbols do not appear correctly.</td>
<td>The font you are using does not support that symbol.</td>
<td>Use the Character Map to locate and select the appropriate symbol.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select Start&gt;Programs&gt;Accessories&gt;System Tools&gt;Character Map. You can copy the symbol from the Character Map into a document.</td>
</tr>
</tbody>
</table>
## Solving audio problems

**Table 6-5  Audio problems**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound does not come out of the speaker or headphones.</td>
<td>Software volume control is turned down.</td>
<td>Double-click the <em>Speaker</em> icon on the taskbar and use the volume slider to adjust the volume.</td>
</tr>
<tr>
<td>The external speakers are not turned on.</td>
<td></td>
<td>Turn on the external speakers.</td>
</tr>
<tr>
<td>External speakers plugged into the wrong audio jack.</td>
<td></td>
<td>See your sound card documentation for proper speaker connection.</td>
</tr>
<tr>
<td>Digital CD audio is not enabled.</td>
<td></td>
<td>Enable digital CD audio:</td>
</tr>
<tr>
<td></td>
<td>1.</td>
<td>From the Control Panel, select <em>System</em>.</td>
</tr>
<tr>
<td></td>
<td>2.</td>
<td>On the Hardware tab, select the <em>Device Manager</em> button.</td>
</tr>
<tr>
<td></td>
<td>3.</td>
<td>Right-click the <em>CD/DVD</em> device and select <em>Properties</em>.</td>
</tr>
<tr>
<td></td>
<td>4.</td>
<td>On the Properties tab, select <em>Enable digital CD audio for this CD-ROM device</em>.</td>
</tr>
<tr>
<td>Headphones or devices connected to the line-out connector have muted the internal speaker.</td>
<td></td>
<td>Turn on and use headphones or external speakers, if connected, or disconnect headphones or external speakers.</td>
</tr>
<tr>
<td>Volume is muted.</td>
<td>1.</td>
<td>From the Control Panel, select <em>Sound, Speech and Audio Devices</em>, and then select <em>Sounds and Audio Devices</em>.</td>
</tr>
<tr>
<td></td>
<td>2.</td>
<td>Deselect the <em>Mute</em> checkbox.</td>
</tr>
<tr>
<td>Computer is in Standby mode.</td>
<td></td>
<td>Press the power button to resume from Standby mode.</td>
</tr>
<tr>
<td>Noise or no sound comes out of the speakers or headphones.</td>
<td>1.</td>
<td>If you are using digital speakers that have a stereo jack and you want the system to autoswitch to digital, use a stereo-to-mono adapter to engage the auto sense feature, or use multimedia device properties to switch the audio signal from analog to digital.</td>
</tr>
<tr>
<td></td>
<td>2.</td>
<td>If the headphones have a mono jack, use the multimedia device properties to switch the system to analog out.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong></td>
<td>If you set digital as the Output Mode, the internal speaker and external analog speakers no longer output audio until you switch back to an auto sense or analog mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you set analog as the Output Mode, external digital speakers do not function until you change the output mode back to an auto-sense or digital mode.</td>
</tr>
</tbody>
</table>
### Table 6-5  Audio problems (continued)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound occurs intermittently.</td>
<td>Processor resources are being used by other open applications.</td>
<td>Shut down all open processor-intensive applications.</td>
</tr>
</tbody>
</table>
| Workstation appears to be locked up while recording audio. | The hard disk might be full.                  | 1. Before recording, be sure there is enough free space on the hard disk.  
|                                               |                                                 | 2. Try recording the audio file in a compressed format. |

### Solving printer problems

### Table 6-6  Printer problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer does not print.</td>
<td>Printer is not turned on and online.</td>
<td>Turn the printer on and be sure it is online.</td>
</tr>
</tbody>
</table>
|                                               | The correct printer driver for the application is not installed. | 1. Install the correct printer driver for the application.  
|                                               |                                                 | 2. Try printing using the MS-DOS command:  
|                                               |                                                 | **DIR C:\> [printer port]**  
|                                               |                                                 | Replace *printer port* with the address of the printer used. If the printer works, reload the printer driver. |
| If you are on a network, you might not have made a connection to the printer. | Make the proper network connection to the printer. |
| Printer might have failed.                   | Run printer self-test.                          |                                              |
| Printer does not turn on.                    | The cables might not be connected properly.     |                                              |

### Self-troubleshooting with HP Vision Diagnostics

HP Vision Diagnostics is a diagnostic tool that can be used by the end user or technical support personnel to view information about the hardware configuration of the computer and perform hardware troubleshooting on HP Workstation and Desktop systems. Booted from either DVD/CD or USB flash key, these diagnostics run outside the operating system and make it easier to isolate potential issues and determine hardware failures.

HP Vision Diagnostics provides:

- Capture complete system configuration information that can be shared as an HTML file, including:
  - System serial number
  - System product number
  - System BIOS revision
Memory size and configuration
Processor information
Storage device information and configuration
Graphics / audio / communications information and configuration

- Comprehensive diagnostic tests with:
  - Highly configurable testing options (quick / complete / custom / interactive / non-interactive)
  - Specific failing memory DIMM identification
  - Tests for video card memory
  - DST Smart tests for both SATA and SAS drives
  - Other tests and diagnostics
- Diagnostic Failure Code Output – A unique warranty code is generated for each failure which can be used to validate diagnostic usage for a specific system
- Ease-of-use - uses similar user interface as previous field diagnostics, HP Insight Diagnostics
- True end-to-end diagnostics – same diagnostics modules as used in the factory

Use HP Vision Diagnostics to determine if all the devices installed on the computer are recognized by the system and functioning properly. Running tests is optional but recommended after installing or connecting a new device.

You can run tests, save the test results, and print them so that you have printed reports available before placing a call to the Customer Support Center.

**NOTE:** Not all third-party devices may be detected by HP Vision Diagnostics.

### Accessing HP Vision Diagnostics

There are three ways to access, install and use HP Vision Diagnostics:

- Use the Vision Creator utility, pre-installed on your workstation, to burn HP Vision Diagnostics to CD or DVD.
- Use additional preinstalled utilities on your workstation to either:
  - Create a bootable USB flash key or
  - Create a bootable DVD or CD.
- If for some reason the above options are not available (for example, your primary hard drive was erased and then restored), you can download HP Vision Diagnostics from the HP Web site.
Using Vision Creator

HP Vision Creator is pre-installed on your workstation and makes it easy to burn HP Vision Diagnostics onto a CD or DVD:

1. To initiate Vision Creator, select: Start > All Programs > PC Help & Tools > HP Vision Diagnostics Disc Creation.
2. Follow the prompts to burn HP Vision Diagnostics onto optical media.

Accessing HP Vision Diagnostics Utilities

These procedures describe how to access the HP Vision Diagnostics utilities that are included in the computer software.

Creating and using a bootable USB key

This section describes how to use a USB key to access the HP Vision Diagnostics.

**NOTE:** Using a USB key is the most convenient method to access HP Vision Diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on VisionDiagUSB.exe. A setup menu appears.
2. Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a USB key.
3. Turn off the computer and restart it with the USB key installed. The computer will boot to the USB key and initiate the HP Vision Diagnostics utility.
4. Follow the HP Vision Diagnostic prompts to troubleshoot the computer.

Creating and using a bootable DVD/CD

This section describes how to use a DVD/CD to run the HP Vision Diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on the VisionDiagISO.exe file. A setup menu appears.
2. Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a DVD/CD.
3. Enable the computer to boot from DVD/CD.
4. Turn off the computer and restart it with the DVD/CD installed in the optical drive. The computer will boot from the DVD/CD and initiate the HP Vision Diagnostics utility.
5. Follow the HP Vision Diagnostic prompts to troubleshoot the computer.

Using the HP Memory Test utility

This section describes how to access the HP Memory Test utility.
NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-alone application, outside of HP Vision Diagnostics.

If the computer is booted from a DVD/CD, a separate boot DVD/CD will be required to use the memory diagnostic. Hence, HP recommends that a USB key be used to boot the diagnostic utilities. It is faster than using a DVD/CD, and it accommodates both the Memory Test and Vision Diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on the MemoryDiagISO.exe file. A setup menu appears.

2. Follow the setup prompts to create a bootable ISO image of the memory diagnostic utility on a DVD/CD.

3. Turn off the computer and restart it with the DVD/CD installed in the optical drive. The computer will boot from the DVD/CD and initiate the memory diagnostic utility.

4. Follow the diagnostic prompts to troubleshoot computer memory.
**Downloading HP Vision Diagnostics**

If for some reason neither Vision Creator nor HP Vision Diagnostics are available on your workstation, follow these steps to download HP Vision Diagnostics from the HP Web site and load onto a USB flash drive or DVD/CD:

2. Select your workstation.
3. Click **Download drivers and software**.
4. Select your language and operating system.
5. Select the **Diagnostic** link.
6. Locate **HP Vision Diagnostics** under “Quick jump to downloads by category...” for either USB or CD (as desired) and select **Download**.
7. Depending on whether you chose USB or DVD/CD:
   a. USB: Run the .exe file that is downloaded, then follow the prompts to save HP Vision Diagnostics and load it onto a USB flash key.
   b. DVD/CD: Run the .exe file that is downloaded, then follow the installer prompts to extract and save the .iso file to your hard drive. Use CD-ROM burning software to copy the .iso file to an optical medium.
8. When the DVD/CD or USB flash drive has the utility installed, insert the USB flash drive or DVD/CD into the computer (while it is on).
9. Shut down the workstation using the operating system.
10. Turn on the computer. The system should boot into HP Vision Diagnostics.

**NOTE:** If the system does not boot to the DVD/CD in the optical drive or to the USB flash drive, you may need to change the boot order. You may use the Computer Setup (F10) utility to change the boot order, or you may press F9 to select the appropriate boot device.

11. At the boot menu, select either the **HP Vision Diagnostics** utility to test the various hardware components in the computer or the **HP Memory Test** utility to test memory only.

**NOTE:** The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-alone application, outside of HP Vision Diagnostics.

If the computer is booted from a DVD/CD, a separate boot DVD/CD will be required to use the memory diagnostic. Hence, HP recommends that a USB key be used to boot the diagnostic utilities. It is faster than using a DVD/CD, and it accommodates both the Memory Test and Vision Diagnostics.

12. If running HP Vision Diagnostics, select the appropriate language and click **Continue**.
13. In the End User License Agreement page, select **Agree** if you agree with the terms. The HP Vision Diagnostics utility launches with the Survey tab displayed.
User interface

The HP Vision Diagnostics application provides six major functions, accessible through Tabs. These functions are:

- **Survey** — Your current system hardware information.
- **Test** — List all diagnostics available for your system. Tests are started there.
- **Status** — This screen shows progress and status of currently running diagnostics.
- **History** — All past diagnostics runs and status are listed there.
- **Errors** — All past diagnostics failures are listed there.
- **Help** — User help about HP Vision Diagnostics.

There are also some common operations that are part of the utility. They include:

- **Exit Diagnostics** button — This button will close HP Vision Diagnostic application and reboot your system. Any running test will be aborted.
- **Reload** button — If available, this button will rescan your system hardware and reload the diagnostics without the need to restart your entire system.
- **Save** button — If available, save your system survey, test history or error data as an HTML file to a floppy disk or a USB key drive.

Survey tab

The Survey tab shows your system hardware information, organized into eleven Categories (for example “Processors”) and device instances (for example “Processor 1”).

The amount of information displayed can be controlled by selecting a combination of View Level and Category.

The **View Levels** include:

- **Overview** — Shows high level summary of the system hardware. This is the default view level.
- **Summary** — Gives limited configuration data for each specific Category.
- **Advanced** — Offers more technical and low-level data for the computer-savvy user.

The **Categories Levels** include:

- **All** — Shows all Categories.
- **Architecture** — Shows system architecture information such as high level PCI devices, low level SMBIOS, CMOS and PCI configuration space data.
- **Audio** — Shows all embedded and add-on audio devices.
- **Asset Control** — Shows asset control related information such as product name, serial number, asset tag, and universal unique ID information.
- **Communication** — Shows communication devices such as serial, parallel, USB, network, Firewire, modem, and Bluetooth ports and devices.
- **Graphics** — Shows all embedded and add-on video cards.
- **Input Devices** — Shows user input devices such as all connected mice and keyboards.
- **Memory** — Shows system memory information.
- **Miscellaneous** — List any devices or data that doesn't belong to any other Category.
- **Processors** — Shows system processors.
- **Storage** — Shows mass storage devices such as floppy drives, optical drives, SATA, SAS hard disk drives and controllers, as well as any RAID arrays.
- **System** — Shows information about system board devices such as fans and cables.

**Test tab**

The Test tab lists all available diagnostics. The lists have been tailored according to your system configuration. Individual test may be selected or unselected. The following Test Modes exist:

- **Quick** — This test selection was picked to perform quickly while covering your entire hardware. Test parameters cannot be modified.
- **Complete** — This test selection offers all available tests and may take a long time to complete. Test parameters cannot be modified.
- **Custom** — Like Complete this test selection offers all available tests. The test parameters may be modified to fit specific needs. For advanced users only!

By default, the three test modes do not display prompts and require no interaction. If errors are found, they are displayed when testing is complete.

However, for each test type, you may also optionally add interactive tests by clicking the **Include interactive tests** box under Test mode. Selecting interactive tests provides the maximum control over the testing process. The diagnostic software will prompt you for input during tests.

**Note:** Memory can not be tested from within the HP Vision Diagnostics application. To test the memory in your computer, exit HP Vision Diagnostic, boot to either the CD or USB flash drive and select **HP Memory Test** from the boot menu.

The **Duration of Test** options control the duration of the test sequence. The following options are available:

- **Number of loops** — A test selection will run once by default. Enter a positive number to make a test selection run many times.
- **Total test time (hours:minutes)** — Alternatively, the test selection can be set to run for a specified amount of time. This does not guarantee that all tests will run if the entered time is less than the necessary time to run all the tests
- **Stop at first error** — Check this option to stop test execution as soon as one error is encountered.
The following **Test Controls** exist:

- **Select All, Unselect All** button — This button toggles to select or unselect all the tests from the test selection tree.
- **Expand, Collapse** button — This button toggles to expand or collapse the test selection tree.
- **Start Test** button — Click this button to start executing all selected tests. HP Vision Diagnostics will automatically switch to the Status tab in order to keep track of the test execution and status.

⚠️ **WARNING!** Once started, do not reboot or power off your computer until all the tests have been completed.

To begin testing:

1. Select the Test tab.
2. Select the type of tests you want to run: **Quick**, **Complete**, or **Custom**.
3. Include optional interactive tests by selecting **Include interactive tests**.
4. Choose how you want the test to be executed, either **Number of Loops** or **Total Test Time**. When choosing to run the test over a specified number of loops, enter the number of loops to perform. If you want the diagnostic test for a specified time period, enter the amount of time in minutes.
5. Click the **Start Test** button to start the testing. The Status tab, which allows you to monitor the progress of the tests, is automatically displayed during the testing process. When the tests are complete, the Status tab shows whether the devices passed or failed.
6. If errors are found, go to the Errors tab to display detailed information and recommended actions.

### Status tab

The Status tab shows the overall progress and status of the test scenario as well as the progress and status of each test. The color coded status are black, blue, green, red, and orange.

The Status tab colors are:

- **Waiting** (black) — No test is running.
- **Running** (blue) — At least one test is currently running.
- **Passed** (green) — All tests have run successfully, meaning that no hardware error or defect was detected.
- **Failed** (red) — The tests have detected at least one error with your system.
- **Canceled** (orange) — The test scenario has been explicitly canceled, in which case no pass or fail conclusion can be drawn.

The available data is:

- **Current Loop** — Shows the current execution loop out of total number of loops specified in the Test panel.
- **Test Time** — Shows the total time elapsed since the beginning of the test execution.
● **Test Complete** — Shows the number of tests successfully completed out of the total number of test to execute.

● **Cancel** button — Push the Cancel button to immediately terminate all currently running tests.

**History tab**

The History tab shows the history of the past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the number of times failed, the date each test was executed, and the time it took to complete each test. The **Clear History** button will clear the contents of the History Log.

The contents of the History Log may be saved as a HTML file to either floppy or USB flash drive by clicking the **Save** button.

**Errors tab**

The Errors tab displays detailed information about any errors found, as well as any recommended actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes the following columns of information.

- The Device section displays the device tested.
- The Test section displays the type of test run.
- The Times Failed is the number of times the device has failed a test.
- The Defect Code provides a numerical code for the failure. The error codes are defined in the Help tab.
- The Description section describes the error that the diagnostic test found.
- The Reason section describes the likely cause of the error.
- The Recommended Repair will give a recommended action that should be performed to resolve the failed hardware.
- The Warranty ID is a unique error code associated with the specific error on your computer. When contacting the HP Support Center for assistance with a hardware failure, please be prepared to provide the Warranty ID.

- The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to either floppy or USB flash drive by clicking the **Save** button.

**Help tab**

The Help tab contains a Vision Help section, and a Test Components section. This tab includes search and index features. You may also review the HP End User License Agreement (EULA), as well as the HP Vision Diagnostic application version information on this tab.
The various sections located here are:

- The Vision Help section contains information on the major functions of HP Vision Diagnostics.
- The Test components section provides a description of each test, as well as the parameters that may be adjusted when running in Custom test mode.
- The Defect codes section contains information on the numerical error code that may appear in the Errors tab.
- The Memory test tab section provides information on the HP Memory Test application that may be launched from the boot menu.
- The HP Support section provides information on obtaining technical support from HP.

**Saving and printing information in HP Vision Diagnostics**

You can save the information displayed in the HP Vision Diagnostics Survey, History and Errors tabs to a diskette or a USB flash drive. You can not save to the hard drive. The system will automatically create an html file that has the same appearance as the information displayed on the screen.

1. Insert a diskette or USB flash drive if running HP Vision Diagnostics from CD.
2. Click Save in the bottom on any of the Survey, History or Errors tabs. All three log files will be saved regardless of from which tab the Save button was clicked.
3. Select the drive onto which you will save the log files and click the Save button. Three html files will be saved to the inserted diskette or USB flash drive.

**NOTE:** Do not remove the diskette or USB key until you see a message indicating that the html files have been written to the media.

4. Print the desired information from the storage device used to save it.

**NOTE:** To exit HP Vision Diagnostics, click the Exit Diagnostics button at the bottom of the screen. Be sure to remove the USB flash drive or CD from the optical drive.

**Diagnostic codes and errors**

This section presents information about diagnostic LED codes, LED color definitions, and POST error messages to help you troubleshoot problems.

**Diagnostic LED and audible (beep) codes**

This section describes the front panel LED error and operation codes as well as the audible codes that might occur before or during the POST.
**Table 6-7  Diagnostic lights and audible codes**

<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Power LED* on. No beeps.</td>
<td>Computer on.</td>
<td></td>
</tr>
<tr>
<td>Blue Power LED* blinks every two seconds.* No beeps.</td>
<td>Computer in Sleep mode (S3-Suspend to RAM). Select models only.</td>
<td></td>
</tr>
<tr>
<td>Blue Power LED* is off.* No beeps.</td>
<td>Computer in Hibernate mode (S4-Suspend to disk) or system is off (S5).</td>
<td>N/A</td>
</tr>
<tr>
<td>Blue Power LED* blinks three times*, once per second.* No beeps.</td>
<td>Computer in Sleep mode (S3-Suspend to RAM). Select models only.</td>
<td></td>
</tr>
<tr>
<td>Blue Power LED* blinks four times*, once per second.* No beeps.</td>
<td>Computer in Hibernate mode (S4-Suspend to disk).</td>
<td></td>
</tr>
</tbody>
</table>

*User-selectable. See The Computer Setup (F10) Utility menu on page 28 for details.

For the following LED activity and beeps, the beeps are heard through the chassis speaker. Blinks and beeps repeat for 5 cycles, after which, only the blinks continue to repeat.

<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Red Power LED blinks two times, once every second, followed by a two-second pause. Two beeps. | CPU thermal protection activated by either of the following methods:  
- A fan might be blocked or not turning.  
- The heatsink and fan assembly is not properly attached to the CPU. | **CAUTION:** Internal components might be powered even when the computer is off. To prevent damage, disconnect the computer power cord before you remove a component.  
1. Ensure that the computer air vents are not blocked and the cooling fan is running.  
2. Open the access panel, press power button, and verify that the CPU fan is spinning. If the CPU fan is not spinning, make sure the fan cable is plugged into the computer board header. Ensure the fan is fully and properly seated or installed.  
3. If fan is plugged in and seated properly, but is not spinning, the problem might be in the CPU fan. Contact HP for assistance.  
4. Verify that the fan assembly is properly attached. If problems persist, there might be a problem with the CPU heatsink. Contact HP for assistance. |
| Red Power LED blinks three times, once every second, followed by a two-second pause. Three beeps. | CPU not installed (not an indicator of bad CPU). |  
1. Verify that the CPU is present.  
2. Reseat the CPU. |
<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Red Power LED blinks four times, once every second, followed by a two-second pause. Four beeps. | Power failure (power supply is overloaded) **CAUTION:** Internal components might be powered even when the computer is off. To prevent damage, disconnect the computer power cord before you remove a component. | 1. Open the access panel and ensure that all power connections (20-pin Main, 4-pin CPU) are secure on the system board.  
2. Check if a device is causing the problem by removing all attached devices (such as hard, diskette, or optical disk drives, and expansion cards.) Power on the computer. If the system enters the POST, power off and replace one device at a time; repeat this procedure until failure occurs. Replace the device that is causing the failure. Continue adding devices one at a time to ensure all devices are functioning properly. |
| Red Power LED blinks five times, once every second, followed by a two-second pause. Five beeps. | Pre-video memory error **CAUTION:** Internal components might be powered even when the computer is off. To prevent damage, disconnect the computer power cord before you remove a component. | 1. Reseat DIMMs.  
2. Replace DIMMs one at a time to isolate faulty module.  
3. Replace third-party memory with HP memory.  
4. The problem might be on the system board. Contact HP for assistance. |
| Red Power LED blinks six times, once every second, followed by a two-second pause. Six beeps. | Pre-video graphics error. **CAUTION:** Internal components might be powered even when the computer is off. To prevent damage, disconnect the computer power cord before you remove a component. | 1. Reseat the graphics card.  
2. Verify the graphics auxiliary power cable is connected (if applicable).  
3. Insert the graphics card into another available slot.  
4. The problem might be on the graphics card. Contact HP for assistance. |
| Red Power LED blinks seven times, once every second, followed by a two-second pause. Seven beeps. | System board failure (ROM detected failure prior to video). **NOTE:** Refer to the Configuring password security and resetting CMOS on page 150 section for detailed information on clearing CMOS. | 1. Clear CMOS.  
2. The problem might be on the system board. Contact HP for assistance. |
### Table 6-7  Diagnostic lights and audible codes (continued)

<table>
<thead>
<tr>
<th>Activity</th>
<th>Possible cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Red Power LED blinks eight times, once every second, followed by a two-second pause. Eight beeps. | Invalid ROM based on bad checksum. | **CAUTION:** Internal components might be powered even when the computer is off. To prevent damage, disconnect the computer power cord before you remove a component.  
1. Clear CMOS.  
**NOTE:** Refer to the Configuring password security and resetting CMOS on page 150 section for detailed information on clearing CMOS.  
2. Upgrade the ROM using SoftPaq, either from the hard disk drive, CD, diskette, or USB removable device (for example, HP Drive Key). See the ROM Flash section of the Maintenance and Service Guide at [http://www.hp.com/support/workstation_manuals](http://www.hp.com/support/workstation_manuals). SoftPaq is a self-extracting executable, which contains instructions for its use, that enables you to upgrade the ROM. To download the Softpaq executable, visit [http://www.hp.com/go/workstationsupport](http://www.hp.com/go/workstationsupport).  
3. The problem might be on the system board. Contact HP for assistance. |
| Red Power LED blinks nine times, once every second, followed by a two-second pause. Nine beeps. | System powers on but does not start. | 1. The problem might be on the system board. Contact HP for assistance.  
2. The problem might be in the CPU. Contact HP for assistance. |
| System does not power-on and LEDs are not blinking. No beeps. | System unable to power on. | **CAUTION:** Internal components might be powered even when the computer is off. To prevent damage, disconnect the computer power cord before you remove a component.  
To resolve the problem, choose one of the following options:  
Press and hold the power button for less than 4 seconds. If the hard disk drive LED turns green, then:  
1. Remove the expansion cards one at a time and try holding the power button again for less than 4 seconds.  
2. The problem might be on the system board. Contact HP for assistance.  
Press and hold the power button for less than 4 seconds. If the hard disk drive LED does not turn on green then:  
1. Check that unit is plugged into a working AC outlet.  
2. Open the access panel and check that the power button harness is properly connected to the system board.  
3. Check that all power supply cables are properly connected to the system board. |

* The BIOS option you select controls the blue LED function during these suspend modes.  
* The z210 computer does not have BIST LED functionality.  
*
LED color definitions

The following table describes what each LED light on the computer front panel signifies.

<table>
<thead>
<tr>
<th>LED state</th>
<th>LED color</th>
<th>System status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid</td>
<td>Blue</td>
<td>System is on.</td>
</tr>
<tr>
<td>Flashing</td>
<td>Blue</td>
<td>System is in Standby.</td>
</tr>
<tr>
<td>Solid or flashing</td>
<td>Red</td>
<td>System has experienced an error. (See POST error messages on page 140.)</td>
</tr>
<tr>
<td>None</td>
<td>No light</td>
<td>System is in Hibernate, or is off.</td>
</tr>
</tbody>
</table>
**POST error messages**

The Power-On Self Test (POST) is a series of diagnostic tests that runs automatically when the computer is powered on.

Audible and visual messages occur before the operating system starts if the POST encounters a problem. POST checks the following items to ensure that the computer system is functioning properly:

- Keyboard
- DIMMs
- Diskette drives
- All mass storage devices
- CPUs
- Controllers
- Fans
- Temperature sensors
- Cables (front/rear panels, audio, and USB ports)

The table shown next describes the POST error messages.

**Table 6-9  POST error messages**

<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td>101—Option ROM Checksum Error</td>
<td>System ROM checksum.</td>
<td>Verify the you have the latest ROM:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Flash the ROM, if needed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. If an expansion card was recently added, remove it to find out if the problem remains.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Clear CMOS. If the message disappears, there might be a problem with the expansion card.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Replace the system board.</td>
</tr>
<tr>
<td>102—System Board Failure</td>
<td>DMA, timers, and so forth, might be set improperly or might be defective.</td>
<td>1. Clear the CMOS.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Remove the expansion boards.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Replace the system board.</td>
</tr>
<tr>
<td>110—Out of memory space for option ROMs</td>
<td>Option ROM for a device could not run because of memory constraints.</td>
<td>Run the Computer Setup (F10) Utility to disable unneeded option ROMs, and to enable ACP1/USB Buffers at Top of Memory.</td>
</tr>
<tr>
<td>162—Systems Options Error</td>
<td></td>
<td>1. Set the date and time from the Control Panel or in the Computer Setup (F10) Utility (depending on the operating system).</td>
</tr>
<tr>
<td>163—Time and Date Not Set</td>
<td>Invalid time or date in configuration memory.</td>
<td>1. Set the date and time from the Control Panel or in the Computer Setup (F10) Utility (depending on the operating system).</td>
</tr>
<tr>
<td></td>
<td>RTC battery might need replacement.</td>
<td>2. If the problem persists, replace the RTC battery.</td>
</tr>
<tr>
<td></td>
<td>CMOS jumper might not be properly installed.</td>
<td>2. If the problem persists, replace the RTC battery.</td>
</tr>
<tr>
<td>Screen message</td>
<td>Probable cause</td>
<td>Recommended action</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| 164—Memory Size Error | Memory configuration is incorrect. | 1. Run the Computer Setup (F10) Utility or the Windows utilities.  
2. Verify that the memory modules are installed properly.  
3. If third-party memory has been added, test the memory configuration using HP memory.  
4. Verify the memory module type. |
| 201—Memory Error | RAM failure. | 1. Run the Computer Setup (F10) utility or the Windows utilities.  
2. Be sure that memory modules are installed correctly.  
3. Verify the memory module type.  
4. Remove and replace memory modules one at a time to isolate faulty modules.  
5. Replace faulty memory modules.  
6. If the error persists after replacing memory modules, replace the system board. |
| 202—Memory Type Mismatch | Memory modules do not match. | Replace the memory modules with matched sets. |
| 203—Memory module failed self-test and failing rank was disabled | Defective memory module. | Replace the memory module. |
| 204—Memory module failed and user rank was disabled | Improper module load. | Reseat the memory module correctly. |
| 205—Memory high temperature detected | Insufficient memory module cooling. | Verify that a memory module cooling fan is installed and operating. |
| 206—Memory setup invalid | Memory configured incorrectly. | Reconfigure the memory modules in the proper slots. |
| 207—Incompatible DIMMs detected | DIMMs are installed that do not fulfill system requirements. | 1. Verify that the memory module type matches computer requirements.  
2. Insert the DIMM in the proper memory socket.  
3. Replace the DIMM if the problem persists. |
| 208—Mismatched DIMMs detected | Installed DIMMs are improperly matched. | Verify that matching DIMMs are installed. |
| 209—Memory warning condition detected | Incorrect memory module type in use. | Verify that the memory modules are compatible with computer requirements. |
| 212—Failed Processor 0 | Processor has failed to initialize. | 1. Reseat the processor in its socket.  
2. If the processor does not respond, replace it.  
3. Replace the system board. |
<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| 213—Incompatible Memory Modules      | A memory module in the memory socket identified in the error message is missing critical SPD information, or is incompatible with the chipset. | 1. Verify the memory module type.  
2. Insert the DIMM in another memory socket.  
3. Replace the module with a DIMM conforming to the SPD standard. |
| 214—DIMM Configuration Warning      | DIMMs are not installed correctly (not paired correctly).                     | See the service label on the computer access panel for the correct memory configurations, and reseat the DIMMs accordingly. |
| 215—DIMM Configuration Error         |                                                                                |                                                                                  |
| 216—Memory Size Exceeds Maximum      | The amount of memory installed exceeds that supported by the hardware.        | 1. Verify how much memory the computer supports.  
2. Remove the excess memory. |
| 301—Keyboard Error                   | Keyboard failure.                                                             | 1. Reconnect the keyboard with the computer powered off.  
2. Check the connector for bent or missing pins.  
3. Be sure that none of the keys are pressed.  
4. Replace the keyboard. |
| 303—Keyboard Controller Error        | I/O board keyboard controller is defective or is not set properly.            | 1. Reconnect the keyboard with the computer powered off.  
2. Connect a keyboard directly to the computer (instead of through a switch box).  
3. Replace the system board. |
| 304—Keyboard or System Unit Error    | Keyboard failure.                                                             | 1. Reconnect the keyboard with the computer powered off.  
2. Connect a keyboard directly to the computer (instead of through a switch box).  
3. Be sure that none of the keys are pressed.  
4. Replace keyboard.  
5. Replace system board. |
| 510—Splash Screen image corrupted    | Splash Screen image has errors.                                              | Update system BIOS.                                                              |
| 511—CPU Fan not detected            | Fan is not connected or is defective.                                        | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan. |
| 512—Rear Chassis fan not detected   | Rear fan missing, disconnected, or defective.                                 | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan. |
<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| 513—Front Chassis fan not detected | Front fan missing, disconnected, or defective. | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan. |
| 514—Memory fan not detected | Memory fan missing, disconnected, or defective. | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan. |
| 515—CPU Overtemp occurred | Insufficient processor cooling or processor defect. | 1. If necessary, add a heatsink to the processor and ensure proper operation.  
2. Replace the processor. |
| 516—Chipset fan not detected | Chipset fan missing, disconnected, or defective. | 1. Reseat the fan cable.  
2. Reseat the fan.  
3. Replace the fan. |
| 517—Low power CPU heatsink(s) detected for high power CPUs | Inadequate heatsink is installed. | Replace the low power heatsink with a high power heatsink. |
| 518—Power supply wattage insufficient for hardware configuration | Computer configuration requires more power than the power supply can provide. | 1. Reduce the computer power consumption.  
2. Replace the power supply with a high output power supply. |
| 601—Diskette Controller Error | Diskette controller circuitry or diskette drive circuitry incorrect. | 1. Run the Computer Setup (F10) utility.  
2. Verify cabling and replace defective cables if necessary.  
3. Clear CMOS.  
4. Replace the diskette drive.  
5. Replace the system board. |
| 605—Diskette Drive Type Error | Mismatch in drive type. | 1. Run the Computer Setup (F10) Utility.  
2. Disconnect any other diskette controller devices (tape drives).  
3. Clear the CMOS. |
| 610—External Storage Device Failure | External storage device is not detected, is improperly connected, or is defective. | 1. Verify that the external device is present and connected properly.  
2. Replace the external device. |
<p>| 611—Primary Floppy Port Address Assignment Conflict | The flexible disk drive is configured at a previously assigned address. | Select a new address for the flexible disk drive. |
| 912—Computer Cover Has Been Removed Since Last System Start Up | N/A | No action required. |</p>
<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| 914 — Hood Lock Coil is not Connected | Mechanism is missing or is not connected. | 1. Reconnect or replace the missing mechanism.  
2. Reseat or replace the missing mechanism cable. |
| 916 — Power Button Not Connected | Power button cable is disconnected from the system board. | Reconnect the cable and restart. |
| 917 — Front Audio Not Connected | Front Audio mechanism is missing or is not connected. | 1. Replace or reconnect the missing front audio mechanism to the system board.  
2. Reseat or replace the missing mechanism cable. |
| 918 — Front USB Not Connected | Front USB mechanism is missing or is not connected. | 1. Replace or reconnect the missing Front USB mechanism to the system board.  
2. Reseat or replace the missing mechanism cable. |
| 919 — Multi-Bay Riser Not Connected | Multi-Bay riser mechanism is missing or is not connected. | 1. Replace or reconnect the missing Multi-Bay mechanism to the system board.  
2. Reseat or replace the missing mechanism cable. |
<p>| 920 — Fatal error on QPI link X | Fatal error detected on QPI link x, where x is 0 or 1. This type of error is identified on the line following the error message. | Potential system board problem; contact HP Support. |
| 921 — Fatal error on QPI Protocol link X | Fatal error detected in QPI link x protocol, where x is 0 or 1. This type of error is identified on the line following the error message. | Potential system board problem; contact HP Support. |
| 922 — Fatal error on PCIe slot X | Fatal error occurred in the designated slot. | Move the card to a different slot. If the problem persists, replace the card. |
| 923 — Fatal error on ESI port 0 slot | A fatal error occurred on ESI port 0 slot. | Verify that the ESI port device is connected and working properly. |
| 924 — Fatal error on IOH core X | Fatal error detected on IOH core x, where x is 0 or 1. This type of error is identified on the line following. | Potential system board problem; contact HP Support. |
| 925 — Fatal error on IOH miscellaneous | Fatal miscellaneous error detected on IOH core x, where x is 0 or 1. | Potential system board problem; contact HP Support. |
| 926 — Fatal error on IOH Vtd | Fatal error detected in the Intel Virtualization Technology. | Potential system board problem; contact HP Support. |
| 927 — Fatal error on DIMM in slot CPU X DIMM Y | Fatal multibit ECC error detected on the DIMM in the slot labeled DIMM x (where x is 1 - 4), as labeled on the system board. | Replace the DIMM in the identified slot. |
| 928 — Fatal machine check detected on CPU X | | Contact HP support. |</p>
<table>
<thead>
<tr>
<th>Screen message</th>
<th>Probable cause</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| 1720—SMART Hard Drive Detects Imminent Failure    | Hard drive is about to fail. (Some hard disk drives have a firmware patch that fixes erroneous error messages.) | 1. Determine if the hard disk drive is giving a correct error message.  
2. Run the Drive Protection System test (if applicable).  
4. Back up contents and replace the hard disk drive. |
| 1783—Fixed Disk 0/1 locked                         | Hard disk drive failure.                                                        | Diagnose the hard disk drive, and replace it if necessary.                         |
| 1796—SATA Cabling Error                            | Missing or improperly attached cable.                                            | Verify that a cable is attached. Reattach the cable.                                |
| 1797—SATA Drivelock is not supported in RAID mode   | SATA Drivelock is not supported in RAID mode.                                   | Disable RAID mode, or disable SATA drivelock.                                      |
| 1801—Microcode Update Error                        | Unknown or unsupported processor stepping.                                      | The microcode update failed. Check the processor stepping to ensure it is a supported stepping. If it is contact, HP Support. |
| 1802—Processor Not Supported                       | The system board does not support the processor.                                | Replace the processor with a compatible one.                                       |
| 1803—Processor feature set is insufficient for current system settings | Processor feature set is insufficient for current system settings. The BIOS settings do not match the support provided by the processor | Change the BIOS settings or upgrade the processor.                                 |
| 1804—A processor feature and the memory configuration are incompatible | A processor feature is incompatible with the memory configuration. | Restore the previous memory configuration.                                         |
| ERROR: Invalid 1394 GUID (Invalid electronic serial number) | No electronic serial number is stored with the system. | To assign a serial number, select **Security >System IDs** in the Computer Setup (F10) Utility. |
| ERROR: Invalid electronic serial number (no number) | No electronic serial number is stored with the system | To assign a serial number, select **Security >System IDs** in the Computer Setup (F10) Utility. |
| ERROR: An unsupported processor is installed. System halted | Unsupported processor detected. | Replace the processor.                                                             |
| ERROR: A processor requiring too much power is installed. System halted | Unsupported processor detected. | Replace the processor.                                                             |
| Invalid electronic serial number                   | Incorrect serial number registered in the system.                              | To assign a serial number, select **Security >System IDs** in the Computer Setup (F10) Utility. |
| Network Server Mode Active and No Keyboard Attached | Keyboard not detected.                                                         | Verify that a functioning keyboard is attached to the computer.                    |
| Processor initialization fails                      | Processor defective.                                                            | Replace the processor.                                                             |
7 Configuring RAID devices

This chapter describes how to configure SATA RAID devices on all Z-series workstations and includes these topics:

Topics

- Maximum RAID hard drive configurations on page 146
- Configuring SATA RAID devices on page 147

For additional information about configuring RAIDs, see http://www.hp.com/support/RAID_FAQs. For information about preparing the computer for RAID configuration, see http://www.hp.com/support/workstation_manuals.

Maximum RAID hard drive configurations

This section lists the maximum number of hard drives supported on HP workstations for RAID configurations.

**NOTE:** This section applies to internal workstation configurations that do not use add-in cards and JBODs.

**TIP:** Use the table values to determine the workstation model-specific maximum number of hard drives as discussed in the sections below.

<table>
<thead>
<tr>
<th>Workstation</th>
<th>8.5mm (3.5”) SATA hard drive</th>
<th>6.3mm (2.5”) SATA hard drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z800</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>Z600</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Z400</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Z210 CMT</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Z210 SFF</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>
Configuring SATA RAID devices

This section describes how to use the Intel® Rapid Storage Manager option ROM Configuration utility to set up and manage SATA RAID volumes.

The following SATA RAID configurations are supported on this computer:

- Up to the computer-specific maximum number of internal SATA hard disk drives and eSATA drives (if you use an optional eSATA bulkhead cable)
- Intel Rapid Storage Manager (IRSM) for Windows

If only a single HDD is attached, the Intel Rapid Storage Manager option ROM does not execute. Associated messages are not displayed.

The Intel SATA AHCI BIOS executes when you select \texttt{RAID+AHCI} for the SATA emulation mode. This BIOS is only used to support serial-attached drives configured as a RAID array.

This section does not apply to configuring SATA RAID in the Linux environment. For Linux SATA RAID, refer to the Software RAID in Linux Workstations section in the \textit{HP Workstations for Linux User Guide} at http://www.hp.com/support/linux_user_manual.

Attaching SATA HDDs

Attach the required minimum number of SATA hard drives for the desired RAID level:

- **RAID 0** — Striped disk array
  - Two drive minimum
  - Improved I/O performance
  - No fault tolerance
- **RAID 1** — Mirrored disk array
  - Two drives
  - 100% redundancy
  - Can recover from single drive failure
  - Improved read performance
- **RAID 5** — Striped disk array with distributed parity
  - Three or more drives (for workstations that support three or more hard drives)
  - Fault tolerant and provides I/O performance improvement, especially for write-biased applications
  - Single drive failure does not cause data loss (performance is compromised until the failed drive is replaced and the array rebuilt).
Configuring system BIOS

Configure the system BIOS to enable embedded SATA RAID functionality.

1. To enter the system BIOS setup, press F10.
2. Use the arrow keys to highlight the desired language, and then press Enter.
3. Use the arrows to highlight Storage>Storage Options, and then press Enter.
4. Use the up or down arrow key to highlight SATA Emulation.
5. Use the left or right arrow key to select RAID+AHCI.
6. To accept the new setting, press F10.
7. Use the arrows to highlight Advanced>Power-On Options, and then press Enter.
8. Use the up or down arrow key to highlight POST Messages.
9. Use the left or right arrow key to select Enable.
10. To accept the new setting, press F10.
11. Use the arrow keys to highlight Advanced>Device Options, and then press Enter.
12. Use the up or down arrow key to highlight SATA RAID Option ROM Download, and then press Enter.
13. Use the left or right arrow key to select Enable.
14. To accept the new setting, press F10.
15. Use the arrows to highlight File>Save Changes and Exit, and then press Enter.
16. Press F10 when prompted.
Creating RAID volumes

To create RAID volumes, use the Intel Rapid Storage Manager option ROM Configuration utility.

1. To enter the Intel Rapid Storage Manager option ROM Configuration utility, press Ctrl+] when prompted.

2. If required, refer the computer Maintenance and Service Guide to make available enough physical drives to create the RAID volume.

3. Use the up or down arrow key to highlight 1. Create RAID Volume, and then press Enter.

4. Type the desired RAID volume name in the Name: field, and then press Tab.

5. Use the up or down arrow key to select the RAID level in the RAID Level: field, and then press Tab.

6. If three or more hard drives are installed (for workstations that support three or more hard drives):
   a. Press Enter to display the Select dialog.
   b. Use the up and down arrow keys and Space to mark individual physical as members of the volume.
   c. Press Enter to exit the Select dialog and return to the Create Volume Menu dialog.

7. If appropriate, use the up or down arrow key to select the Stripe Size in the Stripe Size: field, and then press Tab.

8. Enter the desired volume size in the Capacity: field, and then press Tab.

9. Press Enter to initiate volume creation.

10. When prompted, press Y to acknowledge the warning message and create the volume.

11. Use the up or down arrow key to highlight 5. Exit, and then press Enter.

12. Press Y when prompted to confirm the exit.
This chapter describes how to configure password security and to reset CMOS, and includes these topics:

- Preparing to configure passwords on page 150
- Resetting the password jumper on page 151
- Clearing and Resetting the CMOS on page 151

## Preparing to configure passwords

The Computer Setup (F10) Utility enables you to create setup and power-on passwords.

There are three possibilities for setting passwords:

- Define a setup password only
- Define a power-on password only
- Define both

When defining a setup password only, you cannot enter the setup utility without the password. No password is needed to boot from power-on.

When defining a power-on password only, the power-on password is needed to enter F10 Setup or to boot from power-on.

When defining both, the setup password is needed to enter F10 setup and can be used to boot from power-on.

The power-on password cannot be used to enter the F10 Setup Utility, but it can be used to boot from power-on.

One of the passwords will be required to boot from power on.

After you create both passwords, you can use the setup password in place of the power-on password as an override to log into the computer (a useful feature for a network administrator).

**NOTE:** You can only clear the passwords with the password jumper. Clearing CMOS does not clear the passwords.

**CAUTION:** Before pressing the Clear CMOS button, back up your computer CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized information, including asset numbers and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select **Save to Diskette** from the File menu.
Resetting the password jumper

Use the following procedure to disable the power-on or setup password features and clear the power-on and setup passwords.

⚠️ **WARNING!** To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to disconnect the power cord from the wall outlet and allow the internal system components to cool before touching.

⚠️ **CAUTION:** When the computer is plugged in, the power supply has voltage applied to the system board, even when the computer is turned off. Failure to disconnect the power cord can result in damage to the system.

⚠️ **CAUTION:** Static electricity can damage the electronic components of the computer or optional equipment. Before beginning these procedures, be sure that you are discharged of static electricity by briefly touching a grounded metal object.

1. Shut down the operating system, power off the computer and external devices, and disconnect the computer power cord and external devices from power outlets.
2. Disconnect the keyboard, monitor, and other external devices that are connected to the computer.
3. Remove the access panel.
4. Locate the password header and jumper.
   - The password header is E49. The password jumper is green so it can be easily identified.
5. Verify that the AC power cord is disconnected from the power outlet.
6. Remove the jumper from pins 1 and 2.
7. Replace the access panel.
8. Reconnect the external equipment.
9. Reconnect AC power to the computer.
11. Wait for the workstation to display the HP splash screen.
12. Repeat steps 1 through 5.
13. Replace the jumper from pins 1 and 2.
14. Repeat steps 7 through 10.
15. Wait for the workstation to boot to the F10 (Setup) Utility.
16. Use the F10 (Setup) Utility to create new passwords.

Clearing and Resetting the CMOS

This section describes the steps necessary to successfully clear and reset the CMOS. The CMOS of the computer stores password information and information about the computer configuration.
Using the CMOS Button

To clear CMOS using the Clear CMOS button, use the following procedure:

⚠️ **WARNING!** To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect the power cord from the wall outlet and allow the internal system components to cool before touching.

⚠️ **CAUTION:** When the computer is plugged in, the power supply has voltage applied to the system board, even when the computer is powered off. Failure to disconnect the power cord can result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before beginning these procedures, be sure that you are discharged of static electricity by briefly touching a grounded metal object.

1. Shut down the operating system, power off the computer and any external devices, and then disconnect the computer power cord and external devices from power outlets.

2. Disconnect the keyboard, monitor, and other external devices that are connected to the computer.

3. Remove the access panel.

⚠️ **CAUTION:** Before pressing the Clear CMOS button, back up your computer CMOS settings. Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized information, including asset numbers and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select **Save to Diskette** from the File menu.

4. Locate, press, and hold the CMOS button for five seconds.

NOTE: Verify that the AC power cord is disconnected from the power outlet.

The CMOS button does not clear CMOS if the power cord is connected.

For assistance locating the CMOS button and other system board components, see the system board layout in the **Replacing components** section.

5. Replace the access panel.


7. Plug in and power on the computer. The system boots to a F1 prompt and displays a message that the date/time has changed and that system options have changed.

8. Press F1. The system shuts down for three seconds and then powers back on.

9. Use the F10 (Setup) Utility to reset the date and time.

Using the Computer Setup (F10) Utility to Reset CMOS

1. Access the Computer Setup (F10) Utility menu.

2. When the Computer Setup message appears in the lower-right corner of the screen, press F10, and then press Enter to bypass the title screen, if necessary.

If you do not press F10 while the message is displayed, the computer must be rebooted to access this utility.
3. From the Computer Setup (F10) Utility menu, select **File>Default Setup**.
This restores the settings that include boot sequence order and other factory settings. However, it does not force hardware rediscovery.


5. Select **File->Apply Defaults and Exit**, and then press F10 to accept.

6. Reset the computer passwords and configuration information, such as the system date and time.

**NOTE:** This step does not clear the passwords.
### Connector pins

#### Keyboard

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data</td>
</tr>
<tr>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>+5 VDC</td>
</tr>
<tr>
<td>5</td>
<td>Clock</td>
</tr>
<tr>
<td>6</td>
<td>Unused</td>
</tr>
</tbody>
</table>

#### Mouse

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data</td>
</tr>
<tr>
<td>2</td>
<td>Unused</td>
</tr>
<tr>
<td>3</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>+5 VDC</td>
</tr>
<tr>
<td>5</td>
<td>Clock</td>
</tr>
<tr>
<td>6</td>
<td>Unused</td>
</tr>
</tbody>
</table>

#### Ethernet

<table>
<thead>
<tr>
<th>Pin</th>
<th>10/100-Mb signal</th>
<th>1000-Mb signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>(+) Transmit Data TX/RX 0 +</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>(-) Transmit Data TX/RX 0 –</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>(+) Receive Data TX/RX 1 +</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Unused           TX/RX 2 +</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Unused           RX/RX 2 –</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>(-) Receive Data TX/RX 1 –</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Unused           TX/RX 3 +</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Unused           TX/RX 3 –</td>
<td></td>
</tr>
</tbody>
</table>
### USB Pin Signal

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5 VDC</td>
</tr>
<tr>
<td>2</td>
<td>- Data</td>
</tr>
<tr>
<td>3</td>
<td>+ Data</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
</tr>
</tbody>
</table>

---

### Microphone cable, 6.35 MM (1/8 inch) Pin Signal

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Tip)</td>
<td>Audio</td>
</tr>
<tr>
<td>2 (Ring)</td>
<td>Power</td>
</tr>
<tr>
<td>3 (Shield)</td>
<td>Ground</td>
</tr>
</tbody>
</table>

---

### Headphone cable, 6.35 MM (1/8 inch) Pin Signal

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Tip)</td>
<td>Audio_Left</td>
</tr>
<tr>
<td>2 (Ring)</td>
<td>Audio_Right</td>
</tr>
<tr>
<td>3 (Shield)</td>
<td>Ground</td>
</tr>
</tbody>
</table>

---

### Audio line-in cable, 6.35 MM (1/8 inch) Pin Signal

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Tip)</td>
<td>Audio_In_Left</td>
</tr>
<tr>
<td>2 (Ring)</td>
<td>Audio_In_Right</td>
</tr>
<tr>
<td>3 (Shield)</td>
<td>Ground</td>
</tr>
</tbody>
</table>

---

### Line-out audio cable, 6.35 MM (1/8 inch) Pin Signal

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Tip)</td>
<td>Audio_Out_Left</td>
</tr>
<tr>
<td>2 (Ring)</td>
<td>Audio_Out_Right</td>
</tr>
<tr>
<td>3 (Shield)</td>
<td>Ground</td>
</tr>
</tbody>
</table>

---

### SATA drive

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>Ground</td>
<td>P1</td>
<td>3.3V power</td>
<td>P8</td>
<td>5V power</td>
</tr>
</tbody>
</table>
### SATA drive

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>S2*</td>
<td>A+</td>
<td>P2</td>
<td>3.3V power</td>
<td>P9</td>
<td>5V power</td>
</tr>
<tr>
<td>S3*</td>
<td>A-</td>
<td>P3</td>
<td>3.3V power</td>
<td>P10</td>
<td>Ground</td>
</tr>
<tr>
<td>S4</td>
<td>Ground</td>
<td>P4</td>
<td>Ground</td>
<td>P11</td>
<td>Reserved</td>
</tr>
<tr>
<td>S5**</td>
<td>B-</td>
<td>P5</td>
<td>Ground</td>
<td>P12</td>
<td>Ground</td>
</tr>
<tr>
<td>S6**</td>
<td>B+</td>
<td>P6</td>
<td>Ground</td>
<td>P13</td>
<td>12V power</td>
</tr>
<tr>
<td>S7</td>
<td>Ground</td>
<td>P7</td>
<td>5V power</td>
<td>P14</td>
<td>12V power</td>
</tr>
</tbody>
</table>

* S2 and S3 differential signal pair
** S5 and S6 differential signal pair

### VGA

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red Analog</td>
<td>6</td>
<td>GND</td>
<td>11</td>
<td>Monitor ID</td>
</tr>
<tr>
<td>2</td>
<td>Green Analog</td>
<td>7</td>
<td>GND</td>
<td>12</td>
<td>DDC Serial Data</td>
</tr>
<tr>
<td>3</td>
<td>Blue Analog</td>
<td>8</td>
<td>GND</td>
<td>13</td>
<td>Horizontal Sync</td>
</tr>
<tr>
<td>4</td>
<td>Monitor ID</td>
<td>9</td>
<td>+5 VDC</td>
<td>14</td>
<td>Vertical Sync</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>10</td>
<td>GND</td>
<td>15</td>
<td>DDC Serial Clock</td>
</tr>
</tbody>
</table>

### DVI-I cable

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>T.M.D.S DATA 2-</td>
<td>16</td>
<td>HOT PLUG DETECT</td>
</tr>
<tr>
<td>2</td>
<td>T.M.D.S DATA 2+</td>
<td>17</td>
<td>T.M.D.S DATA 0-</td>
</tr>
<tr>
<td>3</td>
<td>T.M.D.S DATA 2/4 SHIELD</td>
<td>18</td>
<td>T.M.D.S DATA 0+</td>
</tr>
</tbody>
</table>
### DVI-I cable

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>T.M.D.S DATA 4-</td>
<td>19</td>
<td>T.M.D.S DATA 0/5 SHIELD</td>
</tr>
<tr>
<td>5</td>
<td>T.M.D.S DATA 4+ 2</td>
<td>0</td>
<td>T.M.D.S DATA 5-</td>
</tr>
<tr>
<td>6</td>
<td>DDC CLOCK</td>
<td>21</td>
<td>T.M.D.S DATA 5+</td>
</tr>
<tr>
<td>7</td>
<td>DDC DATA</td>
<td>22</td>
<td>T.M.D.S CLOCK SHIELD</td>
</tr>
<tr>
<td>8</td>
<td>ANALOG VERT. SYNC</td>
<td>23</td>
<td>T.M.D.S CLOCK+</td>
</tr>
<tr>
<td>9</td>
<td>T.M.D.S DATA 1-</td>
<td>24</td>
<td>T.M.D.S CLOCK-</td>
</tr>
<tr>
<td>10</td>
<td>T.M.D.S DATA 1+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>T.M.D.S DATA 1/3 SHIELD</td>
<td>C1</td>
<td>ANALOG RED</td>
</tr>
<tr>
<td>12</td>
<td>T.M.D.S DATA 3-</td>
<td>C2</td>
<td>ANALOG GREEN</td>
</tr>
<tr>
<td>13</td>
<td>T.M.D.S DATA 3+</td>
<td>C3</td>
<td>ANALOG BLUE</td>
</tr>
<tr>
<td>14</td>
<td>+5V POWER</td>
<td>C4</td>
<td>ANALOG HORZ SYNC</td>
</tr>
<tr>
<td>15</td>
<td>GND</td>
<td>C5</td>
<td>ANALOG GROUND</td>
</tr>
</tbody>
</table>

### Display port

![Display port diagram]

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ML Lane 0(p)</td>
<td>11</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>12</td>
<td>ML Lane 3(n)</td>
</tr>
<tr>
<td>3</td>
<td>ML Lane 0(n)</td>
<td>13</td>
<td>GND</td>
</tr>
<tr>
<td>4</td>
<td>ML Lane 1(p)</td>
<td>14</td>
<td>GND</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>15</td>
<td>AUX CH(p)</td>
</tr>
<tr>
<td>6</td>
<td>ML Lane 1(n)</td>
<td>16</td>
<td>GND</td>
</tr>
<tr>
<td>7</td>
<td>ML Lane 2(p)</td>
<td>17</td>
<td>AUX CH(n)</td>
</tr>
</tbody>
</table>
### Display port

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>GND</td>
<td>18</td>
<td>Hot Plug Detect</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>ML_Lane 2(n)</td>
<td>19</td>
<td>DP_PWR Return</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>ML_Lane 3(p)</td>
<td>20</td>
<td>DP_PWR</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Main power cable, P1

![Main power cable, P1 diagram]

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5V</td>
<td>7</td>
<td>-</td>
<td>13</td>
<td>V12-B</td>
</tr>
<tr>
<td>2</td>
<td>GND</td>
<td>8</td>
<td>PS_ON_L</td>
<td>14</td>
<td>V12-S</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
<td>9</td>
<td>-</td>
<td>15</td>
<td>V12-S</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
<td>10</td>
<td>5V</td>
<td>16</td>
<td>-</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>11</td>
<td>GND</td>
<td>17</td>
<td>11VSB</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
<td>12</td>
<td>V12-B</td>
<td>18</td>
<td>V12N</td>
</tr>
</tbody>
</table>

### CPU power cable, P3

![CPU power cable, P3 diagram]

<table>
<thead>
<tr>
<th>Pin</th>
<th>Color</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BLK</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>BLK</td>
<td>GND</td>
</tr>
<tr>
<td>3</td>
<td>BLK with BRN stripes</td>
<td>V12CPU</td>
</tr>
<tr>
<td>4</td>
<td>BLK with BRN stripes</td>
<td>V12CPU</td>
</tr>
</tbody>
</table>

**CAUTION:** Never connect the CPU power cable to the system board while power is on. If you do so, the system board can be damaged and the warranty voided. Be sure to distinguish between the CPU power cable that connects to the system board (4-pin white connector) and the Auxiliary graphics card power cable that connects to the PCIe x16 graphics card (6-pin black connector).
### Auxiliary graphics card power cable, P6

<table>
<thead>
<tr>
<th>Pin</th>
<th>Color</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BLK/YEL</td>
<td>V12–G</td>
</tr>
<tr>
<td>2</td>
<td>BLK/YEL</td>
<td>V12–G</td>
</tr>
<tr>
<td>3</td>
<td>BLK/YEL</td>
<td>V12–G</td>
</tr>
<tr>
<td>4</td>
<td>BLK</td>
<td>GND</td>
</tr>
<tr>
<td>5</td>
<td>BLK</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>BLK</td>
<td>GND</td>
</tr>
</tbody>
</table>

**NOTE:** The 6-pin power (auxiliary PCIe cable with black connector) can provide up to 75 watts to PCIe graphics cards.

### Internal USB 1 and USB 2, 2x5

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal (USB1)</th>
<th>Signal (USB2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5V</td>
<td>+5V</td>
</tr>
<tr>
<td>2</td>
<td>+5V</td>
<td>+5V</td>
</tr>
<tr>
<td>3</td>
<td>USB6#</td>
<td>USB7#</td>
</tr>
<tr>
<td>4</td>
<td>USB9#</td>
<td>USB8#</td>
</tr>
<tr>
<td>5</td>
<td>USB6</td>
<td>USB7</td>
</tr>
<tr>
<td>6</td>
<td>USB9</td>
<td>USB8</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>9</td>
<td>(not keyed)</td>
<td>(not keyed)</td>
</tr>
<tr>
<td>10</td>
<td>DETECT</td>
<td>DETECT</td>
</tr>
</tbody>
</table>

**CAUTION:** Possible equipment damage.

The 2x5 connector can be mated to either a wide 2x5 option cable connector or a narrow 1x5 option cable connector.

To prevent damage to the connectors, always connect a narrow 1x5 option cable connector to pins 1, 3, 5, and 7 only of the 2x5 connector (pin 9 is not keyed on the connector).

**NOTE:** USB 1 is DASH compatible using pins 1, 3, 5, 7, and 10 (SMI).

### Rear system fan

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>+12V</td>
</tr>
<tr>
<td>3</td>
<td>Tach</td>
</tr>
<tr>
<td>4</td>
<td>PWM</td>
</tr>
</tbody>
</table>
### Rear CPU fan

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GND</td>
</tr>
<tr>
<td>2</td>
<td>+12V</td>
</tr>
<tr>
<td>3</td>
<td>TACH1</td>
</tr>
<tr>
<td>4</td>
<td>PWM</td>
</tr>
<tr>
<td>5</td>
<td>TACH2</td>
</tr>
</tbody>
</table>

### Internal serial

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal</th>
<th>Pin</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DTR1#</td>
<td>9</td>
<td>+5V</td>
</tr>
<tr>
<td>2</td>
<td>RXD1</td>
<td>10</td>
<td>+3.3V AUX</td>
</tr>
<tr>
<td>3</td>
<td>CTS1#</td>
<td>11</td>
<td>RTS1#</td>
</tr>
<tr>
<td>4</td>
<td>DSR1#</td>
<td>12</td>
<td>COM DETECT</td>
</tr>
<tr>
<td>5</td>
<td>TXD1</td>
<td>13</td>
<td>DCD21#</td>
</tr>
<tr>
<td>6</td>
<td>RI#</td>
<td>14</td>
<td>-12V</td>
</tr>
<tr>
<td>7</td>
<td>Ground</td>
<td>15</td>
<td>+12V</td>
</tr>
<tr>
<td>8</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# System board designators

This appendix describes the system board designators for this computer.

<table>
<thead>
<tr>
<th>Designator</th>
<th>Silk screen</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>MTG1-MTG10</td>
<td>N/A</td>
<td>Mounting holes</td>
</tr>
<tr>
<td>E15</td>
<td>E15</td>
<td>Crisis recovery header/jumper</td>
</tr>
<tr>
<td>E49</td>
<td>E49</td>
<td>Clear password header/jumper</td>
</tr>
<tr>
<td>J9</td>
<td>J9 RJ/USB</td>
<td>LAN/DUAL USB</td>
</tr>
<tr>
<td>J10</td>
<td>J10 QUAD USB</td>
<td>Quad rear USB</td>
</tr>
<tr>
<td>J20</td>
<td>J20 SLOT5 PCI</td>
<td>PCI slot</td>
</tr>
<tr>
<td>J21</td>
<td>J21 SLOT6 PCI</td>
<td>PCI slot</td>
</tr>
<tr>
<td>J22</td>
<td>J22 SLOT7 PCI</td>
<td>PCI slot</td>
</tr>
<tr>
<td>J31</td>
<td>J31 SLOT1 PCIe x1</td>
<td>PCIe x1 slot</td>
</tr>
<tr>
<td>J32</td>
<td>J32 SLOT4 PCIe x16(4)</td>
<td>PCIe x16(4) slot</td>
</tr>
<tr>
<td>J33</td>
<td>J33 SLOT3 PCIe x4(1)</td>
<td>PCIe x4(1)</td>
</tr>
<tr>
<td>J41</td>
<td>J41 SLOT2 PCIe2 x16 75W</td>
<td>PCIe2 x16 slot</td>
</tr>
<tr>
<td>J64</td>
<td>DP</td>
<td>Display port connector</td>
</tr>
<tr>
<td>J65</td>
<td>DVI</td>
<td>DVI connector</td>
</tr>
<tr>
<td>J68</td>
<td>J68 PS2 KBD_MSE</td>
<td>Stacked keyboard/mouse connector</td>
</tr>
<tr>
<td>J83</td>
<td>J83 AUD</td>
<td>Triple stacked audio jacks</td>
</tr>
<tr>
<td>J86</td>
<td>J86</td>
<td>Slot2 PCIe x16 retention clip</td>
</tr>
<tr>
<td>SW50</td>
<td>SW50 CMOS</td>
<td>Clear CMOS switch/push button</td>
</tr>
<tr>
<td>P1</td>
<td>P1 PWR</td>
<td>Power supply connector (18-pin)</td>
</tr>
<tr>
<td>P3</td>
<td>P3 PWR CPU</td>
<td>CPU power connector (4-pin)</td>
</tr>
<tr>
<td>P5</td>
<td>P5 PB/LED</td>
<td>Power button/HDD LED/Power LED switch/Side access panel sensor/Temperature header</td>
</tr>
<tr>
<td>P6</td>
<td>P6</td>
<td>Auxiliary graphics power connector</td>
</tr>
<tr>
<td>P8</td>
<td>P8 CHFAN</td>
<td>Rear system fan</td>
</tr>
<tr>
<td>P9</td>
<td>P9</td>
<td>Front fan header</td>
</tr>
<tr>
<td>P24</td>
<td>P24 FRONT USB</td>
<td>Front panel USB header</td>
</tr>
<tr>
<td>P25</td>
<td>P25 INTERNAL USB2</td>
<td>Dual internal USB header</td>
</tr>
<tr>
<td>P26</td>
<td>P26 INTERNAL USB3</td>
<td>Single internal USB header</td>
</tr>
<tr>
<td>Designator</td>
<td>Silk screen</td>
<td>Component</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>-----------</td>
</tr>
<tr>
<td>P27</td>
<td>DASH/USB1</td>
<td>DASH/Dual internal USB</td>
</tr>
<tr>
<td>P29</td>
<td>P29 HDD LED</td>
<td>Hard disk drive LED connector</td>
</tr>
<tr>
<td>P54</td>
<td>COM</td>
<td>Serial port header</td>
</tr>
<tr>
<td>P60-P64</td>
<td>SATA0 - SATA4</td>
<td>SATA connectors</td>
</tr>
<tr>
<td>P65</td>
<td>eSATA</td>
<td>eSATA connector</td>
</tr>
<tr>
<td>P66 - P67</td>
<td>P66 - P67</td>
<td>SATA connectors</td>
</tr>
<tr>
<td></td>
<td>SATA4 - SATA5</td>
<td></td>
</tr>
<tr>
<td>P70</td>
<td>P70 CPU0 FAN</td>
<td>Primary CPU fan header</td>
</tr>
<tr>
<td>P124</td>
<td>P124 HOOD LOCK</td>
<td>Side access panel solenoid lock header</td>
</tr>
<tr>
<td>P126</td>
<td>PAR</td>
<td>Parallel port header</td>
</tr>
<tr>
<td>XBT1</td>
<td>XBT1 BAT</td>
<td>Battery holder</td>
</tr>
<tr>
<td>XMM1 - XMM4</td>
<td>XMM1 - XMM4</td>
<td>Memory slots</td>
</tr>
<tr>
<td></td>
<td>DIMM1 - DIMM4</td>
<td></td>
</tr>
<tr>
<td>XU1</td>
<td>XU1</td>
<td>Primary CPU socket</td>
</tr>
</tbody>
</table>
C  Routine Care

General cleaning safety precautions

- Never use solvents or flammable solutions to clean the computer.
- Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth and then use the cloth on the component.
- Always unplug the computer before cleaning the keyboard, mouse, or air vents.
- Always disconnect the keyboard before cleaning it.
- Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the computer case

- Follow the safety precautions presented in the Service Considerations section before cleaning the computer.
- To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.
- For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with a cloth or swab dampened with clear water.
- For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol evaporates quickly and does not leave a residue.
- After cleaning, always wipe the computer with a clean, lint-free cloth.
- Occasionally, clean the air vents on the computer. Lint and other foreign matter can block the vents and limit the airflow.

Cleaning the keyboard

⚠️ CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the keys.

- Follow the safety precautions presented in the Service Considerations section before cleaning the computer.
- Visible debris underneath or between the keys can be removed by vacuuming or shaking.
- Canned, pressurized air can be used to clean debris from under the keys. Use caution because too much air pressure can dislodge lubricants applied under the wide keys.
- If you remove a key, use a specially designed key remover to prevent damage to the keys. This tool is available from many electronic supply outlets.

⚠️ CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys are improperly removed or installed, the keyboard might not function properly.
• Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before reassembly.

• Use tweezers to remove any fibers or dirt in confined areas.

**Cleaning the monitor**

• Follow the safety precautions presented in the *Service Considerations* section before cleaning the computer.

• To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or a clean cloth moistened with water.

⚠️ **CAUTION:** Do not use sprays or aerosols directly on the screen—the liquid might seep into the housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may result.

**Cleaning the mouse**

1. Follow the safety precautions presented in the *Service Considerations* section before cleaning the computer.

2. Remove the mouse ball from the housing by removing the retaining plate.

3. Clean the mouse ball.

4. Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5. Reassemble the mouse.
This section provides information on the following HP resources for your workstation:

**Topics**

**Product information on page 166**
- Product data sheets
- HP Cool Tools
- Regulatory information
- Accessories
- System board
- Serial number and Certificate of Authenticity labels

**Product support on page 167**
- Additional information
- Technical support
- HP Support Assistant
- Business Support Center
- IT Resource Center
- HP Service Center
- HP Business and IT Services
- Warranty information

**Product documentation on page 168**
- User and third-party documentation, and white papers
- Product notifications
- QuickSpecs
- Customer Advisories, Security Bulletins, Notices

**Product diagnostics on page 170**
- Diagnostics tools
- Audible beeps and LED code definitions
- Web-based support tools

**Product updates on page 171**
- Driver and BIOS updates
- Operating systems
## Product information

### Table D-1  Product information

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
</table>
| **HP Cool Tools** | Most HP Microsoft Windows workstations are preloaded with additional software that is not automatically installed during first boot. Additionally, a number of valuable tools on your workstation are preinstalled that may enhance system performance. To access or learn more about these applications, choose one of the following options:  
- Click the **HP Cool Tools** icon on the desktop, or  
- Open the **HP Cool Tools** folder by selecting **Start** > **All Programs** > **HP Cool Tools**.  
To learn more about these applications, click **HP Cool Tools—Learn More**.  
To install or launch the applications, click the appropriate application icon. |
| Regulatory information | Refer to the **Safety & Regulatory Information** guide for product Class information. You can also refer to the label on the workstation chassis. |
| Accessories | For complete and current information on supported accessories and components, see [http://www.hp.com/go/workstations](http://www.hp.com/go/workstations). |
| System board | A diagram of the system board is located on the inside of the side access panel. Also, additional information is located in the **Maintenance and Service Guide** on the Web at [http://www.hp.com/support/workstation_manuals/](http://www.hp.com/support/workstation_manuals/). |
| Serial number and Certificate of Authenticity (COA) labels (if applicable) | Serial number labels are on the top panel, or on the side of the unit at the rear, depending on the workstation model. The COA label is generally located on the top or side panel near the serial number label. Some workstations have this label on the bottom of the unit. |
| Linux | For information on running Linux on HP workstations, see [http://www.hp.com/linux/](http://www.hp.com/linux/). |
# Product support

## Table D-2  Product support

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional information</td>
<td>For online access to technical support information and tools, see <a href="http://www.hp.com/go/workstationsupport">http://www.hp.com/go/workstationsupport</a>. Support resources include Web-based troubleshooting tools, technical knowledge databases, driver and patch downloads, online communities, and proactive notification services. The following communication and diagnostic tools are also available:</td>
</tr>
<tr>
<td></td>
<td>● Instant Chat</td>
</tr>
<tr>
<td></td>
<td>● Instant Support</td>
</tr>
<tr>
<td></td>
<td>● Diagnose Problem</td>
</tr>
<tr>
<td></td>
<td>Refer to the workstation <em>Maintenance and Service Guide</em> for more information on how to receive support.</td>
</tr>
<tr>
<td>Technical support</td>
<td>Before you call technical support, refer to the workstation <em>Maintenance and Service Guide</em> for a listing of information you need to have available before you call. For a listing of all worldwide technical support phone numbers, see <a href="http://www.hp.com/support/">http://www.hp.com/support/</a>, select your region, and click <strong>Contact HP</strong> in the upper-left corner.</td>
</tr>
<tr>
<td>HP Support Assistant</td>
<td>HP Support Assistant is an HP application that helps you maintain the performance of your workstation and resolve problems through automated updates and tune-ups, built-in diagnostics, and guided assistance. To access HP Support Assistant, double-click the HP Support Assistant icon on your desktop. <strong>NOTE:</strong> HP Support Assistant is pre-installed on all HP workstations with Microsoft Windows 7 operating systems. HP Support Assistant is not available on workstations running Linux.</td>
</tr>
<tr>
<td>Business Support Center (BSC)</td>
<td>For software/driver downloads, warranty information, single-topic documents, user manuals, or service manuals, see <a href="http://www.hp.com/go/bizsupport">http://www.hp.com/go/bizsupport</a>.</td>
</tr>
<tr>
<td>HP Business and IT Services.</td>
<td>For business and IT information, see <a href="http://www.hp.com/hps">http://www.hp.com/hps</a>.</td>
</tr>
</tbody>
</table>
Table D-2  Product support (continued)

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
</table>
- **North America**: Hewlett Packard, MS POD, 11311 Chinden Blvd, Boise, ID 83714, USA 
- **Europe, Middle East, Africa**: Hewlett-Packard, POD, Via G. Di Vittorio, 9, 20063, Cernusco s/Naviglio (MI), Italy 
- **Asia Pacific**: Hewlett-Packard, POD, P.O. Box 200, Alexandra Post Office, Singapore 911507 Please include your product number, warranty period (found on your serial number label), name and postal address. |

Product documentation

Table D-3  Product documentation

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP user documentation, white papers, and third-party documentation</td>
<td>For the latest online documentation, see <a href="http://www.hp.com/support/workstation_manuals">http://www.hp.com/support/workstation_manuals</a>. These include this User Guide and the Maintenance and Service Guide.</td>
</tr>
<tr>
<td>Product notifications</td>
<td>Subscriber’s Choice is an HP program that allows you to sign up to receive driver and software alerts, proactive change notifications (PCNs), the HP newsletter, customer advisories, and more. Sign up at <a href="http://www.hp.com/united-states/subscribe/gateway/?jumpid=go/subscribe-gate1">www.hp.com/united-states/subscribe/gateway/?jumpid=go/subscribe-gate1</a>. Customer advisories and product change notifications are also available on <a href="http://www.hp.com/go/bizsupport/">http://www.hp.com/go/bizsupport/</a>.</td>
</tr>
<tr>
<td>Topic</td>
<td>Location</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workstation technical overview and specifications</td>
<td>The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs provide an overall specification review of your product. It includes information about its features including the operating system, power supply, memory, CPU, and many other components of the system. To access the QuickSpecs, see <a href="http://www.hp.com/go/quickspecs/">http://www.hp.com/go/quickspecs/</a>.</td>
</tr>
</tbody>
</table>
| Customer Advisories, Security Bulletins, and Notices | To find advisories, bulletins, and notices:  
2. Select the desired product.  
3. From the Resources section, select See more...  
4. Use the scroll bar to select Customer Advisories, Customer Bulletins, or Customer Notices. |
## Product diagnostics

### Table D-4  Product diagnostics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics tools</td>
<td>The HP Vision Diagnostics utility can be found as a burnable ISO image on the workstation hard disk (under C:\VisionDiagnostics), or can be downloaded from the HP web site. For details on using this utility, refer to the section that covers HP Vision Diagnostics in the workstation Maintenance and Service Guide.</td>
</tr>
<tr>
<td>Audible beep and LED code definitions</td>
<td>Refer to the appropriate section of the workstation Maintenance and Service Guide for detailed information about beep and Light Emitting Diode (LED) codes applicable to the workstation.</td>
</tr>
</tbody>
</table>
## Product updates

**Table D-5  Product updates**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver and BIOS updates</td>
<td>See <a href="http://www.hp.com/go/workstationsupport">http://www.hp.com/go/workstationsupport</a> to verify that you have the latest drivers for the workstation. To determine the current workstation BIOS on your workstation, follow these steps during system power up:</td>
</tr>
<tr>
<td></td>
<td>1. Power on the workstation, and wait for F10=setup to appear on the lower right corner of the screen.</td>
</tr>
<tr>
<td></td>
<td>2. Press <strong>F10</strong> to enter the F10 Setup utility. The F10 Setup utility displays the computer BIOS version under <strong>File &gt; System Information</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Note the computer BIOS version so that you can compare it with the BIOS versions that appear on the HP website.</td>
</tr>
</tbody>
</table>
Index

A
Appendices
Connector pins 154
System board designators 161

B
BIOS
Determining version 20
Updating 21
BIOS ROM 25

C
Computer Setup (F10) Utility 25
Menu description 28
Configuring RAID devices 146
SATA RAID 147
Connector pins
Audio line-in 155
Audio line-out 155
Aux graphics card power cable 159
CPU fan 160
CPU power cable 158
Display port 157
DVI-I 156
Ethernet 154
Headphone 155
Internal serial 160
Internal USB 159
Keyboard 154
Main power cable 158
Microphone 155
Mouse 154
Rear system fan 159
SATA drive 155
USB 155
VGA 156

D
Desktop management 36
Altiris Client Management Solutions 39
Dual-state power button 52
FailSafe Boot Block ROM 41
Fault notification and recovery 51
HP Client Manager Software 39
HP SoftPaq Download Manager 40
HPQFlash 40
Initial configuration 37
Remote ROM Flash 40
Remote system install 37
Replicating the setup 38
ROM Flash 40
System Software Manager 40
Upgrading software 39
Workstation security 42
Diagnostic codes and errors 135
LED and beep codes 135
LED colors 139
POST errors 140
Diagnostics and troubleshooting 109
Diagnosis guidelines 112
HP Vision Diagnostics 126
Locating ID labels 110
Locating warranty info 111
Drivers
Installing 17
Updating 17, 21

H
HP Recovery Manager 23
HP resources
Locating 165
Product diagnostics 170
Product documentation 168
Product information 166
Product support 167
Product updates 171
Web links 168

M
Microsoft Windows
Setting up 17
Transferring files 17
monitor
Windows 117

N
Novell SLED
Restoring 24
Setting up 19

O
Operating system setup 16
Microsoft Windows 17
Red Hat Linux 18
Operating system setup; Novell SLED 19

P
Power supply 7
Currents 8
Power consumption 9
Resetting power supply 10
Specifications 9
System fans 10
Voltages 7
Product features 1
ERP compliance mode 13
Front panel components 5
HP Cool Tools 14
Hyper-threading 13
Physical characteristics 7
Rear panel components 6
SATA Power Management 14
System board architecture 1
Turbo Boost 14
Workstation components 4
Product overview 1

R
Red Hat Linux
Setting up 18
Replacing components 53
Access panel 65
Battery 93
cable lock 63
Component locations 60
computer speaker 79
Converting to desktop configuration 105
  
CPU 101
CPU heatsink 98
Disassembly order 63
Front panel I/O device 68
Memory 83
Optical disk drive 71
PCIe card 90
Power connections 81
Power supply 80
Predisassembly 62
Rear system fan 82
Service considerations 55
side access panel sensor 66
side access panel solenoid 67
Slot identification 87
System board 103
Restoring the operating system 22, 23
  Restore method 22

S
Software
  Ordering 23
Support
  Locating HP resources 165

U
Updating the workstation 20
  First boot update 20
  Updating drivers 21
  Updating the BIOS 21

W
Windows 7
  Setting up 17
Windows operating system
  monitor 117
Workstation setup
  Ensuring proper ventilation 15